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PREFACE 
 
WIDEimage is a fully integrated scanning, viewing, converting,  image 
editing, and print system for large format B/W and Color Scanners.  
 
General scanning features include among others: 
• Easy-to-use Scan Panel for optimal control during scanning. 
• On-line previewing in all scanning modes. 
• Deskew alignment. 
• Image Cropping, inverting, mirroring and rotating. 
• On-the-fly image enhancement.  
• On-line Topic and Task related help. 
 
Special monochrome features include: 
• Dual 2D-Adaptive enhancement – processing simultaneously on 

different drawing aspects. 
• 2D-Adaptive thresholding.  
• Fixed thresholding. 
• ADL+ error diffusion halftoning for maintaining shades of gray. 
• Despeckling and hole filling. 
• Monochrome sharpen/soften/blur filters. 
 
For color scanners, extended functionality includes:  
• True color RGB, Indexed, and classified color scan. 
• Color viewing. 
• Color image processing. 
• Color tone adjustment controls. 
• Color sharpen/soften/slur filters. 
• Feature extraction and LUT filter editing. 
 
This User’s Guide describes all of WIDEimage’s features and explains 
how to use them for obtaining perfect results. It assumes a basic 
knowledge of your computer's operation, and  therefore it does not 
repeat material from the manufacturer’s documentation.  
 
This User's Guide applies to the WIDEimage edition for Windows-98,  
Windows-NT and Windows 2000.  
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SYSTEM REQUIREMENTS 
 
• Supported computer and operating system; see Chapter 2: 

"Installation." 
• Scanner with compatible SCSI interface. 
 

RELATED PUBLICATIONS 
 
The "Operator’s Guide" which was supplied with your scanner. 
 
See the README.TXT file on the WIDEimage distribution CD-ROM 
for latest information and news.  
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How To Use This Guide  
 
This guide contains 7 chapters and 4 appendices. Be sure to read 
Chapter 2: “Installation” before attempting to install or use the software 
described in this guide.  
 
Chapter 1.  An introduction to the WIDEimage features.  
 
Chapter 2. Describes how to install WIDEimage on your  

system.  
 

Chapter 3. Describes the Main Toolbar, the File Menu and how to  
                    move between the different screens. 
 
Chapter 4. Describes scanning procedures, settings and tools. 
 
Chapter 5. Describes post scanning options with image viewing and  

editing. 
 

Chapter 6. Describes feature extraction and LUT filter editing.  
 
Chapter 7. Describes the supported image file formats. 
 
Appendix A. Tips on color scanning and copying. 
 
Appendix B. WIDEimage License Agreement. 
 
Appendix C. Contains a useful glossary over scanning/imaging terms. 
 
Appendix D. Index. 
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Document Conventions 
 
The following typographical conventions are used throughout this user 
guide: 
 
• Menu, dialog and option labels are capitalized as they appear in 

the application and written in Italics for enhancement. 
Examples:  
Check the Keep color balance option, Select Windows printer 
driver, Click on Batch Scan – Options to reach the dialog. 

• Names of WIDEimage tools, screen views, menus and buttons, 
appear in italics, conventional book title capitalization format 
(proceeding caps in each word).  
Examples :  
In the Main View, select the Feature Menu. Click on the Invert Tool 
button.  

• Terms that are not tools but internal definitions related to 
WIDEimage features will appear without italics but in conventional 
book title capitalization format.  
Examples:  
The Pick Color, Indexed Mode, Adaptive Level. 
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1. Introduction 
WIDEimage is an integrated software package designed to control all 
scanner functions and image processing features embedded in your 
scanner. 
The program produces a multitude of industry-standard color, graytone 
and B/W output image file formats compatible with CAD, GIS, Raster-
Editor, Raster-to-Vector, Digitize, Overlay, Color Reproduction, Color 
Copying, RIP and Archiving programs. After scanning, the files 
become usable for editing, storing, and conversion. Scanned 
drawings, maps, etc. can be printed, thus exploiting scanning 
enhancement features to create copies that look better than their 
originals. WIDEimage is ideal for use with CAD, GIS, DTP and Color 
Copying Systems. 
  
The program enables: 
 
• Controlling your scanner’s advanced hardware embedded image 

enhancement processing features through a user friendly 
interactive user interface.  

• Software emulation of advanced image enhancement processing 
features not supported in the hardware on the particular scanner 
model. 

• Rapid and easy navigation between scanning, viewing and 
Feature Extraction tasks. 

• Point-and-Click on-line control of scanning parameters such as 
color settings, threshold, scan-window and alignment. On-line 
display during scanning provides instant quality verification. 

• Advanced color feature extraction ensuring uncomplicated and 
clean scans, as well as reduction of file sizes and storage 
requirements. 

• Viewing and zooming to any level in scanned images with a rich 
set of color and image tools. Conversion between image file 
formats. 

• Alignment, perfect electronic horizontal deskewing of originals to 
correct skew when scanning, by setting alignment points on 
screen through pointing and clicking with your mouse. 

• Rotation  of images between 0 and 360 degrees. 

• Electronic despeckling, removing speckles of user-definable sizes. 
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• Reversing (image colors) and image mirroring during scanning. 

• Measuring angles and distances between selected points.  

• Printing to laser printers and industry standard ink-jet and laser 
printers, with a user-definable print window for printing a selected 
part of the image. Setable scaling or auto-scaling.  

• Support of more than fifty important industry standard Image File 
Formats including TIFF formats, JPEG, CALS and CCITT Group 4 
compressed formats, Intergraph RLE and CIT, and Systems 
CADOverlay RLC format for AutoCAD. 
 
 

WIDE FORMAT SCANNER –
w. compatible SCSI I/F

PC or WORKSTATION

Scanning /Image Enhancement
Color Wide-Format Digitize/Copy
B/W Wide-Format Digitize/Copy
Color Feature Extraction

LARGE-FORMAT
PRINTER

File Formats: more than 50 selectable
Color Formats: TIFF, JPEG,
PCX, BMP, RAS, RTL

Full color and monochrome
output/copying to large-
format printer.

Conversion, Despeckling,
Deskewing, Rotation & Alignment
Viewing and Zooming
Batch Processing

 
Fig. 1-1: WIDEimage System Overview 
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2. Installation 

2.1 Introduction 
In the following sections, installation is described for WIDEimage on: 
 
• Windows 98, 98SE  
• Windows ME 
• Windows NT4.0 
• Windows 2000 
• Windows XP 
 
Always check the README.TXT file on the WIDEimage distribution 
CD for updates describing installation procedures, or for installation on 
newly-supported computers and operating systems. 
 
Important note: WIDEimage will use available memory for buffers 
while scanning; therefore you should maximize your workstation 
memory in order to speed up scanning processes.  
 
The WIDEimage program software is not copy protected, but requires 
a scanner correctly installed with the power ON, in order to be fully 
functional.  
 
If no scanner is attached, the application will work only in demo mode.  
 

2.1.1 Demo Mode  
When the application is started without a scanner, a dialog is displayed 
providing the option of either running WIDEimage in Demo Mode or 
re-scanning the SCSI bus in case the scanner was turned on after 
your computer (option only available if using an SCSI interface 
connection). 
 
Demo mode allows you to use WIDEimage without a scanner. Demo 
mode can be useful for demonstrations, user instruction or when using 
the application as a viewer for pre-scanned images. 
 
The following properties apply to Demo Mode :  
• The scanner panel will function as if a color scanner is attached. 

You can use the Viewer and Feature tools with the image as if it 
were scanned in. 

• Scanning is disabled. 
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• Saving to file in the viewer and from the file menu is disabled. 
• Printing is disabled. 
 

2.1.2 Scanner Installation 
Perform the scanner interface installation as described in the 
documentation that came with your scanner. You will be required to 
install scanner drivers and setup the interface parameters. 
 

2.2 Windows Installation 
The system requirements are: 
 
• Windows 98, 98SE, ME, Windows NT.40 or Windows 2000, XP. 
• IBM PC or compatible, 200 MHz or above is recommended. 
• Windows 98 - 64 Mb. RAM min.  
• Windows NT4.0, 2000 and XP - 128 MB. RAM min 
• 24 bit graphics display. 
• A mouse or other pointing device. 
 
Use the Setup program (SETUP.EXE) to set up WIDEimage for 
Windows on your computer: 
 
1. Start Windows.  
2. Insert the WIDEimage distribution CD in your CD-ROM drive. 
3. Click the Start button on the Taskbar, choose Run from the 

menu. 
4. Type D:setup in the command line box. (Replace “D” with your 

CD-ROM’s drive letter). 

Fig. 2-1: Demo Mode Dialog 
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5. Choose the OK button. 
6. Follow the setup instructions on the screen. 
 
After installing all the files, the Setup program creates a program 
group and places the WIDEimage icon inside. 
 
To start WIDEimage for Windows: 
  
1. Click “Programs” in the ”Start” menu.  
2. Click the “WIDEimage” icon to start the program. 
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3. Getting Started – Basic Screens & Tools 

3.1 General Screen Layout 
The following sections give an overall view of the WIDEimage screen 
system and describe in detail the functions in the Main Toolbar and the 
File Menu. 
 
The screen shown below contains 3 function areas above the main 
image display window listed here from top to bottom: 
• Menu Bar  
• Main Toolbar 
• Task Toolbar 
 
There are 2 function areas below the main image display window: 
• Screen-Select Tabs 
• Status Bar 
 
 

 
 

Fig. 3-1: WIDEimage Screen Overview 

Menu Bar  Main Toolbar  Task Toolbar

Status Bar  Main Display AreaScreen Select Tabs  



3-2  Basic Screens & Tools 

The Menu Bar, Main Toolbar, Screen-Select Tabs and Status Bar are 
all general function areas that are present on all screens, while the 
appearance and available tools in the Task Toolbar are task 
dependent. 
From the File Menu you can control loading, saving and printing of 
image files, select program preferences, etc., while the Main Toolbar 
consists of  central  functions such as file open, save, print shortcuts, 
and a range of convenient  zoom tools. Moving between the three 
different screens is controlled through the Screen-Select Tabs. 
Additional pull-down menus, Task Toolbars and Status Bars are 
described in detail in later chapters because their functions and 
layouts change according to the task being carried out (e.g., scanning, 
viewing, feature extraction). 
 
The WIDEimage user interface and all its functions apply to a current 
or active image. An image becomes active when it is either :  
• Opened as a file  
• The result of scanning 
These two ways of activating an image have the same functional 
effect.  
 

3.2 WIDEimage Screens  

3.2.1 Introducing the 3 Task Screens 
WIDEimage allows you to display and work with images in connection 
with different tasks. Each task has its own “Screen” and tools 
associated with the specific task in question. Moving from one screen 
to another is equivalent to changing between the different tasks you 
can perform on an active image.  
 
The following screens are available: 
 
• Scan Screen with scanning functions and the Scan Toolbar  

• View Screen with viewing, image functions and View Toolbar  

• Feature Screen with LUT creation functions and the LUT Toolbar  
 

All screens have the common Main Toolbar at the top and a specific 
Task Toolbar just below it. 
WIDEimage starts up in the Scan Screen. The Scan Screen  consists 
of a Menu Bar and a Main Toolbar plus a Scan Toolbar as the specific 
‘task’ toolbar, a Status Bar at the bottom, and a Scan Panel  on the left 



Basic Screens & Tools  3-3 

side of the screen. See Chapter 4 for details on the Scan Screen, 
Scan Toolbar and the Scan Panel. 
In the View Screen, the Task Toolbar becomes the View Toolbar. See 
Chapter 5 for details on the View Screen with the View Toolbar. 
In the Feature Screen, the Task Toolbar becomes the LUT Toolbar. 
See Chapter 6 for details on the Feature Screen with the LUT Toolbar. 
 

3.2.2 Maneuvering Between Screens 
Moving from one screen to another is easy – simply click on the 
appropriate tab among the Screen-Select Tabs at the bottom of the 
screen. 

The screen choices are:  
 

 The Scan Screen with scanning functions 
and settings 

 

  The View Screen with image functions. 
 

  The Feature Screen with LUT editing    
       functions. 
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Moving to the Scan Screen  
WIDEimage starts in the Scan Screen. If you move to the Scan 
Screen from either the View or Feature Screen with an open image,  
you will be prompted to save the active image file if it has undergone 
changes since it last was saved. 
An image file that  is open when moving to the Scan Screen will act as 
the default file in the Save As dialog for subsequent scans. 
Thus, when scanning, the active image file will be overwritten with the 
new image unless the user chooses to change the file name. A 
warning is displayed before files are overwritten. Default naming for 
scanning target files can be controlled through the File Menu – 
Preferences (section 3.4.9). 
 
Moving to the View Screen  
Upon moving to the View Screen, the active (opened or scanned) 
image is loaded in the main display area.  
If you have moved to the View Screen from the Feature Screen with 
an open RGB (24-bit true color) file, then the RGB file will be 
displayed. 
If no active image exists, the viewer will start up by displaying an 
empty view area. 
 
Moving to the Feature Screen 
The Feature Screen is only active with a color scanner and when an 
RGB image is open. Upon entering the Feature Screen, the active 
RGB image is immediately displayed. A LUT file must be loaded or 
created before LUT functions can be activated.  
Only after an RGB file has been opened and an initial LUT generated 
or loaded, can LUT filtered output be displayed in the Histogram, Color 
Wheel, and Main Views.  
See Chapter 6 for details on the Feature Screen and LUT generation.  
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3.3 The Main Toolbar 
The Main Toolbar is displayed with all three WIDEimage screens. The 
availability of each tool varies from screen to screen.  
 

3.3.1 Open 

 
For opening an image file. 
Displays a file-select dialog for browsing to and opening an existing file 
for viewing This tool is identical with the File Menu..., Open option 
described later in this chapter. 

 

3.3.2 Save 

 
Saves the image to the open (active) file (see File Menu..., Save 
description later in this chapter). When saving from the Feature 
Screen, only the underlying RGB input file is saved. 
 

3.3.3 Print  

 

Displays a dialog for printing an entire open image or only a portion 
selected using the Rectangle Selector Tool. Clicking on the Print Tool  
displays the dialog described in section 3.4.6 – File Menu – Print. 
Printing of an image area defined by the Rectangle Selector is 
described in section 3.4.6 – under Print Range and in section 5.3.1. on  
the View Screen and  its tools. 
 
 
 
 
 
 



3-6  Basic Screens & Tools 

3.3.4 Zooming Tools  
There are 5 zooming tools on the Main Toolbar: 
Zoom, Zoom-In, Zoom-Out, Zoom-Birds-Eye and Zoom Factor.  
 
Zoom 

 
Zooming with image area selection 

• Click the Zoom Tool to activate a special zoom cursor  
• With this cursor, drag a frame on an image area of your choice, 

while holding down the left mouse button.  
• Release the mouse button to perform zooming on the specified 

framed area.  
• Further zooming can be performed immediately with the active 

Zoom- cursor. 
• Re-click the Zoom Tool in order to leave the Zoom  mode.  
 
Zooming can be performed up to a zoom factor of 1600%.  
 
Zoom In 

 
Clicking Zoom In enlarges the view by a factor of 2, with the pivot point 
in the middle of the current  image view.  
 
Zoom Out 

 
Clicking Zoom Out decreases the view by a factor of 2, with the pivot 
point placed in the middle of the current  image view.  
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Zoom Birds Eye 

    

This tool allows you, so to speak, to “fly over different areas of the 
image equipped with binoculars”. You select an area for immediate 
zooming by moving a zoom area frame on an overview of the image. 

Viewing with Zoom Birds Eye 
• Click on the Zoom Birds Eye button. This displays a full view of the 

image with a frame outlining the current zoom area. 

•  Drag the frame corners to enlarge or decrease the frame size 

• Move the cursor close to the frame to change to the panning 
cursor.  

 Panning cursor 

• Hold down the left mouse button and drag the frame to any  
position in the image.  

• Release the mouse button to zoom in on the new framed area.  
 
Zoom Factor 

 
 
The current zoom factor is displayed in the zoom factor field on the 
View Screen and the Feature Screen.  
The zoom factor is 100% when one pixel in the image corresponds to 
one pixel on the screen The zoom factor can range from the whole 
image to 1600%. You can either select from among standard zoom 
factors or else enter your own zoom factor in the edit field. 
 
Zoom Grid: 

 
The Zoom Grid tool toggles On/Off. When ‘On’ it displays a gray grid 
over the image to help you view pixels separately at large zoom factors 
(500% or greater). 
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3.4 The File Menu 
Clicking on File in the Menu Bar displays the File Menu shown below. 
The File Menu offers easy access to file management and global 
configuration settings for WIDEimage and for your printer output. The 
following section describes each of the File Menu’s options. 
 

 
 
 

 
Fig. 3-2: The File Menu 
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3.4.1 Open... 
For opening an image file. 

• Select Open to display a file-select dialog.  
• Click on the down-arrow of the Files of type drop-down box to 

display a list of supported image file formats (see the appendix 
listing supported file formats). The dialog displays only files of the 
chosen format that reside in the Look in box specified folder.  

• Select the folder and file and open it by double clicking or by 
clicking on the open button.  

• You can open a file from any screen. WIDEimage will 
automatically move to the View Screen with the opened file 
displayed. 

 

3.4.2 Close 
The Close option closes the current open file.  
If you after opening the current file made changes, a dialog will give 
you the option to save or disregard your changes.   
 

3.4.3 Save 
Saves the open image under the current file name. 
 
 
 
 

 
Fig. 3-3: Open Image Dialog 
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3.4.4 Save As... 
For saving to a new file name and for file conversion. 

 
• With an active image, either scanned or loaded from a file …. 
• Select Save As… from the File Menu. 
• This displays a dialog for controlled saving of the image file under 

a name, location, folder and format of the user’s choice. 
 
File Format Conversion  
An image file in one format can be converted into another format 
simply with the Save As.. option.  
• Select the desired format from the Save as type drop-down box. 

(See Appendix B: File Formats.) 
• Some formats are supplied with options that can be adjusted prior 

to saving. Click on the Options button to set available format 
options. 

 
 
 
 
 
 
 
 
 
 

Fig. 3-4: Save As.... Dialog 
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3.4.5 Properties… 
Selecting File Menu - Properties displays the active image file’s main 
properties as shown below. Click OK to close the display box. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. 3-5 Image Properties Dialog 



3-12  Basic Screens & Tools 

3.4.6 Print... 
For printing an open image and setting printer driver  properties. 
Printing an open image is carried out either by selecting Print in the 
File Menu or by clicking on the Print Tool in the Main Toolbar. Both 
actions display a print dialog  similar to the one shown below. 

 
The Print dialog informs you of the current settings for the selected  
printer and port. Adjustments to printing settings are carried out here. 
The dialog offers a wide range of options, allowing optimal flexibility in 
relation to your different printing needs. 
 
Making Settings in the Print Dialog 
 
Printer Name 
Printing is always done through a printer that is defined in your 
operating system i.e., Windows . Click the Name drop-down box to 
select one of the printers defined on your system. 
 
Print To File 
Check the Print to file option if you wish to redirect print output to a file. 
The file Save As.. dialog appears when you click OK in the print dialog. 
 

 
Fig. 3-6: Print Dialog Example 
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Select your Printer Driver 
The printer driver selection area offers users optimal flexibility for 
obtaining perfect printer output at maximum speed. By clicking on 
Properties next to the selected driver type, existing printer settings can 
be amended or new printer profiles can be configured to fit specific 
requirements.   

You can select either: 
• Use Windows printer driver  
• Use direct printing. 

Use Windows printer driver 
Select Use Windows printer driver to activate the current Windows 
printer driver when processing the print job. Click on Properties to 
display the Windows printer configuration dialog. See your Windows 
documentation for details on configuration of the Windows printer 
driver. 

Use direct printing  
With Use direct printing you can select one of the printer profiles 
available with WIDEimage from the list in the arrow box. There are  
printer profiles for many commonly used printers. The printer profiles 
and dialogs are designed to enable you to take full advantage of 
printer-specific options. The print job is processed as a raw print that 
goes directly to the printer queue, which speeds up printing 
considerably.  
Use direct printing also allows you to use and create your own pre-
defined printer profiles. User defined printer profiles can be added to 
the profile list by way of the Properties dialog’s Clone… button shown 
below.  

 
Fig. 3-7: Use Direct Printing - Properties Dialog 
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Use direct printing -  Properties 
Selecting Properties after choosing Use direct printing will start a 
dialog with 2 selection tabs: Printer Specific and Page Setup . From 
these tabs you can: 
• Determine margins, printing resolution, and other printer specific 

settings. The Properties... button in the Printer Specific tab 
enables access to  those printer settings that are specific to each 
printer.   

• Determine Paper size and Portrait or Landscape orientation. 
 

Creating User-defined Printer Profiles 
• User-defined profiles are configured and saved in the Use Direct 

Printing - Properties dialogs. 
• You configure new Printer Profiles by cloning from the current 

profile. Click the Clone… button to enter a new profile name and 
save the current settings. Up to 10 user-defined profiles can be 
created and saved. 

• To Delete the current user-defined profile, click on Delete in the 
Printer Properties dialog.  

 
 
 
 
 
 
 

 
Fig. 3-8: Use Direct Printing - Properties - Page Setup Tab Dialog 
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Print Range 
The Print range option group, is where you define the portion of an 
image that will be printed. You can select ranges defined as All or 
Selection.  
• Choose All to set the range to include the entire image. 
• Choose Selection to  limit  the printing range to the area outlined 

by the Rectangle Select Tool when it is active (see Chapter  5 for 
details on the Rectangle Select Tool).  

• The Print Range is set to All by default. 
 
Copies 
The number of copies can be set between 1 and 999. The default 
setting is 1. 
 
Scaling 
Scaling can be set to:  
• Auto - which means the drawing is scaled to the printer page size 

as defined in the current printer profiles page settings in Properties 
- Page Setup. 

• Manual - You choose scaling ratios between 1 and 1000%. 
Default is 100%.   

Scaling is set to Manual by default. 
 
Offset 
Offset can be enabled, which means a part of the image will be cut off 
before printing in order to compensate for top and left printer margins. 
When using a Windows printer driver, the offset is read from the 
driver. With Use direct printing, offsets are specified and amended 
through the Printer Properties dialog.  
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3.4.7 Batch Print … 
Often you will have a list of files that are to be printed in the same way. 
Opening and starting Print for each file in turn would be a slow and 
annoying process. Multiple (batch) printing of several files can be 
carried out by selecting Batch Print … in the File Menu. The files must 
have the same file format. 

Performing Batch Printing 
• Select Batch Print from the File Menu.  
• In the file selection dialog, select the files you wish included in the 

batch.  
• Use the Files of type drop-down box to help ensure that you select 

files with identical formats.  
• Use the <shift> or <ctrl> key in combination with the mouse to 

select multiple files. 
• Click the dialog’s Print… button to start printing. The normal Print 

Dialog described in the previous section (see 3.3.6 Print) will 
appear. From there, printing follows the same procedure as for 
printing a single image file. 

 
 
 
 
 
 
 
 

 
Fig. 3-9: Batch Print Dialog 
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3.4.8 Batch Convert 
You may have a whole list of files in the same format that need to be 
converted in exactly the same way. WIDEimage offers a convenient 
interface for multiple file (batch) conversions.  
 
Choose File - Batch Convert... to display the following dialog in which 
batch conversion settings can be configured. Your settings will apply to 
each file you include in the batch. The dialog is sub-divided into an 
input dialog area and an output dialog area.  

Batch Convert - Making Input Settings 
• Select files for conversion from the File selection dialog. 
• Make sure the input files are of identical file formats. 
• Use the <shft> or <ctrl> key in combination with the mouse to 

make multiple selections. 
 
 
 
 
 

 
Fig. 3-10: Batch Convert Dialog 
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Batch Convert - Making Output Settings 
• Select the output format in the Save as type window. You can 

select a type from the arrow list. 
• Select a target directory in the Directory window. Click on Browse 

if you need to search for an output directory. 
• The resulting output files will inherit their names from the 

corresponding input files. 
• Click on the Options.. button for setting file format options. The 

dialog and its options are relevant to the file format specified as 
the batch output format. Different format types have different 
format option dialogs. 

• Click on Convert Options... to make settings that will apply to all 
the output files in the batch. Rotation Angle, Invert option, Mirror 
option, Scale Factor, Despeckle and Hole Filling are available. 

• Use the bottommost check box if you wish automatic overwriting 
of existing files with the same name. 

 

 
Starting Batch Conversion 
Batch conversion is started by clicking the Convert button. You can 
follow its progress in the Batch Convert Log dialog box . 
 
 

 
Fig. 3-11: Batch Convert - Convert Options Dialog 
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Viewing the Batch Conversion Log  
The Log dialog appears just after the conversion process begins. The 
Log dialog’s window displays the status of each conversion task as it is 
performed. An “OK” message follows each successful conversion of a 
file, while unsuccessful conversions are followed by an error message.  
An Abort option is available as long as the conversion process is 
running. 
• Click the Abort button if you want to stop the batch conversion. 
 
When the conversion process is completed, the Log dialog changes to 
a scroll window allowing you to view all the log entries and thereby 
verify the conversion’s completeness.  
• Click Close to leave the dialog   
• Click Save… to start a file selection dialog for saving the log to a 

file. 

 
 
 
 
 
 
 
 
 

 
Fig. 3-12: Batch Conversion Log Dialog 
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3.4.9 Preferences  
With the Preferences option you can customize central factors in 
WIDEimage.   
Clicking on Preferences displays the following sub menu: 

Setting Unit Preferences 
• Unit… 

Select Unit to set the unit to millimeters or inches. Your selection 
determines units for other measurement settings throughout the 
program. 

 
Setting the Status Bars’ Color Space Value Method 
• Color Info Field…  

A dialog will be displayed in which you can choose between RGB 
or HSV color space values. The View Screen and Feature Screen 
Status Bar will display either RGB or HSV values depending on 
this setting.  

 
Setting Scan Preferences 
• Scanning… 

Select Scanning... to customize different categories of scanning 
aspects. Settings are grouped under 3 tabs : general settings, 
batch (log data) settings, and prescanning behavior.  

 
Fig. 3-13: Preferences Dialog 
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General Preferences  ( see figure above) 
• Display during scanning(no effect on prescan viewing)  

Check the Detailed view option if you want image details to be 
displayed during scanning. Un-checking this box can speed up 
scanning processes. 
Check the Overview option if you want an overview displayed 
during scanning. Un-checking this box can speed up scanning 
processes. 

• Default scan file 
Check the None box if you prefer to enter the scan file name 
manually for each scan-to-file. 
Checking the Last scan file box causes the Save As… dialog to 
always display the latest file name used. This is useful if you 
expect to make trial scans with each job.  

• Paper position 
Here you select paper loading from either the side of the scanner 
or from the center. This setting will be your default setting at 
startup. Paper position can also be set temporarily in the Scan 
Panel – Paper size method options.  

• Scanner Speed 
Sometimes, the performance of your workstation will cause the 
scanner to make repeated “back-ups” during scanning in order to 
ensure correct and continuous processing of scanned data. Back-
ups can be avoided by reducing the scanning speed thus refitting 

 
Fig. 3-14: General Scan Preferences Dialog 
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the scanner’s performance to that of your workstation. Use the 
slider to adjust the speed of the scanner. 

• Color space 
When you calibrate your scanner, profiles for both NTSC and 
sRGB color spaces are created. Selection of a color space here 
determines the color profile you want to use while scanning and 
working with WIDEimage. The NTSC Color space has a slighter 
larger color gamut  than sRGB. With NTSC, Color matching 
between different devices (scanner, display, printer) requires Color 
matching via processing of ICC profiles. 
With the sRGB it is not necessary to perform separate Color 
matching steps via processing of ICC device profiles, as long as 
the used devices (scanner, display, printer) are also set to the 
sRGB standard. 
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Batch Scan Preferences 
• Batch Scan 

Batch Scan preferences specify which information will be logged 
during batch scanning (see section 4.3.6 on Batch Scanning).  Log 
information is presented on two levels:  
• Information relative to the whole batch  
• Information relative to each scan in the batch  
The following dialog shows the log data options. By checking an 
item, you specify that  information about its settings will be 
included in the log. 

Log Format 
You can choose one of two formats for your batch log output. The 
Verbose format lists the batch data in a readable format and should be 
your choice for normal reference purposes.  
The Compact, comma separated format is for importing the batch log 
data to another application such as a spreadsheet or database. 
Column headers are only written to a new or empty log file, otherwise 
data is appended without new headers. Fields irrelevant to the scan 
mode are left empty and each line will always contain a fixed number 
of comma separated fields.   
 
 
 
 
 

 
Fig. 3-15: Preferences – Scan - Batch Scan Dialog 
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Prescan Preferences 
• Prescan Mode – Single or Continuous pass 

Select Single pass if you prefer prescanning to automatically halt 
at the end of the document. Select Continuous if you prefer 
prescanning to move back and forth until you manually press the 
Halt button. 

• Prescan resolutions 
Here you determine resolutions for the following prescan activities: 
Index prescan resolution 
Valid for COLOR scanners. In  the Index prescan resolution box, 
you select from a drop-down list the resolution to be used during  
color index (Index Mode) prescanning.  
Histogram prescan resolution… 
In the Histogram prescan resolution  box, you select the resolution 
for use during  histogram prescan. 

• Alignment detection 
Set the scan length for auto alignment detection i.e., how far the 
scanner will look until it finds a line usable for automatic alignment.   

• Paper Size Detection 
Here you set the scan length for automatic paper size detection 
i.e., how far the scanner will look for the signs that reveal the 
original’s edges and paper size.  

 
 

 
Fig. 3-16: Preferences - Scan - Prescan Settings 
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3.4.10 Exit 
 
Exits WIDEimage. 
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4. Scanning - Scan Screen & Scan Menu 
WIDEimage is a powerful tool for controlling your scanning activities 
and facilitating achievement of perfect results. The Scan Screen is 
your scanning cockpit from which all scanning options can be easily 
accessed and adjusted. This chapter focuses on Scanning procedures 
and settings made in the Scan Screen and the Scan Menu. 
 

4.1 Functionality with Different Scanner Models  
WIDEimage is an integrated software package for a large range of 
scanner models and types. Therefore, the availability of some 
scanning options and settings described in this chapter are dependent 
on the scanner model in question.  
 
For instance, options regarding color scanning are of course disabled 
when running WIDEimage with B/W scanners and there are scanning 
Modes that run on certain scanner models but not on others. 
Differences of this kind will be pointed out in relevant sections.  
 
A number of image enhancement features are processed in the 
hardware on some scanner models while the same features are 
software emulated through WIDEimage on others. WIDEimage’s 
enhancement processing (software emulation) gives the same high 
quality results as hardware embedded processing but at lower speeds.   
 

4.2 Scanning Interface - Scan Screen Overview 
The Scan Screen shown overleaf is divided into general areas as 
described in section 3.1 : Menu Bar, Main Toolbar, and Task Toolbar , 
a Main Display Area in the middle, and the Screen-Select Tabs and 
Status Bar at the bottom. 
 
The Task Toolbar position is now occupied by the Scan Toolbar which 
is composed of tools relevant to controlling scanning activities.  
The main display area is subdivided into a: 
• Scan Panel 
• Detail Window 
• Overview Window 
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4.2.1 The Scan Toolbar 
The Scan Toolbar consists of tools that facilitate frequently-used 
scanning operations. Some of the tools are solely related to 
prescanning while others are used in connection with the final scan-to-
file process. Each tool will be described in connection with its relevant 
function under the following sections about prescanning and scanning.  
 

4.2.2 The Scan Panel 
The Scan Panel is found at the upper left side of the Scan Screen, just 
under the Scan Toolbar. This is your main control station for setting 
options that apply to current prescanning and scanning activities. 
Settings such as scanning mode, resolution, paper size, threshold, 
brightness/contrast and many more can be adjusted through the Scan 
Panel.  
 

 
 

 
Fig. 4-1: The Scan Screen 

Scan Toolbar Scan Panel Overview 
Window 

Detail 
Window 
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4.2.3 Detail and Overview Viewing Windows 
WIDEimage offers prescanning with on-screen viewing and adjusting 
before scan-to-file. To support this, the Scan Screen displays 2 views 
of scanning progress. Just under the Scan Panel you find the 
Overview Window and, on its right side, the larger Detail Window that 
dominates most of the Scan Screen. During scanning and 
prescanning, the Overview Window normally displays the whole 
drawing being scanned, while the Detail Window shows a zoom-in to 
the actual scanned pixel level of the part of the drawing pointed out by 
the square position indicator in the Overview Window. 
During prescan you can use the mouse to point and click on any area 
in the Overview Window thus zooming in on that part in the Detail 
Window where viewing, pointing and marking can be performed with 
greater precision. A new prescan on the indicated area takes place 
immediately every time you change the Detail Window view by pointing 
and clicking with the mouse.  
The square in the Overview Window always outlines the area you are 
currently viewing in the Detail Window. The square can be dragged 
around the Overview Window  to a new position or moved horizontally 
by dragging the scrollbar under the Detail Window. 
 

4.2.4 The Scan Status Bar 
The Status Bar in the Scan Screen displays : 
 
• The current paper dimensions in inches or mm depending on your 

unit setting in the File Menu – Preferences – Unit.  
• Special scanning mode status - Scan-to-Print and Batch Scan 

modes. 

 

 
Fig. 4-2: The Status Bar - Scan Screen 
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4.3 An Overview of Scanning Procedures  
Scanning of a drawing is activated by selecting the appropriate buttons 
on the Scan Toolbar. Scanning can be performed either directly or in a 
two-step process : prescanning and scanning-to-file.  
 

4.3.1 Prescanning and Scan-To-File 
Prescanning can be performed prior to scanning-to-file. Prescanning 
loads the image into memory only so you can view it on screen. 
Prescanning allows you to continuously adjust your scanning settings, 
viewing the effects as you go, before activating scan-to-file. During 
prescanning you can for example fine tune the threshold setting, make 
tonal adjustments or define a limited scanning area on a part of the 
drawing, The Forward button will start a prescan. 
Scanning-to-file is performed when you are satisfied with your settings 
and their effects as displayed during prescanning. Scanning-to-file 
may also be carried out immediately if you choose to omit 
prescanning. The Scan button on the Scan Toolbar will initiate a scan-
to-file.  
 
*Note : Prescanning cannot be performed with originals over 2mm 
thick. 
 

4.3.2 Making Enhancement Adjustments  
Enhancement adjustments can be made during prescanning through 
the Scan Panel – Adjustments Tab. When prescanning, each 
parameter adjustment in the Adjustments Tab automatically initiates a 
new prescan of the current area and the effects of the change are 
immediately displayed. You can also click on the Halt button, make 
your adjustments, and then watch as the effects are applied in the 
Detail Window. The enhancement adjustments can then remain active 
when you commit the scan to file or print.  
 
The availability and relevance of these settings depend on the scanner 
model and the Mode selected in the Scan Setup Tab. Detailed 
instructions on using these features can be referenced in coming 
sections on the Scan Panel, Scan Setup Tab and the Adjustments Tab 
in this chapter. For starters, here are some of the adjustment features 
that can be used when prescanning: 
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Contrast/Brightness  
There are different Contrast/Brightness options/dialogs depending on 
your chosen Mode setting and scanner model.  
 
Threshold 
The Threshold can be adjusted manually when selecting B/W 
Threshold scanning mode. The Threshold setting determines the 
degree of compensation for dark or light parts of a drawing. Threshold 
may be changed at any time during prescan.  
 
2D-Adaptive Threshold 
2D-Adaptive thresholding takes place in real time in the scanner 
hardware. Instead of using a singular threshold value, 2D-Adaptive 
thresholding automatically compensates for varying background, faded 
areas and stains and changes the threshold accordingly as it goes.  
 
Dual 2D-Adaptive Enhancement 
Dual 2D-Adaptive enhancement is where processing is performed 
simultaneously on individual aspects of the original. Dual 2D-Adaptive 
enhancement is performed in the copy modes and on some scanner 
models, also in the B/W Adaptive mode with 2D-Adaptive 
Thresholding as one of the processes. Different combinations of the 
following enhancement features are used: ADL+ error diffusion 
halftoning for maintaining grayshades in printouts, 2D-Adaptive 
foreground thresholding, 2D-Adaptive background suppression and 
2D-Auto edge enhancement. The adaptive levels can be adjusted to 
achieve clear images from low contrast and difficult drawings. 
Background suppression is also adjustable on some scanner models.  
Dual 2D-Enhancement works only with the Copy Modes on scanners 
without hardware embedded support for the dual processing. 
 
Black and White Point 
When scanning in Color or Graytone Modes, you can determine the 
amount of highlight and shadow detail  by setting the black and white 
points. By default, the black and white points are determined by the 
calibrated settings in the scanner. The Black and White Point tool 
allows you to change the defaults for the current drawing and offers 3 
different setting methods : Automatic, Manual, and picking colors 
directly from the image.  
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Despeckle/Hole Filling 
Can be set in B/W Threshold and adaptive modes. You can choose 
removal of black speckles and filling white holes. You control the 
degree of despeckling and hole filling by setting the maximum size of 
the speckles and holes. 
 
2D - Sharpen/ 2D - Soften Filter 
This filter can be used to intensify or “mellow” edges in an image. The 
value you enter in the filter field determines the degree of 
sharpening/softening. Sharpening works well with the blur filter (see 
below). 
 
2D - Blur Filter 
The purpose of the Blur filters is to diminish the effect of color or 
graytone dither patterns when scanning printed originals. Using the 
blur filter together with sharpening gives very good results for many 
drawings. The combination of sharpen with blur allows you to enhance 
lines without creating noise in densely colored/graytones areas. 
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4.3.3 Making Your Scan 
In most cases, scanning a document will only require initializing the 
scan job through the Scan Setup Tab (Mode, Paper size, etc.) and 
then just clicking on the Scan button. This of course requires that the 
current or default settings in the Adjustment Tab are considered 
adequate for your drawing.  
In more advanced cases, scanning a document will be a combination 
of the following steps. 
 
Scanning Steps 
1. Initialize your scanning by setting the main parameters for the 

scanning job in the Scan Panel - Scan Setup Tab. These 
parameters must be set before initiating prescan or scan-to-file if 
they are to take effect. Press the Halt Button if you want to reset 
one of the Scan Setup Tab options. 

2. Press Forward to start prescanning your drawing. You can view 
different details by pointing and clicking with the mouse, dragging 
the Area Indicator Square or with the Forward, Halt, Backward 
buttons.  

3. Make the enhancement adjustments listed above as you 
interactively view the effects of your adjustments on-screen. Try 
out different settings for Adaptive level, brightness, sharpen, etc. 
until you find the perfect values. 

4. When you are satisfied with your settings, press the Scan Button 
to perform a scan-to-file.  

 
Use the User Guide Reference Overview below to find details on each 
scanning step. 
 
Scanning Steps – User Guide Reference Overview  

• Initializing – Main Settings: Section 4.4 - Instructions on making 
initial central settings with optional image correction settings. 

• Prescanning phase: Section 4.5 - . Instructions on how to control 
prescanning and details on special options available during 
prescanning. 

• Scan Adjustments: Section 4.6 – Instructions on fine tuning the 
Scan Mode through the Adjustments Tab before scan-to-file and 
during prescanning. 

• Scanning: Section 4.7 – Instructions on scanning to a file and to a 
printer.  
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4.4 Main Scan Settings - The Scan Setup Tab  
Scanning starts in the Scan Panel – Scan Setup Tab. The Scan Setup 
Tab’s 3 main parameters are central to the scanning operation and 
must be set prior to prescanning or scanning to a file since they cannot 
be amended later. These are:  
• The scanning mode  
• The resolution  
• The original’s paper size  
 
Each of these settings involve options that are all accessed through 
the Scan Setup Tab. You can choose to set most of the options at one 
go by using either your own or WIDEimage’s standard Scan Presets 
that combine Scan Panel options under a Scan Preset name. The 
Scan Setup Tab is shown below. 

4.4.1 Scan Presets 
A Scan preset is a combination of Scan Setup Tab and Adjustments 
Tab settings already defined and stored. Scan presets can be selected 
from the drop-down list, and then they can be amended, renamed, or 
deleted. A Scan preset is handy for storing, recalling and standardizing 
your favorite settings. Paper size settings cannot be saved in a Scan 
preset. 
 

 
Fig. 4-3: Scan Panel - Scan Setup Tab 
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To Create a Scan Preset 
• Set the Mode, Resolution and the Adjustment Tab settings. You 

may have just made a successful scan and wish to save your 
settings for future jobs. 

• Select the arrow next to Scan preset and select Create. 
• You will be prompted for a name for your Scan preset. Choose a 

name related to the class of originals you are scanning ( 
RoadMaps, Cartoon Picts ..etc.), so that the Scan Preset can 
easily be found and reused with similar originals. 

• Click OK to save your settings and add the Scan preset to your 
list. 

 
To Amend a Scan Preset  
• Select the Scan preset that is to be amended in order to load its 

settings. 
• Change the settings. The text for the current Scan preset will 

automatically change to None showing that the Scan preset is 
being redefined. 

• Press the arrow button, - select Create and save the settings 
under the original Scan preset name.  

 
Use Standard Scan Presets  
A number of useful predefined standard Scan presets are available 
with your scanner. These presets combine scanning settings that are 
tested with different types of originals such as Light paper, Light/Dark 
Blueprint, Light/Dark Brown Sepia, Gray transparency, Pencil and 
more. Standard Scan presets cannot be deleted or amended, but they 
can be hidden from the drop-down selection list by checking the Hide 
standard scan presets option so only your own Scan presets are 
displayed.  
 

 
Fig. 4-4: Scan Setup - Scan Preset Dialog 
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4.4.2 Scan Mode  
The scan Mode is the most central scanning option and it determines 
the enhancement options available to you in the Adjustments Tab. 
Different scanning modes can be applied for different types of 
scanning assignments. There are true color and reduced color modes. 
Some of the monochrome Modes are especially effective for 
enhancing details on difficult and unclear drawings. Some of these are 
specially designed for printed output (copying) while others are more 
suited for file storage. An overview of the types of scan Modes follows 
below. 
 
The availability of specific scanning modes and the adjustment options 
for each mode depend on your scanner model. Color modes are only 
available with a color scanner. WIDEimage adapts to the detected 
scanner and only displays those modes available to it. 
 
Color Modes 
The Full 24-bit true color mode creates 16.8 million colors. 
 
Indexed color mode is an effective method for scanning documents 
that display a limited range of colors. True colors are automatically 
mapped to a selected color palette based on adaptive color optimizing.  
Indexed color transformation greatly reduces the data volume, 
increases scan speed and minimizes disk storage requirements by 
only requiring 8-bit per color pixel compared with 24-bit in true color 
mode. 
 
Real-time color classification (Classified Color) mode sorts the 
observed color features in the document into a set of color categories 
by on-board mapping through a classified color LUT (Look Up Table). 
Color classification is described in chapter 6 - Feature Extraction. 
 
Monochrome Modes 
Monochrome scanning can be performed in 256 shade graytone, Copy 
modes or line modes.  
 
Dual 2D-Adaptive Enhancement Processing (monochrome) 
Processing works on the foreground and background separately. 
Processing is performed on-the-fly without the need for investigative 
pre-scanning. Enhancement processes are simultaneously performed 
on different drawing aspects. On some scanners, Dual 2D-Adaptive 
enhancement is performed only in the Copy Modes (see below) with 
processing carried out in the WIDEimage software. 
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The Copy Modes 
The Copy modes incorporate Dual 2D-Adaptive enhancement 
processing with different combinations of ADL+ Error Diffusion 
Halftoning, 2D-Background suppression, 2D-Auto edge enhancement 
and 2D-Adaptive thresholding. The copy modes are ideal scanning 
wide format documents that are intended for re-printing. The ADL+ 
Error Diffusion Halftoning supports visibility of graytones in printed 
output by adding toned shades of gray in regions between black and 
white. On some scanners, all Dual 2D-Adaptive enhancement features 
and processing are embedded in the scanner hardware and controlled 
through WIDEimage. For other scanners, WIDEimage provides 
software emulation of any Dual 2D-Adaptive enhancement process not 
supported by the hardware. 

 
Line Modes 
In line modes, the scanner outputs each scanned pixel as a single bit, 
either black (1) or white (0), depending on whether  its gray level is 
below or above the threshold. 
Both adaptive and fixed level thresholding is supported. 
 
Selecting the Scanning Mode 
The scanning Mode is chosen from the drop-down box in the Scan 
Setup Tab. You can set the scanning Mode to one of the following if 
the attached scanner supports the Mode. Here are some guidelines: 
 
• B/W Threshold: This mode uses a global threshold to determine 

whether a pixel is black or white. Use this mode for drawings and 
line art. You set the threshold value in the Adjustments Tab.  

• B/W Adaptive: In this mode the threshold adapts to darker or 
lighter areas in the original as opposed to the B/W threshold mode 
that uses a singular global threshold. The BW Adaptive mode is  
suitable for scanning all kinds of line drawings including difficult 

   
Fig. 4-5: Dual 2D-Adaptive Enhancement -  Before and After 



4-12        Scanning - Scan Screen & Scan Menu 

blueprints, brown transparencies (sepias), etc. A stained or faded 
original can be renewed as good sections are retained and bad 
ones clarified. Normally, the sharpen/blur filters should not be 
adjusted with this mode. This mode provides minimum file sizes 
and is, thereby, well suited for scan-to-file.  This mode supports 
adjustable adaptive level and background suppression. On some 
models, background suppression is applied automatically and only 
the level is adjustable. 
The B/W Copy Adaptive mode (see below) is also good with this  
type of originals but is better suited for creating printed output . 

• B/W Copy Normal: Dual 2D-Adaptive enhancement with ADL+ 
error diffusion halftoning and 2D-Auto edge enhancement and 2D-
Adaptive background suppression. This mode is suitable for 
copying (scan and print) of normal drawings with a reasonably 
good quality. Halftones are distributed throughout the image for 
softer transitions between black and white. 

• B/W Copy Photo: Dual 2D-Adaptive enhancement with ADL+ 
error diffusion halftoning. This mode is suitable for copying (scan 
and print) of continuos shades of gray like in photos. Halftones are 
distributed throughout the image for softer transitions between 
black and white.  

• B/W Copy Adaptive: Dual 2D-Adaptive enhancement with ADL+ 
error diffusion halftoning, 2D-Adaptive thresholding and 2D-
Adaptive background suppression. This mode is suitable for 
copying (scan and print) of Sepia, Blueprint and other originals 
with heavily distorted foregrounds and backgrounds where the 
shades that create unwanted “noise” are close to the shades that 
make up the image’s data and the two are hard to differentiate.  

• Gray Copy Adaptive: Dual 2D-Adaptive enhancement with 2D-
Adaptive thresholding and 2D-Adaptive background suppression. 
Graytone copy to print of originals with heavily distorted 
foregrounds and backgrounds where the shades making up the 
image “noise” are close to the shades making up the image’s data 
and hard to differentiate. Takes advantage of the printer’s high 
resolutions for high quality detailed printed output.  

• B/W Photo: A halftone dithered mode suitable for photos and 
printouts. Scans gray-tones and converts them to dithered black 
and white in the end file. Scanning is performed in 8 bit graytone 
mode while the program generates halftone data in memory based 
on the Floyd Steinberg algorithm. You adjust Contrast/Brightness 
and Lightness in the Adjustments Tab.  
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• Graytone: In this mode 256 gray levels are recognized for each 
pixel (1 byte, 8 bits per pixel). Gives good reproduction of 
complicated B/W images like B/W photos. You adjust 
Contrast/Brightness and Lightness in the Adjustments Tab.  

• RGB Color: 24 bit true color mode for capturing all of the image’s 
colors. This mode produces large files. You adjust 
Contrast/Brightness in the Adjustments Tab.  

• Indexed Color : Indexed Color mode allows you to compress file 
size by reducing the colors produced to a number between 2 and 
256. In Indexed Color Mode, you can adjust Contrast / Brightness 
through the Adjustments Tab.  

Clicking the setup  button  in this mode displays a dialog for 
selecting the number of colors and a method for computing the 
index color values based on a prescan analysis of the image. The 
3 methods are: 
Linear: Index colors are linearly distributed without a prescan.  
Adaptive Photo: Index colors optimized for photos with prescan 
and image adaptation. 
Adaptive Map: Index colors optimized for maps with prescan and 
image adaptation. 

• Classified Color :  This mode is for scanning with a LUT filter 
created in the Feature Screen.  

Click on the setup button  to invoke a standard open file dialog 
where you can select and load your feature extraction LUT file 
(.lut). See chapter 6 for details on feature extraction, LUT filter 
creation and the Feature Screen. 

 

4.4.3 Resolution 
Scanning resolution is the number of pixels per inch (dpi) in the end 
(scanned) image. An image with a high resolution will contain more 
and thereby smaller pixels than an image with equal dimensions with a 
lower resolution. High resolution images will therefore normally display 
more detail and wider color ranges than low resolutions. However, high 
resolutions produce larger files with the usual  setbacks in relation to 
disk space, load time, etc.  
Your selection of resolution will therefore depend mainly on how you 
intend to display the image. For offset printing, high resolutions work 
best while for screen and web display, lower resolutions will suffice. 
Normally, 300 dpi and above are considered high resolutions. High 
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resolutions can also be necessary if small details (like in maps) must 
be displayed clearly. Often, your output device’s documentation will 
contain recommendations about optimal scanning resolutions. 
The image resolution should be determined before scanning i.e., 
before your original is digitized and the image transformed to pixel 
data. Using an Image editor to increase resolution of an image 
scanned at low resolutions will normally not improve the image’s 
quality. 
Resolution is selected from the Resolution drop-down box in the Scan 
Setup Tab. Depending on the scanner model, the drop-down box 
shows either predefined normal resolutions, predefined turbo-
resolutions, or the physical resolution.  

Click on the Setup button  to display a dialog for selecting 
between different resolution lists. WIDEimage automatically detects 
the resolutions supported by the attached scanner and displays only 
those applicable. Selections are: 
• Normal: The edit field allows you to set the scanning resolution in 

one DPI increments. 
• Turbo: Selecting Turbo sets the scanner in vertical interlaced 

mode and speeds up the scan process by up to two times. Turbo 
mode has no effect for resolutions below 300 DPI and is not 
available in Classified and Index modes.   

• Physical: This list is of interest when scanning in graytone mode 
for later processing. The resolution is the actual unscaled physical 
resolution of the attached scanner. 

 
Scaled Resolutions 
Some scanner models support Scaled Resolutions that allow you to 
make very high-resolution settings above the scanner’s true maximum 
scanning resolution. The higher (scaled) resolution is achieved by 
adding pixels to the image. The number of pixels used to replace each 
pixel depends on the scaled resolution setting made by the user. 
Instead of simply replacing each pixel with clusters of identical ones, 
precise color shades are assigned to the new pixels. The shades are 
calculated though interpolation between the original pixels (gradual 
change). 
Just write the higher resolution, example “1000” in the resolution edit 
field. See your scanner documentation for the maximum scaled 
resolution supported. 

4.4.4 Setting the Paper (original) Size  
Setting paper size is a two step process: 
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• Select the setup arrow button to choose the method for paper size 
calculation. 

• Select the actual size that relates to your chosen method.  
 
Setting the Paper Size Method 
The scanner must know the paper size of the original. This is not only 
important for capturing the whole image, but also effects 
measurements and calculations on technical drawings and maps. The 
application offers many different methods for determining the original’s 
paper size. You select the method for defining your paper size through 
the Paper Size Method menu (Fig 4-6 overleaf) that you activate by 
clicking the setup button.  

  

The chosen method will always be written in the Scan Setup Tab with 
the corresponding units setable in the edit field.  
Depending on your scanner model, you can choose one of the 
following methods: 

• Fixed Paper Size – Available standard sizes including common 
US, European and DIN drawing sizes and user defined custom 
sizes. You choose from a list of sizes that appears in the edit field. 
Amedning the list and sizes is described under Setting Paper Size 
Method Parameters. 

• Auto Paper Size – Automatic detection of your paper size. You 
can make one of the following selections if available on your 
scanner model:  
Auto size ISO: The Width and left-Offset are automatically 
detected, snapping to nearest standard ISO paper size. Setting 
Orientation will also affect auto sizing. Length is set according to 
the detected standard size. 
Auto size US: The Width and left-Offset are automatically 

 
Fig. 4-6: Paper Size Method Menu 
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detected, snapping to nearest standard US paper size. Setting 
Orientation will also affect auto sizing. Length is set according to 
the detected standard size. 
 Auto width: The Width and left-Offset are automatically detected 
without snapping. Use this setting if your original is not close to a 
standard size. 
Auto image width: Auto size detection on some color scanner 
models. The max paper width is detected and the whole length of 
paper is scanned.  
Hollerith size info: (Aperture Card scanners only) The paper size 
will depend on the Hollerith code on the card. Go to the Paper 
Setup option to set the card parameters. The steps involved are 
described under Setting Paper Size Method Parameters.  

• Paper Width only – With this method you set the paper width 
values directly in the Paper Size Method edit box. The values will 
be interpreted as inches or mm depending on the setting in the 
File Menu-Preferences dialog or as scanner units if you check the 
Use Scanner Units option ( see below). 

• Centered Paper Load – Checkmark this option if you are loading 
from the center. Unmark it if you are loading from the side. Make 
sure the setting corresponds with the physical positioning of the 
paper, or you will get a blank scan. This option defaults to the 
Paper position setting in the File Menu – Preferences dialog. 
Changing the setting here in the Paper Size Method Dialog 
temporarily overrides the Preferences setting for the current 
scanning session.  

• Use Scanner Units – Scanner units are drawn on the scanner 
near the insertion slot. For example, with the Paper Width Only 
method, the original’s paper size can be read off the scanner and 
then defined by these units if you check this option. This setting 
affects also the Paper Size Setup list so that all the standard sizes 
will be defined in scanner units. 

 
Setting Paper Size Method Parameters 
 
The Paper Setup option is for defining Fixed Paper Size values, the Y 
(vertical) offset with Auto Width and automatic detection properties for 
Aperture Card scanning. Paper Setup leads to one of the following 
option groups – Paper Size, Y offset, and Oversize, depending on the 
selected paper size method. Lets look at the method parameters in 
each option group. 
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Paper Size 
With the Fixed Paper Size option selected, Paper Setup leads to the 
Paper Size Setup dialog for defining your paper sizes. The most 
popular standard sizes are already defined in the program. You can 
add, edit and delete your own size definitions in the list.  
The Paper Size Setup dialog is shown overleaf. 

Create New sizes  - Click the New Size tool at the top to add a new 
size.  
Edit existing sizes - Edit directly in the list’s fields to change values for 
existing sizes, and  fixed offsets. You select paper orientation (portrait 
or landscape) by selecting the size defined by “P” or “L” like A4-P and 
A4-L. Only offsets can be edited in predefined standard sizes. 

Delete a size  – Select a size with the arrow buttons or by clicking 
and then select the delete button. Predefined standard sizes cannot be 
deleted. 
 
Auto Paper size detection with Aperture Cards (Aperture Card 
Scanners only) - You can use Auto Paper Size detection with an 
Aperture Card scanner. Your Hollerith cards hold punched hole 
information for the image paper size. The parameters you set tell the 
program where to look for this information and what to do. Here’s how 
you setup automatic paper sizing with aperture card scanning: 

 
Fig. 4-7: Paper Size Setup dialog 
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• Click the Auto Paper Size option. With an Aperture Card scanner, 
the paper size window will display "Hollerith Size Info". 

• Click again the arrow button to the right of the paper size window. 
In the sub menu, click the Paper Setup - Paper Size... option. 

• The Paper Size Setup dialog appears with additional fields related 
to Aperture Card scanning and the Hollerith codes on the cards.   

• The list of defined paper sizes shows standard or customized 
sizes. You can create your own sizes if necessary with the button 
for new sizes.  

• Attach Hollerith paper size detection codes to the paper sizes by 
filling in the list's rightmost column. For example, your cards may 
have been constructed with the code "A4" in card column 67, 
indicating that the standard A4 portrait size is to be used for the 
image. In this case you would write “A4” in the Size Code field for 
the size named A4-P. 

• Amend the Reduction factor (Red. Factor) field if necessary. The 
Reduction Factors have standard values and  define the relation 
between the image on film and the original size 

• In the "Hollerith paper size code starts at column" field, you enter 
the punched column where the paper size information is found 
such as "67" in the current example. Codes will be interpreted 

 
Fig. 4-8: Paper Size Setup with Aperture Cards 
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according to the paper sizes and their attached codes in the list of 
defined paper sizes that you prepare. 

• The next three options determine what will happen should the 
scanner meet cards that do not contain a matching code. You can 
select one of the following actions: 

• Proceed without scanning card - skip the card and go on. 
This can be useful for selecting only certain cards for 
scanning. 

• Stop Scanning - You may expect all the cards to have valid 
codes and you want to manually check the process if a code 
cannot be read. 

• Scan card using size code - allows you to force an 
alternative size for those cards without valid codes. 

Paper Y offset - With the Auto Paper Size option selected on normal 
Wide format scanners, Paper Setup leads to a dialog in which you 
enter an offset for the scanning (Y) direction. The default offset is zero. 
Oversize – Select Oversize for expanding all paper sizes by a user-
defined factor. This option is available with all paper size methods. 
 

4.4.5 Optional Image Correction Settings  
Apart from the central settings, the following operations can be 
performed while creating a scanned image. These operations only 
take effect during scanning and cannot be previewed during  
prescanning. For all these tools,  you select the desired operation just 
before selecting the Scan Button  after optional prescanning if 
performed.  

Invert (image colors) 

 
Click on the Invert  tool before scanning to file. This will reverse the 
image colors in your end file. The result is a negative image. When 
scanning in color modes, the R,G & B channels invert separately. 

Mirror 

 
It is sometimes necessary to scan a drawing on transparent film from 
the "back", due to the toner being on that side of a film. This would 
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result in unintended reversal or “mirroring” of the image in relation to 
the original. Click on the Mirror tool before clicking on the Scan Button 
to “re-mirror” the drawing thus reversing the undesired effect. 

Rotation 
You can rotate the image in the end file.  

Rotate Right  (90°) :    

Rotate Left  (270°) :        

Rotate 180° :   
 
Press the desired Rotation tool before hitting the Scan Button and the 
image will be saved with the indicated adjustment. The Rotation tools 
are only available if Fixed Paper Size has been selected as the paper 
size method.  

4.5 Using Prescanning  
Prescanning allows fast on-screen viewing of scanning results with 
different settings and adjustments. Prescanning is optional and if you 
feel confident with the initial settings, you can skip prescanning and 
scan directly to a file. But for difficult drawings, or for your first 
experience with a certain type of original, prescanning offers 
advantages that are hard to overlook.   
 
After having inserted the drawing into the scanner and chosen your 
central initial settings in the Scan Setup Tab, start prescanning by 
selecting Forward on the Scan Toolbar. Your image will gradually 
appear in the Overview and Detail windows as the original is 
horizontally scanned. You control prescanning of specific areas by 
activating one of the tools for area selection described below.  
During prescanning, you can make different enhancement 
adjustments (Threshold, Brightness, etc.) through the Adjustments 
Tab, based on what you see in the Detail View Window in order to find 
the best solution for the particular drawing. You can make a complete 
assessment of the drawing by analyzing specific difficult areas. 
TIP: Let the whole image be prescanned before making adjustments 
so you can afterwards click-select any area for detailed viewing. 

NOTE: Media over 2mm thick cannot be accurately prescanned. 
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See also section 3.4.9 for details on selecting Prescan Preferences.  

4.5.1 Forward, Halt and Backward Buttons 

           
Using these toolbar buttons you can alter the prescan direction and 
Halt in an area of your choice. Prescanning is started by pressing the 
Forward button and will go into Halt Mode when your press Halt.  
While in Halt Mode, every adjustment you make automatically starts a 
new prescan of the area currently viewed in the Detail View Window 
while immediately displaying the adjustment’s effects on your screen. 
Applying adjustments while in Forward or Backward Modes will 
automatically put prescanning into Halt mode and thus initiate a new 
prescan over the current prescan area, as if you had pressed Halt 
manually.  
 
 
 
 

4.5.2 Fast Prescan Area Selection 
An alternative to using the Forward, Backward and Halt buttons for 
repositioning the Detail Window view, is to click with the mouse in the 
Overview Window  on the area you wish to work on. This initiates a 
fresh prescan and the specified area will appear in the Detail  Window 
with  the operation ending in Halt Mode. The new position of the 
square in the Overview Window indicates the area displayed in the 
Detail  Window.  
You can also drag the square to a new area in the Overview Window.  
• Press and hold the left mouse key while pointing at the square to 

activate the panning cursor (hand). 
• Drag the square while still holding down the key. 
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• Release the mouse key thus starting a new prescan and a detailed 
(zoomed in) view of the new area in the Detail Window.  

4.5.3 Reset Prescanning 

 
Use the Stop Button to reinitialize a whole new prescan operation. 
Activating the Stop Button during prescanning will return the original to 
the start position and the Scan Setup Tab will be redisplayed, enabling 
you to reset/change the Scan preset, Mode, Resolution and Paper size 
settings. 

4.6 Optional Settings During Prescanning  
Prescanning allows you to see results before they are committed to a 
file. WIDEimage takes advantage of this with special tools that can be 
applied to the image on your screen during prescanning. The  visible 
effects are then reapplied during  scan-to-file. Unlike the enhancement 
options in the Adjustment Tab, these tools do not relate to the 
Scanning Mode. 
 

4.6.1 Scan an Image portion - Scanwindow 

 
Fig. 4-9: Drag the area indicator square in the Overview Window 
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With a Scanwindow you can scan a specific isolated area of a drawing. 
The Rectangle Selector Tool  for defining a Scanwindow is found on 
the Scan Toolbar.  

Defining a Scanwindow 
• Select halt during prescanning and click on the Rectangle Selector 

button on the Scan Toolbar. 

• The cursor will change to the rectangle draw pointer.  
• You define a Scanwindow by dragging a rectangle in the overview 

window.  
• The rectangle can be resized and moved by dragging at its edge 

and corner handles.  
• If great precision is required, you can either move the rectangle 

into the Scan Area Indicator square or move the Scan Area 
Indicator square onto the rectangle. Either action will zoom in on 
your Scanwindow in the Detail Window from which it can be 
adjusted in a zoomed in view.  

• While the Rectangle Selector is active (button ON), click on the 
Scan button to initiate a scan-to-file with only the selected part as 
scanning input. 

• The Rectangle Selector tool stands ready after you select 
Forward, and is turned off either by clicking on it again or by 
starting a scan-to-file. 

 
 
 
 
 

4.6.2 Image Alignment 

 
A drawing which is not perfectly oriented horizontally during insertion 
into the scanner can be electronically deskewed during scanning. 
Realignment is performed by placing an alignment line in the drawing. 
WIDEimage  helps by automatically creating an alignment line based 
on features in the original image. For most purposes and originals, the 
automatically created line will be positioned with sufficient accuracy 
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but, you have the option of amending it manually if necessary. The 
Align Tool is available when prescanning.  
 
Setting an alignment line 
• Click the Align tool to activate the Align Mode and click the 

Forward button. 
• When in Align Mode, starting a prescan will automatically place a 

system-calculated alignment line on the image on-screen. 
• If the calculation/angle of the automatic line does not meet your 

requirements, it can be repositioned, rotated, etc. Here's how: 
• Use your mouse for making changes and adjustments to the 

alignment line. Moving the mouse over the line activates functions 
and relevant cursors as described below : 

• Move the cursor over one of the alignment-line's end-points to 
reveal its adjustment and resizing handles. You can drag a line 
end while holding down the left mouse key to adjust its length or its 
alignment angle. 

• Clicking on the right mouse-button, while pointing at one of the 
end-points, will make the cursor jump to the other end-point. 

• Move the mouse over the line middle to reveal its movement 
handles indicated by the cursor on contact. With these handles 
you can move the alignment line to a different position on the 
screen while retaining its original angle. 

• All the above mouse and drag functions can be deactivated by 
pressing the <ESC> key. 

• The alignment angle is displayed in the Status Bar. You end the 
alignment process by re-clicking the Align tool button. 

• Press the Scan button use your alignment in the resulting scanned 
file.  

• Use the Stop button if you wish to deactivate the Align Mode and 
remove the line without using it. 

 

4.6.3 Black and White Point 

 
With the Black and White Point Tool you determine the amount of 
highlight and shadow detail during scanning in one of the Color or 
Graytone Modes. By adjusting the white point you determine the 
amount of highlight detail in the scanned image. The white point 
should be set so that the lightest part only just shows no detail. 
Adjusting the black point will determine the amount of shadow detail in 
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the scanned image. The black point should be set so that the darkest 
part only just shows no detail. 
Click on the Black and White Point Tool to access the adjustment 
dialog. This initiates a prescan and a luminance histogram is 
calculated and displayed. 

Black and White Point setting options 
The Black and White Point dialog contains four option (check) boxes : 
• Logarithmic scale 
• RGB  
• Luminance 
• Keep color balance 
Logarithmic scale - Try this option if your histogram doesn't bring out 
enough detail. For example, an image that contains a large white 
background will show a very high peak and other colors that are 
represented by relatively small amounts of pixels will hardly be visible. 
Such large differences can be accounted for by checking the 
Logarithmic option. This will recalculate histogram point values by a 
logarithmic function rendering large pixel groups of single colors less 
dominating thus bringing out details that otherwise would not be visible 
in the histogram. 

 
Fig. 4-10: Black and White Point Setup dialog 
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RGB - Check this option if you wish to view and set highlight and 
shadow through R, G, B Histograms, either with or without the Keep 
color balance option checked. 
Luminance - Check this option if you wish to view and set highlight 
and shadow through a luminance histogram. 
Keep color balance - Check this option if you wish to retain the 
current color balance and effect Red, Green and Blue channels 
simultaneously. If an image shows unbalanced color, for example if it 
seems too blue, you can uncheck this option and adjust blue 
separately without effecting Red and Green channels. This option is 
automatically checked when working with the Luminance histogram 
(see below). 
 
Setting Black and White Point 
The initial Histogram displays the current black and white points. Black 
and white point values can be modified  by you through one of the 
following options : 
 
Auto:  Automatic calculation based on the image's darkest and lightest 
values according to the current histogram – based on either RGB 
values or Luminance.  
• Click  the Auto button to set the black and white points 

automatically. 
Manual: Direct use of RGB values for setting black and white points. 
• Set your Values manually either by moving the sliders or by writing 

in the edit field. 
• Check Keep color balance to tie the sliders together, enforcing 

equal Red, Green, Blue values for both the White Point and the 
Black Point. This will maintain the current color balance in the 
scanned image.  

• Click the Reset button if you wish to reset the sliders to the value 
currently set in the scanner. 

Manual Picking : You can use a black pick tool or the white pick tool 
to select black and white directly from the prescanned drawing.  
• Click on a Pick button to activate a black or white pipette. 
• Drag the mouse pointer to select a whole area of pixels. When you 

release the button, an average of the pixels in the area defines the 
Black or White point.  

• To select one pixel, just click and release without dragging. 
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Click OK to activate your new settings. 
Click Cancel to reset the previous settings and end the dialog. 
 
The values are offsets to those found during calibration. If you wish at 
any time to return to the calibration values, set the sliders to Black 
Point: 0,0,0 and White Point: 255,255,255. 
Ranges for the Black Point settings are from 0,0,0 to 15,15,15 and for 
White Point settings 128,128,128 to 255,255,255 but these can vary 
with different scanner models. 
When you leave WIDEimage, the modified offsets are not stored. At 
startup, WIDEimage will revert to the calibrated settings: Black Point: 
0,0,0 and White Point: 255,255,255. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.7 Tuning Your Scan - The Adjustments Tab 
In previous sections we described how prescanning and scanning 
operations involve making initial settings followed by Scan Mode 

 
Fig. 4-11: Black and White Point - Manual Selection Pipettes 
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related adjustments. This section gives instructions on performing 
these adjustments for achieving optimal results.  
The Adjustments Tab allows you access to quality enhancement 
features and on-the-fly adjustments during prescanning, such as 
threshold, brightness and contrast settings, i.e., Scan Mode related 
adjustments. After setting your options in the Scan Setup Tab, 
WIDEimage switches automatically to the Adjustments Tab when you 
initiate prescanning. If you wish to omit prescanning, just click on the 
Adjustments Tab, and make your adjustments before clicking on the 
Scan Button. 
   
The adjustment Options are specific to each scanning mode 
The Adjustments Tab allows you to make adjustments on options 
relevant to the scanning Mode which you selected through the Scan 
Panel’s Scan Setup Tab. Because of this, the options displayed or 
enabled on the Adjustments Tab depend on the selected Mode (and 
on your scanner model). The Adjustments Tab for the B/W Threshold 
Mode is displayed below.  
You can make Adjustments Tab settings continuously during 
prescanning or else immediately after making your initializing central 
settings and before scan-to-file. 
Throughout the rest of this section, Adjustment Tab options are 
described under the Scan Modes that activate them. 

4.7.1 Adjusting the B/W Threshold Mode  
The Adjustments Tab with options for B/W Threshold mode is 
displayed in the previous figure. When a camera in the scanner looks 
at a drawing, it converts what it sees to graytone levels between 0 and 
255 with dark tones represented by low values, light tones by high 
values and middle tones by middle values. When  scanning at a 

 
Fig. 4-12: Scan Panel - Adjustments Tab  
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specific threshold all gray tones below the selected threshold value will 
be represented as black pixels, and all gray tones above will be 
represented as white pixels. For example, if you have a very faded line 
drawing, you might want to increase clarity by setting a high threshold, 
thus forcing some of the  grays back to their original black. 
 
Setting the Threshold  : 
The threshold can be set in three different modes: 

• Threshold: The threshold value is set by clicking on the up/down 
arrow buttons, or by editing in the field. This mode allows you to 
make threshold adjustment during prescanning activities (using 
the forward, halt, backward tools) while the effect is displayed on 
the screen.  

• Histogram, Auto: Histogram analysis is performed as described 
above, but scanning-to-file proceeds automatically using the 
computed global threshold value without displaying  the histogram.  
The drawing is prescanned and investigated. A global single 
threshold value is computed based on the analysis of the graytone 
histogram. The drawing is then automatically returned to its 
starting point, after which  scanning progresses using the 
determined threshold value. 

• Histogram Manual: After you click on the "Scan" button, the 
scanner automatically does an investigative scan of the original 
and returns it to the starting position. The image is analyzed by the 
scanner, and a histogram of the distribution of graytones in the 
image is displayed on the screen together with a proposed 
threshold setting computed algorithmically. You can accept the 
proposed value or change it with the threshold slider, thereby 
choosing an optimal threshold value. See section 4.6.2 for more 
details on using the histogram. 
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Setting Filters :  
After selecting the threshold mode, you can take advantage of the 
following filters : 

• Despeckle and Hole Filling: You can select/deselect 
Despeckling and/or Hole Filling filter(s). Using the up/down arrows, 
you can define the filter size as the number of pixels that make up 
one side of a square box. Despeckling removes black speckles 
that fit within the box. Hole Filling fills white holes that fit within the 
box. Filtering occurs on-line during scanning. Despeckle and Hole 
Filling adjustments can be done during prescanning as you view  
the effects on screen.  

• Blur Filter: (not available on all scanner models) The Blur filter 
blends graytones and thus removes unwanted “noise” from the 
image. The value you set determines the degree of graytone 
blending. This filter can be combined with sharpening if available 
on your scanner (see below). 

• Sharpen/Soften Filter: (not available on all scanner models) The 
Sharpen/Soften filters go over the scanned image, and intensify or 
“mellow” identified edges. The value given the filter with the slider 
determines the degree of sharpening/softening. Using this filter in 
combination with the Blur Filter can often enhance image quality 
as the scanner first blurs away unwanted noise and then sharpens 
the result. 

*Sharpen/Soften and Blur filters are not available on all scanners in B/W Threshold 
mode. 
 

 
Fig. 4-13: Drawing Scanned at 
threshold setting of 45 

 
Fig. 4-14: Same Drawing at threshold 
value setting of 210 
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4.7.2 Adjusting the B/W Adaptive Mode 
 
Adaptive Level works like a threshold - the lower the value, the more of 
the background is picked up during scanning. 
 

Some scanner models apply automatic background suppression in this 
mode while others let the user adjust background suppression 
automatically.  

Background suppression (if adjustable on your scanner model) is 
normally set to zero, but can be raised to suppress the background 
influence in drawings with dark or patched multilevel backgrounds. 
 
 
 
 

 
Fig. 4-15: Adjustments Tab - B/W Adaptive Adjustment 

 
Fig. 4-16: Adjustments Tab - Adaptive Level with background suppression 
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Using the adaptive controls: 
• Start prescanning by clicking the Forward button.  
• Find a critical area on your image in the Overview Window and 

click on it using your mouse. 
• After prescanning the selected area, WIDEimage will go 

automatically to Halt Mode. Now, any adjustments you make 
in the Adjustments Tab  will initiate a new prescan of the area 
currently viewed in the Detail Window while displaying the 
effects of your new settings immediately. In this way, the 
adaptive level and scan quality can be altered interactively 
while viewing the results on-screen.  

• Adjust the adaptive Level for the best result. 
 

Setting Filters: 
• Despeckle/Hole Filling: You can select/deselect Despeckling 

and/or Hole Filling filter(s). Using the up/down arrows, you can 
define the filter size as the number of pixels that make up one side 
of a square box. Despeckling removes black speckles that fit 
within the box. Hole Filling fills white holes that fit within the box. 
Filtering occurs on-line during scanning.   

• Blur Filter: (Not available on all scanner models). The Blur filter 
blends graytones and thus removes unwanted “noise” from the 
image. The value you set determines the degree of graytone 
blending. This filter can be combined with sharpening if available 
on your scanner (see below). 

• Sharpen/Soften Filter: (Not available on all scanner models). The 
Sharpen/Soften filter goes over the scanned image, and intensifies 
or “mellows” identified edges. The value you enter in the filter field 
determines the degree of sharpening/softening. Positive values 
sharpen and negative values have a softening effect. Using this 
filter in combination with the Blur Filter can sometimes enhance 
image quality by first blurring away noise and then sharpening the 
result. 
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4.7.3 Adjusting the B/W Copy Modes 
B/W Copy Normal, B/W Copy Photo, B/W Copy Adaptive 
 
Adaptive Level works like a threshold - the lower the value, the more of 
the background is picked up during scanning. 

 
Using the adaptive controls: 

• Start prescanning by clicking the Forward button.  
• Find a critical area on your image in the Overview Window and 

click on it using your mouse. 
• After prescanning the selected area, WIDEimage will go 

automatically to Halt Mode. Now, any adjustments you make 
in the Adjustments Tab  will initiate a new prescan of the area 
currently viewed in the Detail Window while displaying the 
effects of your new settings immediately. In this way, the 
adaptive level and scan quality can be altered interactively 
while viewing the results on-screen.  

• Adjust the adaptive Level for the best result. 
• Adjust Background Suppression if available in the dialog. 

Automatic (Auto) Background Suppression can be selected.  
• Use the Sharpen and blur filter to enhance image edges in 

your printed output while reducing noise in dense graytone 
areas. 

 
Setting Filters: 
• Blur Filter: The Blur filter blends graytones and thus removes 

unwanted “noise” from the image. The value you set determines 

 
Fig. 4-17: Adjustments Tab - Copy Modes 
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the degree of graytone blending. This filter can be combined with 
the sharpening filter (see below). 

• Sharpen/Soften Filter: The Sharpen/Soften filter goes over the 
scanned image, and intensifies or “mellows” identified edges. The 
value you enter in the filter field determines the degree of 
sharpening/softening. Positive values sharpen and negative values 
have a softening effect. Using this filter in combination with the 
Blur Filter can often enhance image quality as the scanner first 
blurs away noise and then sharpens the result. 

 

4.7.4 Adjusting the Gray Copy Adaptive Mode  
 
The Gray Copy Adaptive mode uses the detail of graytone data 
together with adaptive thresholding to produce enhanced gray data 
ideal for output on printers with high resolutions. As this mode uses 
adaptive thresholding combined with graytones, both adaptive and 
graytone adjustment controls can be applied. 

 
• Follow the instructions described above for the Copy Modes to 

make your Adaptive Level, Background Suppression and 
Sharpen/Soften/Blur adjustments. 

• Use the following descriptions about the Dither, Graytone and 
Color Modes to make adjustments on Contrast, Brightness, 
Lightness, and Gamma settings in the Gray Copy Adaptive 
mode. 

 
 
 

 
Fig. 4-18: Adjustments Tab: Gray Copy Adaptive Mode 
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4.7.5 Adjusting Dither, Graytone and Color Modes 
B/W Photo, Graytone, RGB Color, Indexed Color, Classified Color  

In these modes you can make tonal adjustments and add blur, 
sharpen and soften filters.  
 
NOTE: With Classified scanning, you will have laid the groundwork for 
color results for a whole class of maps or drawings in the LUT filter 
while working in the Feature Screen. Therefore, you normally would 
not want to make any special tonal adjustments in the Adjustments 
Tab for Classified scanning while applying the filter. Your LUT should 
be created on the basis of a 24-bit color scan with all the Adjustment 
Tab settings at their defaults. Classified scanning is on the other end 
of the process and keeping the Adjustment Tab settings at their 
defaults here as well will ensure that your LUT filters the colors as you 
expect it to. 
There are three possible methods for making tonal adjustments in the 
dither, graytone and color modes: 
 
Setting Brightness/Contrast  
• Brightness 

Use brightness to compensate for a light or dark original being 
scanned. Numeric values for brightness are defined by clicking on 
the up/down arrow buttons or by editing directly in the fields. The 
normal position is zero with negative values for reducing 
brightness and positive values for intensifying brightness.  

• Contrast 
Contrast is the range between light and dark in an image. An 
image with little midtone detail, heavy shadows and bright 

 
Fig. 4-19: Adjustments Tab - Dither, Graytone & Color Modes 
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highlights can have too much contrast and, conversely one mainly 
with midtone detail, dull shadows and highlights can have little 
contrast. Adjusting the contrast can make colors more vivid and 
realistic. Numeric values for contrast are defined by clicking on the 
up/down arrow buttons or by editing directly in the fields. The 
normal position is zero with negative values for reducing contrast 
and positive values for adding contrast.  

Setting L/S/B (Lightness, Saturation, Balance) Levels 

Selecting this option and clicking on the setup button  starts a 
dialog where values can be entered for lightness and saturation, and 
balance values for red, green, and blue. 
• Use the sliders to select the tonal values. 
• Click Apply to activate the settings in a new prescan without 

closing the dialog. 
• Click Reset to reset all the L/S/B values to 0. 
• Click Cancel to apply the previous values and close the dialog. 
 
Note: In the modes BW Photo, Graytone and Gray Copy Adaptive, 
only the Lightness value is available for editing. 
 
Using a Gamma Curve   
Select the Gamma Curve tonal adjustment option. 
You can set a Gamma value in the edit field or...  

select the  setup button   to start a dialog for setting color tone 
transfer curves through the Gamma Curve Editor . 
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Gamma adjustment can be used to make tone distribution lighter or 
darker in an image with emphasis on midtones rather than the extreme 
(black, white) ends. All three (Red, Green , Blue) color channels can 
be effected together with each change. Turn up the Gamma value to 
lighten the image tones and turn down the Gamma value to darken the 
tones. For example, if you are scanning a picture of a blue sea,  a 
lower Gamma value will change the sea’s color towards a darker 
marine blue, and turning up the Gamma value will change the normal 
sea color to a light sky-like blue. 

The color tone transfer curves can be modified in the Gamma Setup 
dialog, either as separate curves for each color (Red, Green, Blue) or 
as a common curve.  
 
Note: In the modes BW Photo, Graytone and Gray Copy Adaptive, the 
three separate color channels will not be available for editing and the 
editing takes place on the common curve. 
 
The lower left end of a tone curve typically represents the dark portions 
of the scanned image and an upward bend will typically lighten the 
shadows. Similar capabilities exist when working with the middle and 
highlight parts of a curve. In this way it is possible to alter only certain 
tonal ranges of an image without making unwanted changes to other 

 
Fig. 4-20: Gamma Setup Dialog  
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parts. 
 
Editing the Gamma Curve:  
Double click on the line to set and display editing points. Move the 
mouse over the point to display drag handles. You can use these to 
adjust the tone curves, either separately or as one curve.  
The following editing options are available: 

 
• Use the Red channel, Green channel, Blue channel option groups. 

Use the Visible option to render the channel editable. Marked 
channels will be part of the curve. For example, if all three Visible 
options are checked, then the curve represents all channels 
together in a common curve. If only Red’s Visible option is 
checked, then you can amend the Red channel separately. 

• Use the Linear option boxes to indicate if curve adjustments 
should use straight lines between the editing points. 

• Use the Curve option boxes to indicate if curve adjustments 
should use curves between the editing points. 

• Identical curve sets the active curves equally. 
• The Create curves from gamma value option box enables you to 

edit the curves by setting gamma values. 
• The Grid option sets a grid behind the curves to assist in editing. 

 
Apply : Click the Apply button to activate the gamma setting and start 
a prescan without closing the dialog. This lets you preview the curve’s 
effects as you make amendments. 
 
Cancel: Click Cancel to restore the previous gamma values in the 
scanner. 
Reset: Click on Reset to reset the currently selected color tone 
transfer curve to linear (1 to 1) and remove current handles.  

S-curve: The default representation is linear. Clicking S-curve will set 
the tone transfer curve to a Floyd-Steinberg curve, also called an S-
curve, which is a commonly used tone enhancement for photos. 
Default .   

The modified curves are stored when you leave the dialog by clicking 
Apply or OK. The color transfer curves will be downloaded into the 
scanner when you initiate a prescan or scan-to-file operation.  
 
Setting Filters: 
• Blur Filter : The Blur filter blends colors or graytones and thus 

removes unwanted “noise” from the image. The value you set 
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determines the degree of color or graytone blending. This filter can 
be combined with sharpening if available on your scanner (see 
below). 

• Sharpen/Soften Filter: (Not available with Indexed and Classified 
modes) The Sharpen/Soften filter goes over the scanned image, 
and intensifies or “mellows” identified edges. The value you enter 
in the filter field determines the degree of sharpening/softening. 
Positive values sharpen while negative values have a softening 
effect. Using this filter in combination with the Blur Filter can often 
enhance image quality by first blurring away noise and then 
sharpening the result.  

4.7.6 Using a Histogram to Adjust the Threshold 
A histogram analysis can be used with the B/W threshold mode for 
B/W drawings. 
A Histogram is a graphic representation of the number of pixels at 
each graytone level in an image. The histogram can be displayed on 
screen and used to manually set a threshold value of your choice. This 
method is adequate for drawings that do not have isolated difficult 
areas and where a global threshold value would suit the whole 
drawing. Setting the threshold using a Histogram is available when 
scanning in the B/W threshold mode by checking Histogram Manual. 
For more difficult drawings, best results would be achieved by using 
the 2D-Adaptive scanning modes.  
 
Histogram analysis is based on the fact that a normal drawing does 
not only contain black and white. A drawing might have a dark blue 
background, or perhaps brown lines on a light blue or brown 
background. When the camera in the scanner looks at a drawing, it 
converts what it sees to graytone levels between 0 and 255. A very 
black background is represented by a low value and a very white 
background is represented by a high value. Light and dark gray, blue, 
brown, and all other tones are represented as in-between graytone 
values. 
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When the scanner performs a histogram analysis, it counts the 
number of pixels found at each of the 256 graytone levels. WIDEimage 
presents these counts in a graph. The graytone level is placed on the 
horizontal axis, while the vertical axis represents the accumulated pixel 
count at each individual graytone level. Pixels with black or the darkest 
graytones are will be represented on the left side of the horizontal axis 
while white or the lightest graytones will be on the right. 
 
A vertical line in the histogram with a value indicator attached is 
displayed. The line’s position and the value indicator represent the 
threshold value and the number of pixels found at the threshold value. 
The threshold value and the number of pixels found at the value are 
also displayed in the dialog. The initial threshold value is an 
automatically computed "good value" based on an algorithmic analysis 
of the peaks in the histogram. Using the mouse, you can alter the 
position of the vertical value-indicator line by dragging the threshold 
slider to a new threshold value. 
 
When scanning at a specific threshold, all gray tones below the 
threshold will be represented as black pixels, and all gray tones above 
will be represented as white pixels. 
In most cases you will see a histogram with two peaks. The larger 
peak represents the background information (the lightest gray tones) 
of the scanned original, and the smaller one represents the line 
information (the darkest gray tones) in the drawing. 
 
A third peak at a high graytone level occurs when the scanner’s 
camera has seen some of the scanner’s own white reference 

 
Fig. 4-21: The Histogram - Manual Threshold Adjustment 
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background. This can be avoided by narrowing the scanwidth setting 
to the width of the drawing. 
 
Normally, in terms of the histogram, the best threshold selection lies in 
the deepest part of the valley, between the two peaks, and closest to 
the peak that represents background information in the drawing. 
 
Normally, the Histogram will be based on Linear calculations as 
described above. Select the Logarithmic display option if your 
histogram doesn't bring out enough detail. For example, an image that 
contains a large white background will show a very high peak and 
other colors that are represented by relatively small amounts of pixels 
will hardly be visible. Such large differences can be accounted for by 
checking the Logarithmic option. This will recalculate histogram point 
values by a logarithmic function rendering large pixel groups of single 
colors less dominating thus bringing out details that otherwise would 
not be visible in the histogram. 
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4.8 An Overview of Scanning Modes and Options 
 
Mode* Usage Adjustments 

BW Threshold Drawing and lineart 
 

Threshold value 
Histogram.  
Despeckle, 
Holefilling 
Sharpen/Soften*** 
Blur*** 
 

BW Adaptive Scan to file of Line 
drawings difficult 
blueprints, sepias, 
faded/stained 
drawings. 
 

Adaptive Level 
Back. Suppression** 
Despeckle, 
Holefilling 
Sharpen/Soften*** 
Blur*** 
 

BW Copy Normal Halftone copy to print 
of all normal originals 
with a relatively good 
quality image.  

Adaptive Level 
Sharpen 
Soften 
Blur 
 

BW Copy Photo Halftone copy to print 
of continuos shades 
of gray such as in 
photos.    

Adaptive Level 
Sharpen 
Soften 
Blur 
 

B/W Copy Adaptive Halftone copy to print 
of Sepia, Blueprint, 
and other originals 
with heavily distorted 
foregrounds and 
backgrounds in which 
the shades that 
create image noise 
are close those that 
represent the image’s 
data and the two are 
hard to differentiate. 
 

Adaptive Level 
Sharpen 
Soften 
Blur 
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Gray Copy Adaptive Graytone copy to 
print of originals with 
heavily distorted 
foregrounds and 
backgrounds where 
the shades making 
up the image “noise” 
are close to those 
making up the 
image’s data and 
hard to differentiate. 
Takes advantage of 
the printer’s high 
resolutions. 

Adaptive Level 
Back. Suppression
Contrast 
Brightness 
Lightness 
Gamma 
Sharpen,Soften,Blur 

BW Photo Halftone dithered 
mode for photos and 
printouts using Floyd 
Steinberg algorithm. 
 

Contrast 
Brightness 
Lightness 
Sharpen,Soften,Blur 

Graytone Monochrome image 
reproduction with all 
tones retained. 

Contrast 
Brightness 
Lightness 
Sharpen,Soften,Blur 

RGB Color True Color image 
reproduction 
 

Brightness 
Contrast, 
Lightness, Saturation, 
Balance, Gamma 
Sharpen,Soften,Blur 

Indexed Color**** Color Scanning with 
file size compression 
through color 
reduction. 

Brightness, Contrast, 
Lightness, Saturation, 
Balance, Gamma 
Blur 

Classified Color  Feature Extraction 
and scanning with 
LUT filter. 
 

Brightness, Contrast, 
Lightness, Saturation, 
Balance, Gamma 
Blur 

 
* The availability of specific scanning modes will depend on your scanner model.      
** Background suppression is not available (or necessary) on some scanner models 
***   Sharpen, Soften and Blur filters are not available on all scanners in this mode. 
**** Indexed Color scanning mode works through a preliminary prescan and can      
     therefore not be used with thick media over 2mm (0.08”) thick. 
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4.9 Scanning to a Target  
You have made your central settings in the Scan Setup Tab and tuned 
the scan through prescanning and the Adjustments Tab. Now you are 
ready to commit your image to a file, a printer or another output target. 
The Scan Button triggers a scan. The target is determined by checking 
output options in the Scan Menu. 

Scan Button 

 

4.9.1 Scan to a file 
• Make sure the Scan To File option (default setting) is selected in 

the Scan Menu. 
• Select the Scan button. This halts any current prescanning 

operation, repositions the paper original in the scanner, and 
scanning-to-file follows immediately thereafter. 

• In the file Save As… dialog select a file or create a new file name. 
The default filename will be set according to your choice in the File 
Menu - Preference dialog. 

• Select the file format you wish used for your scanned file. 
• During scanning, the scanned image is displayed in the two view 

windows of the Scan Screen. You can speed up scanning by 
turning off the Detail View through File - Preferences - Scan.  

 

4.9.2 Scan to the Viewer 

You can redirect scan output to the View Screen. Sometimes you 
know beforehand that you will need to make image adjustments and 
therefore, instead of first scanning to a file and then loading it into the 
View Screen, you scan straight to the Viewer’s memory, make your 
adjustments and then save to a file. 
• Select the Scan To Viewer option in the Scan Menu. 
• Selecting the Scan Button will then start scanning when completed 

the image will be loaded and displayed in the View Screen. 
• Select the Save As option when you are satisfied with your 

changes. 
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4.9.3 Scan to a Printer 

You can redirect scan output to your printer. 
• Check the Scan To Print option in the Scan Menu. 
• Selecting the Scan Button will then start the normal print dialog in 

which you select a printer for the scanning output. 
• Click OK in the print dialog to start scanning to your printer 

4.9.4 Scan Whole Batches 

Use batch scanning if you have a whole group of documents with 
equal characteristics and require equal settings. With batch scanning 
you can work from the scanner, inserting documents as each is 
automatically loaded and scanned.  
• Check the Batch Scan option in the Scan Menu. 
• The Scan Button will then start the Batch Scanning dialog in which 

you set up file naming, and logging options for the batch. 
• Follow the instructions for applying batch scanning options 

described in the coming section. 

4.9.5 Stop Scanning and Eject Original  
Stop 

 
Scanning will stop upon reaching the end of a drawing or when you 
click on the Stop button on the Scan Toolbar.  
• Click on the Stop Button to terminate scanning at any point. 
• The scanned part of the original will be saved to disk under the file 

name specified in the Save as… dialog. 
• If you stop a scan-to-file midways, the file will be closed with the 

data already scanned. 
 
Eject 

  

Normally you would use the control buttons on the scanner to eject 
and reload originals. But you can also eject originals without leaving 
your workstation. Press the Eject button to eject the current original 
from the scanner insertion slot.  
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4.10 The Scan Menu 
The Scan Menu contains global scanning modes and options.  
Select Scan in WIDEimage’s Menu Bar to display the Scan Menu 
shown below.  

 
The Scan Menu is where you, among other things, set up scanner 
device options, setup and initiate batch scanning, and redirect 
scanning output to your viewer or printer. In the following sections, we 
will describe each of the Scan Menu’s options.  
 
 
 
 
 
 
 

 
Fig. 4-22: The Scan Menu 
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4.10.1 Scanner Setup 
The Scanner Setup dialog contains options for scanner related 
settings. It is here you select the scanner, set Paper Load options, set 
your Media Offsets, and make adjustments for scanning thick originals 
through the Extended Thickness options. 

Selected Scanner 
WIDEimage detects which scanner models are accessible through 
your workstation. Selecting Selected Scanner displays a drop-down 
box containing a list of available scanners named by their model. 
Clicking on an item in the list makes it the active scanner. 
 
Paper load  
Select between Manual load  or Automatic load. With manual loading, 
you position the original in the slot and then press the down button on 
the scanner. With automatic loading, the scanner detects and loads 
the original as soon as you insert it. A delay factor can be set for 
automatic paper loading giving you time to position the original 
correctly. 
 
 
 
 
 
 
 
 

 
Fig. 4-23: Scanner Setup Dialog 
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Media Offsets Settings 
Correction Factor in scanning … (Vertical Precision Setting) 
This option allows you to tune the scanner's vertical precision setting.  
During scanning, an original image is digitized as it is propelled 
through the scanner. One at a time, thin strips of the image are 
processed as they pass the cameras.  Vertical precision is directly 
affected by the speed in which this happens. Inaccurate vertical 
precision results in vertical lines in the scanned image that are longer 
or shorter than the same lines in the original. The vertical scan 
accuracy is adjusted mechanically during production of the scanner. 
This setting, is extremely precise and more than adequate for most 
applications.   
Should you require very high accuracy, you can modify the vertical 
precision from zero to a value between –1% and 1%. Positive settings 
mean that the distance between scan lines will be increased, and 
negative settings mean that the distance between scan lines will be 
decreased. When you exit the Scanner Setup dialog, the modified 
value is stored in non-volatile memory in the scanner and can only be 
changed by re-doing the setup. 
 
The procedure for vertical precision adjustment would be to scan a 
precision original. Import the scanned drawing into your CAD system 
or other application, and measure the vertical distance between points 
in the image. Then compare those with similar physical measurements 
between the points on the original. Caution should be taken at all 
stages of the procedure with regard to the stability and temperature 
sensitivity of the original and the measurement ruler used. 

 
Fig. 4-24: Scanner Setup - Media Offsets 
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Furthermore, you should perform the setup at the scanning resolution 
you will later actually be using for scanning the originals. 
 
Media Offsets in… 
The Top(start), Bottom(end), Side offset edit fields define the scanning 
field offsets. You can use this option to correct slight offset 
irregularities.   
• Offset values are defined in inches or mm. depending on your 

Preferences – System – Unit settings.  
• An offset value in the Side field means that the scanning field’s 

side reference point is moved towards the middle.  
• An offset value in the Top or Bottom fields mean that the scanning 

field’s top or bottom point is moved down.  

 
Extended Thickness Settings 
Camera Stitching 
Scanning needs are not always limited to convenient paper thin media. 
You might need to scan thick originals such as maps or posters pasted 
on cardboard. While some scanner models are built to scan very thick 
originals, others require a special “Extension Kit for Thick Media”. 
Scanning thick media can  require enlarging the scanner’s insertion 
area and this can affect the scanner’s automatic control of  border 
lines between the cameras – the so called Stitching. Stiff and 
unbendable media will affect Stitching most. The Camera stitching 
option allows you to adjust stitching parameters when scanning with 
thick and stiff originals. 
• Adjust the insertion slot to accommodate your thick media as 

described in the scanner’s operations guide or Extension Kit guide. 

 
Fig. 4-25: Scanner Setup - Extended Thickness 
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• Load the thick original you wish to scan. Center loading is 
recommended with thick originals. The scanner’s media transport 
rollers grip more evenly with center loading.   

• Click Scanner Setup in the Scan Menu. 
• Make a test scanning. Bulky thick media needs to be supported 

with both hands on its way in and out of the scanner.  
• Stitching errors will be easiest to see on an image with one or 

more clear diagonal lines. 
• Normally, only stiff media will affect stitching. A flexible media will 

usually be stitched correctly regardless of its thickness.   
• If the lines seem uneven, check the box labeled Adjust for 

extended media thickness.  Some scanner models will 
automatically detect the fact that you have raised the insertion slot 
and this option box will be omitted from the dialog.  

• Change the value for each of the scanner’s cameras. Normally, 
only positive values should be used. 

• Make test scans and readjust the values until you are satisfied that 
the lines are stitched correctly. 

• Click OK to accept your settings. 
 
Use extended thickness paper handling  
Scanning thick originals can give distorted results at both the top and 
bottom edges where the edge meets the scanner’s rollers. On some 
scanner models, you can omit edge distortion by letting the scanner 
skip the leading and trailing edges. This setting is only be available on 
scanners originally constructed with thick media scanning capabilities. 
Edge skipping is the default setting on these scanners when they are 
set (see your scanner’s Operator’s Guide) in one of the extended 
media positions. Use the checkbox Use extending thickness paper 
handling  to enable and disable skipping of the two edges. 
 
Note: This option is not available with all scanner models. 
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4.10.2 Aperture Card Setup 
The Aperture Card Setup option is available if an Aperture Card 
scanner is the active scanner. The Dialog is shown below: 

 
Hollerith card batch scan with automatic file naming 
The first field allows users to define how file names will be generated 
using Hollerith data on the cards. You specify a template for using the 
Hollerith character index as a source for all or some of the characters 
in the automatically generated filename. For example, if you set your 
template to IM#23#2400E and a Hollerith card has an “a” punched at 
index 23 and a “g” at index 24, the image will be scanned to a file 
called Imag00E.  
Hollerith characters that are invalid in file names will be replaced by an 
underscore character (“_”). Use the setup button  to pick file names 
from your computer or network. 
 
File format selection 
Select the desired file format for your output and click the Format 
Setup button to set the specific file format options. 
 
Aperture Card insertion method (card copy generation) 
The Odd and Even option boxes refer to how your cards are inserted 
into the scanner. The cards must always be placed so that the film 
faces towards the camera lens. Since optimal coping of aperture cards  
results in their being mirrored for each copy, odd generation copies 
must be inserted and treated differently than even generation copies. 
The original is an odd generation, the first copy an even generation, 
the third copy an odd generation and so on. For an original card and 
odd generation copies, select the Odd option and insert the cards with 
the cut corner facing down and forwards. For even copies select the 
Even option and insert the cards with the cut corner facing up and 

 
Fig. 4-26: Aperture Card Setup dialog 
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forwards. Odd and even generation cards cannot be mixed in one 
stack. 
When scanning aperture cards, you can select automatic paper size 
setting where the size information is read off each card.  See section 
4.4.1 for information on preparing automatic paper size setting with 
Hollerith card information. 
 

4.10.3 Batch Scan 
Batch Scanning is a powerful and time saving option for scanning a 
whole set of drawings that, due to their similarity in color and quality, 
require equal scanning settings. You can use all the scan options such 
as Mode, Size, Resolution, and Despeckle/Hole Filling Filters, when 
doing a batch scan. Selecting Batch Scan will set WIDEimage in Batch 
Scanning Mode.  
(Scan to File, Scan to Viewer, Batch Scan and Scan to Printer work 
like radio buttons, meaning only one of them can be active at a time.) 
 
To Perform Batch Scanning  
• Set up your scanning parameters as with single-document 

scanning. 
• Select Batch Scan in the Scan Menu to activate Batch Scanning 

Mode. 
• Click on the Scan Button. A dialog for making batch scanning 

settings is displayed. 
• Determine the batch scanning settings. The following settings are 

available: 

 
 
 
 

 
Fig. 4-27: Batch Scan Dialog 
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Auto file naming -  “By count starting from”   
If you select this option, a three-digit number will be added to 
your "Scan to file" filename (in addition to the three-letter file-
format identifier), and is incremented automatically for each 
scan-to-file (e.g., name001.rlc, name002.rlc, etc.). 
Scan to file  
Here you enter a path and  filename that will serve as the 
template for file naming in the batch as described above. 
Overwrite existing files  
In the check boxes you can specify if existing files should be 
overwritten by the new scan. 
You can achieve automatic NEW file naming by selecting the 
Auto file naming by count option with the Overwrite existing files 
option disabled. This will set the program to automatically 
increase the file name counter until a non-conflicting name is 
found. 
Log to file 
Check this option and select a file name if a log file of the 
scanned drawings should be created. Log data is always 
appended to existing log files so you will either enter a new file 
name or else empty the default file in order to to make a 
separate log file for a new batch. Log file output can be set up 
through the Log options… Button which leads to the same 
dialog found through File Menu - Preferences – Scan - Batch 
Scan Tab (see section 3.3.10). 
 

• After making the batch scanning settings, click OK and continue 
working from the scanner. Load your originals in one by one and 
each will be scanned with your settings. 

• When you run batches, the loading process can be speeded up by 
selecting Autoload in File menu–Preferences–Scan–Paper Load.  

4.10.4 Scan To Print 
Your scanner and printer can be used as an effective copy system. 
The Scan to Print option allows you to copy an original directly from the 
scanner to a Printer device and make a cleaned-up copy of old faded 
or stained originals, using the Adaptive and other enhancement 
features in WIDEimage and your scanner. Scan to File, Scan to 
Viewer, Batch Scan and Scan to Printer work like radio buttons, 
meaning only one of them can be active at a time.  
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To redirect scanning output to a printer 
• Click on the Scan to print option in the File Menu to set 

WIDEimage in "Scan-to-Print Mode". While in Scan-to-Print-Mode, 
all following scanned images will be sent directly to an attached 
printer device. 

• Click on the Scan button when you have made your scan settings 
and are ready to scan. 

• The normal Print dialog, will appear allowing you to set up your 
print job as described in section 3.3.6 before scanning starts. 

• Click OK to start the scanning to your selected printer. 
 
NOTE: This option was also described in previous section – “Scanning 
to a Target.” 
 

4.10.5 Calibrate Scanner 
 
Why Calibration? 
Since the light detectors in all color scanners are affected with usage,  
RGB output signals can vary. Age usually affects color balance and 
linearity, while the chromacity components are relatively stable.  
 
To ensure long term stability and reproduction of color scans, the 
scanner linearity, color balance and chromacity can be calibrated, 
using the IT8 Calibration Sheet (ANSI IT8 standard reflective target) 
shown in the next figure: 

 
Fig. 4-28: IT8 Calibration Sheet 
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Some monochrome scanners support basic calibration. Basic 
calibration reduces noise in the dynamic area and ensures stable and 
clean scans. For example it reduces the unwanted effects caused by 
dust particles when scanning at high resolutions.  
 
How to calibrate the scanner? 
• It is recommended to let the scanner warm up for 1 complete 

hour before calibrating. Slight intensity changes can occur in the 
scanner’s florescent lights just after turning the scanner on. The 
cameras can also shift slightly during the first minutes of start up. 
The 1 hour warm-up time will ensure stabilized light conditions and 
camera heights. The stabilization will ensure that the conditions 
during calibration match those during scanning.  

• Select Calibrate Scanner from the Scan Menu. 
• On the latest scanner models, the Scanner Maintenance wizard 

will start up and guide you through perfect camera alignment and 
calibration. This requires that you have installed the Scanner 
Maintenance software that came with the scanner. On other 
models, a stand-alone Calibration wizard will start up. 

• For color scanners, calibration involves: Basic Calibration, and 
Color Calibration. For monochrome scanners that support 
calibration, only the first step - Basic Calibration will be necessary. 

• Follow the wizard’s instructions regarding insertion of the 
maintenance/ calibration sheets. The wizard will inform you when 
the process is complete. See  the documentation that came with 
your scanner for detailed instructions on calibration and scanner 
maintenance. 

 
What Happens During Calibration? 
WIDEimage scans the RGB color value of each patch, converts to 
CIE-Lab color space (where color distances correspond better with 
human vision). Comparing with the known reference CIE-Lab values of 
the IT8 target, the software calculates the scanner's color correction 
for each patch. 
WIDEimage automatically builds the color tone transfer tables and 
correction matrix and downloads them into the scanner. 
When you calibrate your scanner, profiles for both NTSC and sRGB 
color spaces are created. 

4.10.6 Scan to File and Scan to Viewer 
Selection of these options determines the target for scanner output 
when activating the Scan Button.  
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Selecting Scan to Viewer is handy if you know or suspect beforehand 
that you will amend the image (crop, scale, tonal adjustment, etc.) in 
the Viewer (View Screen). After making your amendments you save 
the image to a file using the File Menu’s Save As option.  
With Scan to File selected, the Save As dialog appears when you 
select the Scan Button, and output is sent to the file you selected. 
Scan with this option when you don’t wish to make after-scanning 
changes to the image. Scan to File is the default selection. 
 
Tip : Scan to File, Scan to Viewer, Batch Scan and Scan to Printer 
work like radio buttons, meaning only one of them can be active at a 
time. It’s easiest to think of these 4 options as “Output Mode 
Selectors”. For example selecting Scan to File puts the application in 
“Scan to File Output Mode" and it will stay in that output mode until 
another Output Mode Selector is chosen.  
 
NOTE: These options were also described in the previous section - 
“Scanning to a Target”. 
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5. Viewing Scans - View Screen & Image Menu 

5.1 Introducing the Viewer 
The View Screen and the Image Menu compose an independent work 
area, also called the Viewer, that allows you to inspect, refine, and 
manipulate either the image you just scanned or images previously 
scanned and saved on file. During scanning, you took full advantage of 
prescanning and optional scanning settings and modes. Here, in the 
Viewer, you can go one step further and perform those fine 
adjustments that make the difference between a very good result and 
a perfect one.  
All the Viewer’s image functions (except for alignment and despeckle) 
are processed on screen data only, for fast interactive use. To update 
the image file with amendments made in the Viewer, you must save it 
by clicking Save in the Main Toolbar or using Save As in the File 
Menu. 
 
• Viewing functions in the View Toolbar 
  Main view with zoom and portion cutout operations 
  3 local Viewboards with zoom operations 
 
• Image Functions in the View Toolbar 
  Image Cropping 
  Align  
  Invert colors 
  Mirror image 
  Despeckle 
  Measure between two points 
  Flip Image and Rotate image  90° left,  90° right, 180°  
 
• Image functions in the Image Menu 
  Brightness/Contrast adjustment 
  Histogram Stretch – Black and White point adjustment 
  Hue/Saturation/Value image adjustment 
  Red/Green/Blue image adjustment 
  Grayscale conversion 
  Classify – LUT filtering 
  Decrease Colors/Graytones 
  Count Colors in image 
  Scale image 
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5.2 View Screen layout 
To start viewing and working with an image, you have to open the 
image file by clicking on the Open Tool in the Main Toolbar. If you 
have just performed a scan in the Scan Screen with Scan to Viewer 
selected in the Scan menu, the image just scanned will automatically 
be loaded and displayed in the View Screen.  
From the View Screen you can directly control all aspects of viewing, 
zooming and manipulating an image. 
Like the Scan Screen, the View Screen is divided into the general 
areas as described in section 3.1. The Task Toolbar position is 
occupied by the View Toolbar, and the whole main display area is 
available for viewing. The following general areas make up the View 
Screen. 
  
• Menu Bar and Main Toolbar 
• View Toolbar 
• Main Display Area 
• Screen-Select Tabs 
• View Screen Status Bar 

 
Fig. 5-1: The View Screen 
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5.3 Viewing an Image –  Viewing Options 
The Viewer combines view selection tools and image manipulation 
tools that together make after-scanning operations easy. 

5.3.1 View Selection Tools 
The View Toolbar’s first 6 tools from the left are the view selection 
tools.  
When one of the view selection buttons is turned ON, the button stays 
turned ON until another view is selected. Changing between views 
does not change the function of other view tools. The following view 
selection options are available: 
 
Main View 

 
The Image is displayed on screen at the current zoom level. If you  
return to the Main View from a Viewboard , the zoom level will be 
restored to the value set when you left the Main View.  
 
Viewboard 1,2,3 
 

 
 
Local Viewboards for retaining views of an image.  
 
You can save a partial view of the image by “cutting out” a section with 
the Rectangle Selector and then pressing a Viewboard button.  
 
Usage of the Rectangle Selector tool with the Viewboards to save 
views of the image is described in the next section. 
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Rectangle Selector 

 

For selecting image areas for use with Viewboards, Crop, Save As, 
Print and Color Count. 

Defining a selection area 

• Click on this tool to turn the button “on” and change the cursor to: 

 
• Hold down the left mouse key with this cursor active and select an 

area by dragging a rectangle on the screen. 
 
After you have created a preliminary rectangle, you can move and 
resize it using your mouse.  Moving the mouse over the rectangle’s 
components (sides and corners), activates different functions and 
relevant cursors as described below : 
• Move the cursor over a rectangle’s corner to reveal its resizing 

handle (a blue arrow will appear). You can drag any of the corners,  
while holding down the left mouse key to resize your rectangle.  

• Clicking on the right mouse-button, while pointing at one of the 
corners, will make the cursor jump to the next corner (clockwise). 
<shift>right clicking will move the cursor counter clockwise. 

• Move the mouse over one of the 4 rectangle lines to reveal its 
movement handles indicated by the cursor on contact. These 
handles can be used to move the rectangle to a different position 
on the screen. 

• Point with the mouse anywhere inside or outside the rectangle to 
activate the “Zoom Cursor” shown below. Armed with this cursor 
you can click and zoom in on image details for making fine 
adjustments to rectangle corners. Zoom views can be saved on 
the Viewboards. 

The Zoom Cursor 

• All the above mouse and drag functions can be deactivated by 
pressing the <ESC> key. 

  
If you regret your rectangle, it can be deactivated without any function 
being performed by re-clicking on the rectangle tool. You can  
deactivate the rectangle and the function by clicking on the standard 
cursor tool. 
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Creating “cutout” Views  with the Rectangle Selector 
You might be interested in viewing one or more specific areas in the 
image. You can save such a view in a Viewboards. Here’s how: 
 
• Mark out an area with the Rectangle Selector as described above. 
• With the rectangle active, click on one of the Viewboards 1, 2 or 3 

buttons. 
• The marked area will be saved in the Viewboard you chose.  
• Use the zoom tools to further enhance viewing of your cutout 

image portion if necessary.  
 
Tools that can be used with the Rectangle Selector  
Selecting Crop, Save As… or Print will perform the corresponding 
function on the area outlined by the rectangle. The rectangle will be 
deactivated immediately after performing the function. 
You can also perform a Color Count of colors in the selected area. 
See section 5.3.8 Image Menu – Color Count for details. 
The Save and Save As… functions will include all image changes 
within the rectangle. Only the selected area is saved. 
 

5.3.2   Image Manipulation Tools 
The image manipulation functions found in the View Toolbar are: 
 
Standard Cursor 

  
Clicking on this tool will change the cursor to the standard cursor. You 
can always use this tool to get back a normal “passive” cursor after 
activating any tool that creates active cursors such as resizing, 
panning, rectangle select and pipette cursors. 
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Pick Color 

 
To view color information from the image  
• Load the image in the Viewer and select the Pick Color Tool. 

• The cursor will change to:  
• Move the cursor around and point at pixels in the View Screen 

Window.  
• The corresponding color’s Intensity (“I”) and Red, Green, Blue 

values are displayed in the View Screen’s status bar:  
 

 
 
• Hold down the left mouse key and drag a rectangle on the screen. 

This will display the average RGB value of all the pixels within the 
rectangle. 

• Release the mouse key to remove the rectangle.  
 
Crop 

 
For cutting out an image area. 
This function works with a rectangle that has been placed with the 
Rectangle Selector. Clicking on the Crop button will remove all image 
data outside the rectangle, keeping only the image inside. See the 
previous section for instructions on placing the rectangle with the 
Rectangle Selector. 
 
Measure 

 
The Measure tool allows you to measure parts of your drawing directly 
on the screen. You set a measure line anywhere in the image and the 
line’s length is displayed in the status bar.  The Measure tool and the 
measure line are also used in combination with the Align tool when you 
need to align your image. 
Setting a Measure Line 
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• Click on the Measure tool to turn the function ON. The cursor 
changes to the line marker : 

 
• Using this cursor, drag a measure line directly on the image.  

• Once you have created a preliminary line, your mouse can be 
used for making changes and adjustments. Moving the mouse 
over line components (end-points and line) activates new functions 
with a relevant cursors as described below: 

• Moving the cursor over one of the measure line end-points will 
reveal its adjustment and resizing handles. You can drag the line 
end while holding down the left mouse key to adjust its length and 
end-point positions.  

• Clicking on the right mouse-button, while pointing at one of the 
end-points, will make the cursor jump to the other end-point. 

• Moving the mouse over the measure line itself, reveals its 
movement handles, indicated by the cursor on contact. These 
handles can be used to move the measure line to a different 
position on the screen while retaining its original angle. 

• Pointing with the mouse anywhere away from the measure line 
activates the “Zoom Cursor”. With this cursor  you can click and 
zoom in on image details for making fine adjustments to the line 
end-point position.  

The Zoom Cursor 
• All the above mouse and drag functions can be deactivated by 

pressing the <ESC> key. 
Measurement information, given as the distance in pixels, mm, inch 
and angle, is immediately displayed in the Status Bar as shown below:  

 

The angle information can be used with the Alignment tool as 
described below. The measure line disappears when you re-click on 
the Measure tool.  
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Align 

  
The Align Tool works with the Measure Tool. If you have drawn a 
measure line, clicking on this tool will align the image based on the 
alignment angle displayed in the Status Bar. To align an image, set 
and adjust a measure line as described above. Find the desired angle 
using a line or border in the image that can guide you. Then just click 
on the Align Tool. 
 
Invert 

  
Click on the Invert tool to invert the image. You can deactivate the 
inversion effect by re-clicking on the button. Black becomes white and 
white becomes black for B/W images. For graytone images, the invert 
function is performed on the graytones directly. For Indexed color, 
inversion is performed on the Palette Colors and for RGB colors on 
individual color channels. 
 
Despeckle  

 
The Despeckle function is only relevant to B/W images. Selecting 
despeckle displays a dialog for determining the speckle and hole size. 
The Image File will be despeckled and Hole Filled on the basis of the 
settings that represent the size of a box. Speckles that fit into the box 
will be removed and holes that fit into the defined box will be filled. 
Clicking OK applies the changes and updates the view. As with all the 
View Screen functions, you still have to use Save to update the image 
file. 
 
Mirror 

 
Click on the Mirror  tool to mirror the image in the Viewer. 
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Flip Image 

 
Click on the Flip Image button to flip the image around vertically. 
 
Rotate Left   

              
Clicking Rotate Left will rotate the image 90° to the left (270°).  
 
Rotate Right 

 
Clicking Rotate Right will rotate the image 90° to the right (90°).   
 
Rotate 180° 

 
Clicking Rotate 180° will rotate the image right until it’s upside down.  
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5.4 Editing features in the Image Menu 
Clicking on Image in the Menu Bar, displays the Image Menu shown 
below. The menu contains selections for image operations that mainly 
apply for  Graytone, Indexed and RGB images. The last item, Scale, 
can also be performed on BW images. 
 

 
The availability of some of the menu items varies with the type of  
loaded image. For example, the Classify item only applies for RGB 
color images and the Hue/Saturation/Value, Red/Green/Blue and 
Grayscale items are not relevant with Graytone images. The Scale 
option can be applied on all types of images, including B/W. 
 
As with the View Toolbar tools, these function apply to on-screen data 
only and the Save function must be applied to update the image file 
with your changes.  
 
The Image Menu items are described in the following sections. 

 
Fig. 5-2: The Image Menu 
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5.4.1 Brightness/Contrast 
 
Changing Brightness/Contrast in an existing image 
• Open the image in the View Screen. 
• Select the Brightness/Contrast option in the Image menu. 
• The adjustment dialog shown below appears. 

• Brightness and Contrast can be selected independently. Values 
can be set either by dragging the sliders or by editing in the edit 
fields. 

• Click Preview to update the image with your changes without 
leaving the dialog.  

• Click OK to leave the dialog, and update the image with your 
settings. 

• Click Cancel if you want to reset Contrast/Brightness to its former 
values i.e., the values that existed before you entered the dialog. 

 
 
 
  
 
 
 
 
 
Tip : As an alternative to the Preview button, you can view setting 
effects interactively as you make adjustments. This is done by holding 
down the <ctrl> key as you move the sliders.  
 
 

 
Fig. 5-3: Brightness/Contrast Dialog 
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5.4.2 Histogram Stretch 
For setting Black and White Point Values in an existing image. 
The histogram gives you a picture of your image’s tonal range. You 
can use the histogram to set the Black Point and White Point values,  
for achieving optimal balance between highlight and shadows 
throughout your image. 
• Open the image in the View Screen. 
• Select Histogram Stretch from the Image Menu. A luminance 

histogram adjustment dialog is displayed. 

There are two ways to make Black and White Pint adjustments: 
• Manual: You can manually set the Black Point (BP) and the White 

Point (WP) by dragging the sliders to any position within the 
luminance range (0-255). Clicking OK will stretch the image so 
that the resulting histogram fits between the two manually defined 
points. 

• Auto: Select the Auto button in the dialog to initiate generation of 
a luminance histogram for the image. Two points in the histogram 
will be automatically found: The Black Point (BP) which is 
calculated as the graytone level of the 5% darkest pixels, and the 
White Point (WP) which is the graytone level of the 5% brightest 
pixels. The image is stretched so that the resulting histogram 
occupies a graytone range from 0 to 255. 

• Use the Preview button to display the effects of your settings. 
• Click OK to apply the changes and close the dialog. 
 
Tip : As an alternative to the Preview button, you can view setting 
effects interactively as you make adjustments. This is done by holding 
down the <ctrl> key as you move the sliders.  

 
Fig. 5-4: Histogram Stretch Dialog 
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5.4.3 Hue/Saturation/Value 
For tonal adjustment through adjusting Hue, Saturation, Value color 
balances within an existing image. 
• Open the image in the View Screen 
• Select Hue/Saturation/Value from the Image Menu. An HSV 

adjustment dialog will popup.  
• Values can be set either by dragging the sliders or by editing in the 

respective edit fields. 

The settings are applied in the following way: 
• Hue: Increases or decreases Hue. All colors are moved 

simultaneously up or down the color spectrum. 
• Saturation: Increases/decreases Saturation. 100% converts the 

image to Graylevels. 
• Value: Increases/decreases Luminance. 100% produces pure 

black. 
• Click the Preview button to see the effects of your settings. 
• Click OK to leave the dialog and update the image with your 

settings. 
• Click Cancel if you wish to reset the values to the prior settings. 
 
Tip : As an alternative to the Preview button, you can view setting 
effects interactively as you make adjustments. This is done by holding 
down the <ctrl> key as you move the sliders.  
 
 
 

 
Fig. 5-5: Hue/Saturation/Value Dialog 
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5.4.4 Red/Green/Blue 
For tonal adjustment through adjusting Red, Green, and Blue (RGB) 
color balances within an existing image. 
 
• Open the image in the View Screen. 
• Select Red/Green/Blue from the Image Menu. An RGB adjustment 

dialog will pop up.  
 

• RGB balances are set as percentages by dragging the sliders or 
by editing in the respective edit fields. 

• Click Preview to view your latest adjustments. 
• Click OK to leave the dialog and update the image with your 

settings. 
• Click Cancel if you wish to reset the values to the prior settings. 
 
 
 
 
 
Tip : As an alternative to the Preview button, you can view setting 
effects interactively as you make adjustments. This is done by holding 
down the <ctrl> key as you move the sliders.  
 
 
 
 
 
 
 

 
Fig. 5-6: Red/Green/Blue Dialog 
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5.4.5 Grayscale 
For converting an existing color image to grayscale colors. 
• Open the image in the View Screen. 
• Select the Image Menu 
• Check (click on) the Grayscale option. 
 
This action will convert an active Feature Extracted color, indexed 
color or RGB color image to a grayscaled image by replacing each 
color with a gray of equal luminance.  
 

5.4.6 Classify (Feature extract) 
For applying the effects of a LUT filter to an existing RGB true color 
image. This is "off-line" feature extraction i.e., feature extraction is 
applied to a single saved image. "On-line" feature extraction involves 
downloading a LUT filter into the scanner and applying the filter's 
effects directly during scanning as described in chapter 6. 
To perform off-line classification 
• Open the image in the View Screen. 
• Select the Image Menu 
• Select Classify. This will display a File-Selection dialog for 

selecting a LUT (Look Up Table .lut) file. 
 

• Click Open to apply LUT filtering to the RGB image, on the basis 
of the LUT file you selected in the dialog. 

• Applying the LUT filter performs off-line feature extraction, 
converting the image to Classified color. 

 

 
Fig. 5-7: Image Menu - Classify Dialog 
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5.4.7   Decrease Colors/Graytones 
Use this option to decrease the number of colors or graytones in an 
image. This is typically used for adapting images to certain colors 
schemes (for example CAD programs) and for compressing file size 
through decreasing color/graytone detail. 
 
• Open the image file in the View Screen 
• Select the Image Menu 
• Select Decrease Colors/Graytones. The submenu offers 2 options 

for decreasing colors and graytones with relevant adjustments. 
• You can decrease by using only black and white in the image. 

You can decrease the number of colors or graytones in the image. 
The methods and adjustment options are described below: 

 
• B/W: (Decrease to B/W image) 

The luminance of the active Graytone, Indexed or RGB image is 
used as the base for thresholding. Use the sliders to set the 
threshold to the desired value. The Preview button can be used to 
view setting effects or else hold down the <ctrl> key as you move 
the sliders to view effects interactively. 

 
• Color/Graytones 2-255: (Decrease the number of graytones or 

colors) 
Output is will be created as Indexed Color for Color images and  
as Graytone for graytone input images. 
If you wish to convert a color image to graytones, select Grayscale 
from the file menu and then, if required, come back here to reduce 
the number of graytones.  

 
 

 
Fig. 5-8: Image Menu - Decrease B/W 
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• Adaptive, no. of colors : The image is mapped based on the 
nearest color for Feature extracted color, Indexed color and RGB 
color. For Graytone input, graytones for output are selected based 
on equalizing the histogram. The number of output colors can be 
determined in the edit field. 
Custom Palette: A custom palette: .lut, .pal, .tif, .pcx etc. can be 
loaded by selecting a file through the Browse button. Settings 
regarding the number of output colors and file type are determined 
by the selected custom palette file. 

• Press the OK button to apply your settings on the image. 

5.4.8 Count Colors 
Select Count Colors to display the number of colors or graytones used 
in one of the following active views: 
  
• Main View 
• Viewboards  
• Rectangle Selection. (See section 5.3.1 – Viewing Selection Tools 

for instructions on placing and resizing the rectangle in the image). 
 

 
 
Click on Cancel to remove the message. 
 
 
 

 
Fig. 5-9: Image Menu - Decrease Colors 256 colors 
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5.4.9 Scale 
For resizing an image by a scale factor you set in the dialog. 

• Open the file in the Viewer 
• Select the Image Menu and click on the Scale option. 
• In the Scale dialog, choose the scaling factor by dragging the 

slider with the mouse.  
• The default scaling factor is 100%. 
• Click OK to apply resizing in the Viewer. 
• Select Save or Save As… to retain your changes. 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. 5-10: Image Menu - Scale Dialog 
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6. Feature Extraction  

6.1 What is Color Feature Extraction? 

6.1.1 Introduction 
A scanned color image of a map or drawing can be composed of up to 
16.7 million colors. Most scanned images will contain many colors that 
cannot be perceived by the human eye, due to a relative low amount of 
pixels representing them or due to their nearness to another color that 
is represented on a larger scale. This means that a very large number 
of an image’s colors are not required in order to bring out its features. 
For example, the edge pixels of a red line on a white background will 
have gradations of red colors, and a crossing red and blue line will 
have pixels with color mixtures of red and blue, etc. It would be 
beneficial to filter the many colors in the input image so that only those 
features that can be seen are actually represented in the output  
image. In the mentioned examples, this would mean  outputting a 
single red color representing both the center and the edge pixels of the 
red line on a clean white background, and a red line crossing on top of 
the blue line. 
 
The LUT filter (color Look Up Table) in the scanner can automatically 
perform a desired reduction of all the scanned colors into only a few 
significant colors (max. 255) representing the actual features. By 
filtering your images, you will obtain a significant reduction of data, 
save valuable space and render your image files easy to load and 
work with. This data compression can take place from 24 bits per pixel 
down to 8 bits per pixel or even down to 4 bits per pixel. 
 
But the scanner cannot automatically generate the LUT filter content in 
such a way that the output colors correspond to an image’s features 
as perceived by the human eye. Only the user can do this, by 
manipulating the LUT filter content on one or more representative 
sample maps or drawings until the colors in the output image 
satisfactorily represent the desired features. The prepared LUT filter 
content can then be downloaded into the scanner, allowing  automatic 
feature extraction (and data compression) on a whole class of similar 
maps or drawings. 
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6.1.2 LUT editing in the Feature Screen 
To assist the user in preparing the LUT filter content, the LUT editor 
provides tools to merge, explode or remove colors, and through this 
editing process the user can converge on a LUT filter that ideally 
outputs only one color for each feature in the scanned image. To 
facilitate the editing process, the user can switch between views of the 
true color input image and the feature extracted output image. Pixels 
that will be affected by the current edit operation are interactively 
highlighted. The user will only be required to commit the operation 
when satisfactory results are obtained.  
 

 
Two help screens, the Color Wheel View and the Histogram View, 
provide alternative ways of seeing color space position (Hue/ 
Saturation/Value - HSV color space) and the input pixel count 
associated with each of the LUT filtered output colors. 
 
 
 
 

Fig. 6-1: Feature Extraction Overview 
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6.1.3 Feature Extraction Procedures 
Here are the typical steps involved when creating and editing a LUT 
filter for Feature Extraction: 
 
1. Scan a representative sample of a class of maps or drawings in true 
color (24-bit RGB mode) and save it. You should scan with the default 
settings of white point/black point, contrast/brightness, etc., and not in 
any way modify the file in the Viewer. This is because your 
modifications will not be reproducible when you later scan other 
drawings from the same class that will share a created LUT filter. 
It is only necessary to scan a small but representative part of the 
original and a small file will make editing easier and faster. 
 
2. An initial automatic creation of the LUT filter is performed by 
opening the previously scanned true color image in the Viewer.  Then 
move to the Feature Screen by clicking on the Feature Tab. Select 
Create from the Feature Menu in the Pull-down Menu  Bar in order to 
generate an initial LUT filter that you will later amend. From the Create 
dialog, you select a creation method and the initial number of 
automatically generated output colors. There are two basic 
approaches to selecting the initial number of colors. 
 

Excessive Initial Colors : Set the number of output colors to a 
higher count than the number you want to end up with in order to 
have some additional colors to work with in the edit phase. Then 
use the Merge Color and Remove Color edit tools to reduce the 
resulting number of LUT output colors while controlling re-mapping 
to feature representative colors. 
  
One or Few Colors : Set the number of output colors to a lower 
count than the number you want to end up with. Then use the 
Insert Color and Explode Color edit tools to increase the resulting 
number of LUT output colors. Some start with only one color 
(minimum), and then insert input colors picked right off the RGB 
image. The inserted colors can be selected as color averages from 
whole areas representing a specific feature. This method creates 
LUT filters that are stable throughout the class because they are 
based on broad color schemes that relate directly to the original 
RGB image colors. Re-mapping becomes predictable because the 
very pixels you wish to re-map are used to form the inserted target 
color.  
 

3. Use the LUT edit tools to enhance the automatically generated LUT 
filter until each of the output colors represents a feature in the original 
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true color RGB image. Do not worry at this stage if the output colors do 
not look right - you can correct this later. Your only goal here is to 
ensure that  the colors give an accurate one-to-one representative 
match of the features in the scanned map or drawing. 
 
4. You should at this point save the LUT filter for eventual editing later 
on. You will probably want to check and modify the filter with other 
representative maps or drawings from the same class. 
 
5. In the final stage you can re-map the logical output colors from the 
LUT filter to colors of your choice, e.g., change a muddy red output 
color to a clear, bright red, by using the Import Color function and 
replacing the existing output color with the new one. This is an 
irreversible operation that will prohibit further editing because the new 
colors will not normally be positioned in the immediate neighborhood 
of its associated RGB colors. 
 
6. Save the generated LUT filter for future downloading into the 
scanner.  
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6.2 LUT Filter Editing - Getting Started 
To start editing a color feature extraction LUT (Look Up Table) you 
must open a previously scanned true color image (24-bit RGB) in the 
View Screen, and then move to the Feature Screen by clicking on the 
Feature Screen Tab . As described in previous chapters, you open an 
RGB image in the View Screen by either:  
• Selecting Open in the Main Toolbar or from the File Menu. 
• Moving to the View Screen from the Scan Screen just after you 

have scanned-to-file in RGB mode.  
The Feature screen (in its Main View) is shown below: 

Select Create in the Feature Menu to automatically generate an initial 
feature extraction LUT. The initial LUT will be used as the starting 
point from which you revise the LUT until you are satisfied with the 
result.  
When you create the initial LUT, all the Feature Screen views and LUT 
editing tools become accessible. The Feature Screen is divided into 
the standard areas: Menu Bar, Main Toolbar and Task Toolbar, a Main 
Display Area in the middle and the Screen Select Tabs and Status Bar 
at the bottom. The Task Toolbar is now occupied by the LUT Toolbar 
which is composed of tools relevant to LUT filter editing. 

 
Fig. 6-2: The Feature Screen (In Main View) 
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6.3 Selecting LUT Editing Views  
The LUT Toolbar consists of view selection tools and LUT edit tools.  
 
To assist in editing the LUT filter, color data in the true color original 
and its corresponding output after LUT filtering can be displayed 
(viewed) in several ways. The following view options are available: 
 
• Main View: This displays either the true color input image or the 

corresponding LUT filtered output image. This view is also known 
as the Main LUT Edit Screen – see Fig. 6-2. 

• Viewboards 1, 2 or 3: Displays zoomed-in or cutout parts of 
either the true color input image or its corresponding LUT filtered 
output image. 

• Color Wheel: Displays the position of each of the colors in the 
LUT filtered output image in HSV (Hue/Saturation/Value) color 
space. 

• Histogram: A graphical representation of the output colors being 
used for classification. The size of a column indicates the 
proportional amount of true color pixels mapped to the LUT filtered 
output color i.e., the column’s color. 

 
You can select between these viewing options by clicking on the 
appropriate button on the LUT Toolbar. When one of the LUT filter 
view selection buttons is turned ON, the button stays turned ON until 
another view type is selected.  
 
In the Main and Viewboards views, you can switch between displaying 
the true color RGB input image and the corresponding LUT filtered 
output image, by clicking on the RGB/LUT toggle button. 
 
In the Main and Viewboards views, colors affected by the current edit 
tool will be highlighted by continuous blinking. In the LUT mode, 
(controlled by the RGB/LUT button) the highlighted color represents 
the LUT output color. In the RGB mode, the highlighted colors 
represent RGB input colors that belong to a LUT output color.  
 
As we will see later, the Main and Viewboards views allow you, in 
connection with many edit functions, to use your mouse to select 
colors directly from the image. Selected colors will be highlighted as 
described above.  
 
Editing selections and marking made in one view, will be saved and 
displayed when you move to another view. For example, if you mark a 
color with the pick tool in the Color Wheel View, the same color will be 
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marked with a blue rectangle in the Histogram View and will blink in 
the Main View and Viewboards View. 
 
Lets look at the Feature Screen’s viewing tools. 
 

6.3.1 Viewing in the Main View 

 
Clicking on the above tool activates the Main View. In the Main View, 
the image is displayed on the screen at the current zoom level. 
Returning to the Main View from a Viewboard will restore the current 
zoom level of the Main View.  
The image will be displayed as either an RGB input image or as a LUT 
Filtered output image, depending on the state of the RGB/LUT button.  
 

6.3.2 Making Partial Views - Viewboard 1,2,3 

 
Viewboards can be used for retaining cutout and zoomed views of an 
image. When clicking a Viewboard button for the first time after an 
image has been opened, the image will be displayed as seen in the 
Main View. You can then create a partial view by either “cutting out” an 
area with the Rectangle Selector or by zooming and repositioning the 
image. The new (partial) view will be stored when leaving the 
Viewboard, and if you later select it again, the partial view will be 
redisplayed. The image will be displayed as either an RGB input image 
or as a LUT filtered output image depending on the state of the 
RGB/LUT button. See the following description of the Rectangle 
Selector Tool.   
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6.3.3 Using the Rectangle Selector 

 
In the Feature screen, the Rectangle Selector  tool can be used for 
two purposes: 
• Selecting a “cutout” area for saving and viewing in a Viewboard 
• Selecting an area that serves as the basis for creating an initial 

LUT filter. 
In the following we will see how to select image areas with the tool and 
how to save the selection for viewing. Using the Rectangle Selector in 
connection with LUT creation is described in section 6.5.1 Feature 
Menu – Create LUT. 
 
Marking out an area with the Rectangle Selector 
• Click on the Rectangle Selector tool to turn the function “on” and 

change the cursor to: 

 
 
• Hold down the left mouse key with this cursor active to select an 

area by dragging a rectangle on the screen. 
 
• After you have created a preliminary rectangle, you can move and 

resize it using your mouse.  Moving the mouse over the 
rectangle’s components (sides and corners), activates different 
functions and relevant cursors as described below : 

 
• Move the cursor over a rectangle’s corner to reveal its resizing 

handle (a blue arrow will appear). You can drag any of the corners,  
while holding down the left mouse key to resize your rectangle.  

 
• Click on the right mouse-button, while pointing at one of the 

corners, to make the cursor jump to the next corner (clockwise). 
<shift>right clicking will move the cursor counter clockwise. 

 
• Move the mouse over one of the 4 rectangle lines to reveal its 

movement handles indicated by the cursor change on contact. 
These handles can be used to move the rectangle to a different 
position on the screen. 

• Pointing with the mouse anywhere inside or outside the rectangle 
activates the “Zoom Cursor” shown below, allowing you to click 
and zoom in on image details for making fine adjustments to 
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rectangle corners. Zoom views can be saved on the Viewboards. 

The Zoom Cursor 
 
• All the rectangle mouse and drag functions can be deactivated by 

pressing the <ESC> key. 
  
If you regret your rectangle, it can be deactivated without any function 
being performed by re-clicking on the rectangle tool. You can  
deactivate the rectangle and the function by clicking on the standard 
cursor tool. 
 
Creating and saving “cutout” views  with the Rectangle Selector 
You might be interested in viewing one or more specific areas in the 
image. After marking out an area with the Rectangle Selector, you can 
save the specified area in a Viewboard from which it can be recalled.  
• Mark out an area with the Rectangle Selector tool as described 

above. 
• Click on one of the Viewboard 1, 2 or 3 buttons.  
• The marked area will be saved in the Viewboard you chose.  
• Use the zoom tools to further enhance viewing of your selected 

image portion.  
 

6.3.4 Viewing RGB input and LUT output colors 

 
The RGB/LUT button is a valuable tool because it allows you to 
interactively evaluate your LUT filter and editing actions by comparing 
the original RGB input image with current LUT filtering results (output 
colors). Clicking on this button will toggle between the RGB and LUT 
display mode in the Main and Viewboards views. The RGB state 
(button OFF) will display the original true-color RGB input image. 
When the tool is toggled to LUT (button ON – highlighted), the image 
is displayed with the current LUT filter effects.  
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6.3.5 Viewing with the Color Wheel  

 
Pressing this tool displays the Color Wheel View. The Color Wheel 
view displays the LUT output colors in the HSV model 
(Hue/Saturation/Value). An initial LUT file must be created or loaded 
before you can use this view. 

The view is divided into two parts, with Hue/Saturation represented on 
the right and the Brightness (value) represented on the left. On both 
sides, each color is represented by a color disc.  
The hexagon on the right (Hue and Saturation) contains the slice of 
colors selected in the triangle on the left (Brightness value).  
The hexagon is bordered by a color-hue-ring. The position of the color 
discs denotes their level of saturation. The closer to the hexagon’s 
center, the less saturated the color. 
On the left side (value), the topmost discs represent the lightest colors, 
and the lower discs represent  the darkest colors.  
 
 

 
Fig. 6-3: The Color Wheel View 
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The Hue and Saturation hexagon can be viewed in other ways. 
Clicking the right mouse button in the hexagon displays the following 
options: 
 

 
 
• RGB Cube 

Checking RGB Cube turns the hexagon into a 3 dimensional cube 
which represents RGB space. The cube can be rotated manually 
by dragging the left mouse pointer anywhere inside the right 
window. This allows you to view  all the color discs and their 
relative positions to each other in color space. Colors “hiding” 
behind others will become visible. 

• HSV Wheel  
Checking this option reverts to the two dimensional view, with the 
hexagon ring as described above. HSV Wheel is the default 
setting. 

• Uniform Size  
When this option is not checked,  the size of each LUT output 
color disc is relative to the number of pixels belonging to it in the 
original RGB input image. Therefore, the discs and their relative 
sizes clearly show the level of each color’s presence in the original 
input image. Sometimes the level of a color’s presence is 
unimportant in regard to the current editing function. Checking this 
option sets all color discs to equal sizes regardless of the pixel 
count.  

• Default Position  
Resets the RGB Cube to the default position.  

• Rotate  
Clicking on rotate displays a rotating RGB Cube and a controller 
that consists of an arrow and a compass as shown overleaf: 
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  Rotate – Cube controller 
 
Drag the mouse while holding down the left mouse button to move 
the arrow. The arrow in combination with the compass works like a 
joystick. You control the cube’s rotation direction and speed by 
controlling the arrow’s direction and distance from the compass.    

 
You may want to concentrate your editing actions on certain colors and 
would therefore like to reduce the number of colors displayed. In the 
left view (Brightness Value), the two horizontal lines (top and bottom) 
that define the size of  the slice selected in the triangle can be moved 
vertically by dragging the handles with the mouse. This “cutting out” of 
colors effects only the Color Wheel view and does not reduce colors in 
the output filter you are creating. You will have to use the Remove 
Marked and Remove Similar color tools for that (see section 6.4 LUT 
edit tools).   
 
Editing in the Color Wheel View 
Selecting colors in combination with editing tools is performed by 
moving the mouse pointer on the desired color disc in either one of the 
left (brightness) or right (Hue/Saturation) views. To help you, a blue 
ring will appear around the color that is being pointed at. The next click 
with the mouse will then select/mark that color with the current editing 
function.  
Many edit functions work in connection with a Pick Color. Only one 
pick color may be active at a time. In the Color Wheel View, you 
choose the Pick Color with the Pick Color tool (the pipette icon). The 
current picked color will be indicated by a red ring around the selected 
disk, and the color will be displayed in the window next to the Pick 
Color tool. 
Marking and unmarking of one or more colors is done by clicking on a 
color disc when in one of the supported edit functions. A marked color 
can be identified by a blue dot in the center of its color disc.  
 
Marking a color as “Protected” or “Unprotected” is done by clicking on 
the color disc when the Protect/Unprotect tool button is on. A protected 
color can be identified by a red dot in the center of its color disc.  
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6.3.6 Viewing with the LUT Histogram  

 
If a LUT file has been generated or loaded, selecting the above tool 
displays a histogram representing the LUT output colors that are used 
for classification (feature extraction) of the original RGB input image. 
The Histogram View gives a good clear picture of the quantity of 
output colors and their dominance in the original image.    
 
You can select a histogram sorting method through the Feature Menu 
(see section 6.5.6 – Histogram Sorting). Your selection takes effect 
immediately in the Histogram View with values descending from left to 
right. The available sorting methods are shown below: 
 

 
 
• Histogram sorted by each color’s pixel count. 
• Histogram sorted by palette order. 
• Histogram sorted Hue/Saturation/Value(HSV) color values  
• Histogram sorted by Red/Green/Blue (RGB) color values. 



6-14                       Feature Extraction 

 
Editing in the Histogram View 
In the Histogram View, you can pick colors with the Pick Color tool (the 
pipette icon). The current picked color will be indicated by a blue 
rectangle with a red arrow around the color histogram bar, and the 
color will be displayed in the window next to the Pick Color tool. 
Marking and unmarking of one or more colors is done by clicking on a 
color bar when in one of the supported edit functions. A marked color 
can be identified by a blue dot in the square below its color bar.  
Marking a color as “Protected” and “Unprotected” is done by clicking 
on the color bar when the Protect/Unprotect tool button is on. A 
protected color can be identified by a red dot in the square below its 
color bar. 
The Pick Color, Mark/Unmark and Protect/Unprotect tools will be 
described in section 6.4.  
 
 
 
 
 
 

 
Fig. 6-4: The LUT Histogram View 
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6.3.7 Viewing Pixel Information on the Status Bar 
The Screen Status Bar in the Feature Screen displays information on 
any color pointed at by the cursor or by one of the LUT edit tools. 
Information is displayed immediately, simply by moving the cursor over 
the color in the Histogram View and the Color Wheel View. In the Main 
View, pixel status is displayed when using the Pick Color tool as  
described in section 5.3.2 (View Screen- Image Manipulation Tools).  
 
The Status Bar is shown below: 

 
The following information fields are displayed: 
 
I:'#'  H:'#'  S:'#'  V:'#'   
 
or else 
  
I:'#'  R:'#'  G:'#'  B:'#' 
 
depending on the Color Info Field setting in the File Menu - 
Preferences – Color Info Field (see section 3.4.9). The labels used to 
identify each field are :  
 
I  is the Intensity field 
H,S,V  are Hue, Saturation, Value fields 
R,G,B  are RGB fields 
 
The Status Bar also displays a color’s Pixel count and Protection 
status. 
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6.4 Using the LUT Filter Editing Tools  
After automatic creation of an initial LUT filter, you will want to change 
the filter until it performs perfectly with the class of originals you wish 
to scan. The next sections are about the LUT editing tools and how to 
use them.  

6.4.1 An Overview of LUT Editing Tools 
On the right side of the LUT Toolbar you will find functions for 
controlling LUT editing. These tools can be sorted into three groups:  
 
• Assistance  function tools 
• Edit function tools 
• Commit and Regret function tools 
 
Each of the tools in these three groups will be described in detail later  
in this section. 
 
Assistance  functions: 
There are three selection tools that “assist” the Edit functions, but do 
not themselves make any alterations to the LUT. These are: 
• Pick Color  
• Protect Color(s) 
• Standard Cursor  (arrow) 

 Standard Cursor tool 
The Pick Color and Protect Color buttons are ON/OFF buttons. When 
clicked, the button stays “ON” until the button is either clicked again or 
the function is turned “OFF” by selecting another button. The Standard 
Cursor tool is enabled in the Main and Viewboards views. Pressing the 
Standard Cursor button “turns off” any current editing function and 
pixel highlighting. 
 
Edit functions: 
Seven edit function tools for setting up edit changes to the LUT are 
available: 
• Merge Marked Color(s) 
• Merge Similar Color(s) (to Pick Color) 
• Insert New Color (Pick) 
• Explode Pick Color 
• Remove Marked Color(s) 
• Remove Similar Color(s) (similar to Pick Color) 
• Remove Minor Color(s) 
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When one of the above Toolbar buttons is turned “ON”, it remains 
“ON” until one of the following occurs: 
• The edit operation is executed by clicking the Apply button. 
• The edit operation is aborted by clicking the Standard Cursor 

(arrow) tool button. 
• The function is turned “OFF” by clicking another Edit or Assistance 

function button. 
 
In the Main View and Viewboards highlighted colors are shown 
blinking on the screen. Highlighted colors are those affected by the 
currently selected edit function.  
 
When using an edit tool, marking and unmarking a LUT output color is 
done by clicking on a pixel on the screen with the mouse.  
Use of the edit functions normally results in re-mapping of the original 
RGB input image colors into one or more LUT output colors. 
Re-mapping is based on the shortest distance between input and 
output colors, and results depend on whether RGB or HSV 
coordinates are used. Selecting between the RGB or HSV methods 
takes place in the Feature Menu - Color Space (see section 6.3). 
Changes in Color Space will take effect on edit operations performed 
after the change. 
 
Commit / Regret functions: 
The Commit/Regret tools affect the LUT by either applying or undoing 
one of the above LUT edit functions. There are two tools: 
• Apply Edit Operation 
• Undo Edit Operation(s) 
 
Clicking the Apply button will conclude and commit the specified Edit 
function changes to the LUT. The selected edit tool button is turned 
'OFF' when the operation is completed. 
 
The Undo button, reverses the latest edit function, including changes 
to a color’s protection status. Up to 10 edit functions can be cancelled 
with the Undo button.  
Lets take a closer look at each LUT editing tool. 
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6.4.2 Protect Color(s) 

 
This tool is for protecting one or more colors from LUT editing 
operations. Protecting a color is like locking its current mapping 
settings. Colors are per default unprotected. 
 
How do I protect a color? 
• Go to the LUT edit view that best suites locating the color(s) for 

protection. Use the zoom tools to view individual pixels if 
necessary. 

• Click on the Protect Tool to activate the function. 
• Click on a color in any of the views to mark it as protected. 
• If you regret a marking, re-click on a protected color to remove the 

protection mark. 
• Re-Click the Protect Tool to turn the function OFF. 
 
Why Protection? - Protection Properties 
Protecting a LUT output color means that it cannot be removed by the 
editing operations. The following properties apply: 
• Colors in the original RGB image belonging to a protected color 

cannot be moved to another LUT output color. 
• A protected LUT output color cannot be removed from the list of 

active LUT output colors. 
• Other colors in the original RGB image can be mapped (added) to 

a protected LUT output color. 
• Attempts to mark protected colors for merging/removal will prompt 

a warning. 
 
Identifying Protected Colors 
In the Histogram view, a protected LUT output color is identified by a 
red square in the box below the color’s column. 
In the Color Wheel view a protected color is identified by a red dot in 
the center of the color disk. 
In the Main View and Viewboards, with the Protect Color(s) tool turned 
ON, all colors belonging to a protected LUT output color will be 
highlighted (blinking).  
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6.4.3 Pick Color 

 
For selecting LUT output colors for use in combination with other LUT 
editing functions. 
 
How do I select a Pick Color 
• Go to the LUT edit view that best suites locating the color you wish 

to select. Use the zoom tools (in Main and Viewboards Views) to 
view individual pixels if necessary. 

• Click on the Pick Color Tool. 
• When the button is turned ON the cursor changes to the Pick 

Color pointer cursor (pipette): 

 
• Click with the pipette on a pixel in one of the views to select the 

corresponding LUT output color. In the Histogram view, you select 
an active Pick Color by clicking on the desired LUT output color 
column. In the Color Wheel View you select the Pick Color by 
clicking on one of the color discs.  

• To help identify colors for selection, you can view (RGB or HSV) 
values of colors on the status bar as you point with the pipette. 

• Only one color can be selected at a time with Pick Color. The last 
selected color will always become the active Pick Color.  

• A sample of the active Pick Color will be displayed in the window 
to the right of the Pick Color Tool button. 

 
 
Identifying the Pick Color in the Image 
The Pick Color Tool works in all views, e.g., Main View, Viewboards, 
Color Wheel and Histogram.  
In the Main View and Viewboards, with the Pick Color tool turned on, 
all pixels that have the active Pick Color as their output LUT color will 
be highlighted (blinking). 
In the Histogram view, a full height rectangle around the column marks 
your selection and indicates that the color is the active Pick Color. 
In the Color Wheel View the active Pick Color is indicated by a red ring 
around the selected LUT output color disc. 
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6.4.4 Merge Marked Color(s) (to Pick Color) 

 
The Merge Marked Color tool enables you to merge one or more 
colors of your choice, through re-mapping. 
 
How do I mark and merge output colors? 
• Go to the LUT edit view that best suites locating the color(s) you 

wish to merge. Use the zoom tools to view individual pixels if 
necessary. 

• Select a Pick Color with the Pick Color Tool. 
• Select the Merged Marked Color Tool. The tool will stay ON until 

you re-click it. This means that you can mark many colors before 
applying the function. 

• Click with your mouse on any color(s) to mark it for re-mapping. 
• To un-mark a marked color, just re-click on it in any of the views. 
• A warning will be displayed if you attempt to mark a Protected LUT 

output color for merging. 
• Control your markings in different views i.e., Histogram, Main, 

ColorWheel. 
• Click on the Apply Tool button to activate the merge process. 
• View the effects in the Main View with the RGB/LUT button on 

LUT output. 
• If you regret the merge effects, click on the Regret Tool to remove 

the action. 
 
Merge Tool Effects 
Colors in the original RGB input image, that belong to a Marked Color, 
will be merged (re-mapped) to the active Pick Color, i.e., the last color 
chosen with the Pick Color Tool. 
 
Identifying Marked Colors 
Pixels that belong to the Pick Color and the marked LUT output colors 
will be highlighted in the Main and Viewboard views, or marked by blue 
dots in the Histogram and Color Wheel screens. 
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6.4.5 Merge Similar Color(s) (similar to Pick Color) 

  
The Merge Similar Color Tool enables you to merge colors on the 
basis of their similarity, thus filtering out unessential color differences 
from the image. 
The Merge Similar Color(s) Tool merges all unprotected LUT output 
colors that lie within a specified color distance from the Pick Color. The 
colors are re-mapped to the Pick Color. 
 
How do I merge similar output colors? 
• Go to the LUT edit view that best suites locating the color(s) for 

merging. The Color Wheel View gives a good picture of the output 
color's nearness in color space (similarity), or use the Histogram 
view sorted by HSV or RGB values. 

• Select a Pick Color with the Pick Color Tool. You want to merge 
colors that are similar to this color and you want to merge the 
colors TO this color. 

• Select the Merged Similar Color(s) Tool. The tool will stay ON until 
you re-click it. A Set Distance dialog box appears.  

• Set the colors distance in the dialog box using the slider. See the 
definition of similarity below. 

 
• The Pick Color and Pixels that belong to colors defined as similar 

to the Pick Color are highlighted/marked. You can interactively see 
which colors will be included because highlighting/marking takes 
immediate effect as you make changes to the color sphere radius 
by moving the sliders. 

• Click the dialog's Apply Button to commit the function. 
• Control your results in different views i.e., Histogram, Main, 

ColorWheel. 
• View the effects in the Main View with the RGB/LUT Button on 

LUT output. 
• If you regret the merge effects, click on the Regret Tool to remove 

the action. 



6-22                       Feature Extraction 

Merge Similar Effects 
Colors in the original RGB input image, that belong to LUT output 
colors within the sphere, are re-mapped to the Pick Color. Protected 
colors are excluded from the sphere regardless of their similarity to the 
Pick Color. Merged LUT output colors are not removed from the list of 
active LUT output colors, and thus will still be shown in the Color 
Wheel and Histogram Screens ( values of 0 will be associated with 
these colors). 
 
Definition of Similarity 
Similarity is defined in the following way: The slider defines a distance 
which represents the radius of a sphere that surrounds the Pick Color. 
Colors close enough to the Pick Color, so that they are within the 
sphere, will be considered similar. The smaller the distance, the less 
the number of colors that will be defined as similar. The distance 
is represented as a percentage of the full color axis. 
 

6.4.6 Explode Color (Pick Color into more colors) 

  
For reproducing more LUT output colors based on a selected color 
and the original colors that belong to it. Colors in the original RGB 
input image that represent the Pick Color are evenly distributed into 
the Pick Color and a number of new LUT output colors. 
 
How do I explode a LUT output color? 
• Go to the LUT edit view that best suites locating the color you wish 

to explode. 
• Select the color with the Pick Color Tool. You want to explode this 

color into more colors from the original that are near it. 
• Select the Explode Color Tool. The tool will stay ON until you re-

click it. A dialog box for setting the number of colors will appear. 
• If you attempt to activate the Explode Pick Color Tool with the Pick 

Color itself protected, an error message will be displayed. 
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• Set the number of colors you wish the Pick Color exploded into in 

the dialog box using the slider. You can set up to 63 colors. 
• Click the dialog's Apply button to commit the function. Colors in 

the original RGB input image, that belong to the Pick Color, are re-
mapped into the specified quantity of LUT output colors. One of 
these colors is the Pick Color itself, while the rest are new colors. 

• The Apply function will be disallowed if the total number of active 
LUT output colors exceeds 255 as a result of the explode function. 

• Control the results in different views i.e., Histogram,  ColorWheel. 
• View the effects in the Main View with the RGB/LUT button on 

LUT output. 
 
Explode Effects 
Colors in the original RGB input image that represent the Pick Color 
are evenly distributed into the Pick Color and a number of new LUT 
output colors. Colors in the original RGB input image, that belong to 
the Pick Color, are re-mapped into the specified quantity of LUT output 
colors. One of these colors is the Pick Color itself, while the rest are 
new colors. The new LUT colors are evenly distributed within the 
sphere of RGB colors previously belonging to the Pick Color. 
The new LUT colors are evenly distributed within the sphere of RGB 
colors previously belonging to the Pick Color. 
Re-mapping is based on the color distance method selected in Color 
Space in the Feature Menu (see section 6.5.7). 
 

6.4.7 Remove Marked Color(s) 

  
For removing LUT output colors through manual selection. 
 
How do I mark and Remove output colors? 
• Go to the LUT edit view that best suites locating the color(s) you 

wish to remove. Use the zoom tools to view individual pixels if 
necessary. 

• Select the Remove Marked Color tool. The tool will stay ON until 
you re-click it. This means that you can mark many colors before 
applying the function. 

• Click with your mouse on any color(s) to mark it for removal. 
• Marked colors can be unmarked by clicking on a pixel 

corresponding to the marked LUT output color. 
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• A warning will be displayed if you attempt to mark a Protected LUT 
output color for removal. Protected colors cannot be marked. 

• Control your markings in different views i.e., Histogram, Main, 
ColorWheel. 

• Click on the Apply Tool button to remove the marked 
colorsfromthe output colors in the LUT. 

• View the effects in the Main View with the RGB/LUT button on 
LUT output. 

• If you regret the effects, click on the Regret Tool to cancel the 
action. 

 
Remove Tool Effects 
A marked LUT output color will be removed by re-mapping the colors it 
relates to in the original RGB input image. The colors are re-mapped 
to the nearest unmarked LUT output color. 
 
Identifying Colors Marked for Removal 
Pixels corresponding to the marked LUT output colors will be 
highlighted (blinking) in the Main and Viewboards views, and marked 
with blue dots in the Histogram and Color Wheel views. 
Removed LUT output colors will be removed from the list of active 
LUT output colors, and thus from the Color Wheel and Histogram 
screens. 
 

6.4.8 Remove Similar Color(s) (similar to Pick Color) 

  
The Remove Similar Color Tool enables you to remove colors on the 
basis of their similarity. 
The Remove Similar Color(s) Tool removes all unprotected LUT output 
colors that lie within a specified color distance from the Pick Color. The 
Pick Color itself will be removed if it is unprotected. After removal, an 
original input color that has lost its target, will be remapped to the 
nearest active output color in the LUT. 
 
How do I Remove Similar output colors? 
• Go to the LUT edit view that best suites locating the color(s) for 

removal. The Color Wheel View gives a good picture of the output 
color's nearness in color space (similarity), or use the Histogram 
View sorted by HSV or RGB values. 

• Select a Pick Color with the Pick Color Tool. Your goal is to 
remove colors that are similar to this color. 
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• Use the Protect Tool on the Pick Color if you don't want it removed 
as well. Leave it unprotected if you want it removed with all the 
colors similar to it. 

• Use the Protect Tool to protect other (similar) colors that you don't 
want removed. 

• Select the Remove Similar Color(s) Tool. The tool will stay ON 
until you re-click it. The following dialog appears. 

 
• Set the colors distance in the dialog box using the slider. See the 

definition of similarity below. 
• The Pick Color and Pixels that belong to colors defined as similar 

to the Pick Color are highlighted/marked. You can interactively see 
which colors will be included because highlighting/marking takes 
immediate effect as you make changes to the color sphere radius 
by moving the sliders. 

• Click the dialog's Apply Button to commit the function. 
• Control your results in different views i.e., Histogram, Main, Color 

Wheel. 
• View the effects in the Main View with the RGB/LUT button on 

LUT output. 
• If you regret the remove effects, click on the Regret Tool to 

remove the action. 
Remove Similar - Effects 
Colors in the original RGB input image, that belong to LUT output 
colors within the sphere, are re-mapped to the nearest active LUT 
output colors. Protected colors are excluded from the sphere 
regardless of their similarity to the Pick Color. Removed LUT output 
colors are deleted from the list of active LUT output colors, and thus 
from the Color Wheel and Histogram Screens. 
Definition of Similarity 
Similarity is defined in the following way: The slider defines a distance 
which represents the radius of a sphere that surrounds the Pick Color. 
Colors close enough to the Pick Color, so that they are within the 
sphere, will be considered similar. The smaller the distance, the less 
the number of colors that will be defined as similar. The distance 
is represented as a percentage of the full color axis. 
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6.4.9 Remove Minor Color(s) 

  
The Remove Minor Color(s) Tool enables you to remove colors on the 
basis of their relative dominance in the image. 
The Remove Minor Color(s) function removes all unprotected LUT 
output colors that are identified as being minor in relation to all the 
active output colors. After removal, an original input color that has lost 
its target, will be remapped to the nearest active output color in the 
LUT. 
How do I Remove Minor output colors? 
• Go to the LUT edit view that best suites locating the color(s) for 

removal. The Histogram View and the level of each color column 
gives a good picture of an output color's dominance in the image. 

• Use the Protect Tool on the colors you don't want it removed. 
• Select the Remove Minor Color(s) Tool. The tool will stay ON until 

you re-click it. A dialog for setting the minority borderline appears. 

 
• Set the minor percentage borderline value in the dialog box using 

the slider. A percentage value represents a color’s number of 
pixels in relation to the total number of pixels in the original. The 
slider setting in the window determines the borderline between 
major and minor colors, meaning that image colors with lower 
percentage values will be removed when Remove Minor Color(s) 
is applied. 

• The unprotected pixels that belong to colors defined as minor are 
highlighted/marked. You can interactively see which colors will be 
included because highlighting/marking takes immediate effect as 
you make changes to the minor borderline by moving the slider. 

• Click the dialog's Apply Button to commit the function. 
• Control your results in the different views i.e., Histogram, Main, 

Color Wheel. 
• View the effects in the Main View with the RGB/LUT Button on 

LUT output. 
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• If you regret the remove effects, click on the Regret Tool to 
remove the action. 

 
Remove Minor Color - Effects 
Colors in the original RGB input image, that belong to LUT output 
colors with pixel counts lower than the borderline percentage, are re-
mapped to the nearest active LUT output colors. Protected colors are 
excluded from the process regardless of their pixel count. Removed 
LUT output colors are deleted from the list of active LUT output colors, 
and thus from the Color Wheel and Histogram Screens. 
 

6.4.10   Insert New Color (Pick) 

 
The Insert New Color Tool enables you to insert new colors that are 
created on the basis of existing colors in the original RGB image. This 
is a powerful tool because it allows you to take out colors or color 
averages from the original RGB image and put them into the LUT filter 
as re-mapping targets. Basing your LUT on original input colors can 
help make it stabile and well balanced in relation to a whole class of 
originals because you set up well-defined re-mapping relationships.  
Inserting a New Color 

• Move to the Main view or one of the Viewbords. This tools can 
only be used in one of these views with the RGB/LUT Button 
toggled on RGB viewing mode. 

• Toggle the RGB/LUT Button so you are viewing in the RGB 
original color mode. 

• Use the Protect Tool to mark colors you definitely don't want 
remapped to the new color. 

• Select the Insert Color Tool. The cursor changes to the pipette 
cursor: 

 
• Use the pipette cursor to select a pixel representing a color you 

want added to the LUT. Remember : Pixel selection is easiest 
after zooming-in so that pixels can be identified separately. 

• You will be warned if you happen to select a pixel representing a 
color that is already present in the LUT. If you get this warning 
then try another color. 

• Notice that the selected color becomes the new Pick Color and is 
ready for merge, removal, or explode actions. 
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• You can also insert a new color based on the average of many 
colors from a selected area. Hold down the left mouse key and 
drag a square with the new cursor over an image area. 

 
• Release the key and see the color that appears as the Pick Color. 

The new LUT output color is an average of the original RGB input 
image colors (pixels) within the square. 

• To add the color (single pixel or area), click on the Apply Tool. 
• If you attempt to insert an RGB input color that belongs to a 

protected LUT output color, a warning will be displayed. 
• Use the RGB/LUT Button to view the effects with the new color. 
• View the color and its dominance in the Histogram View. 
 
Insert New Color - Effects 
The nearest original RGB input image colors will re-mapped to the 
new inserted LUT output color. By selecting area averages, you can 
ensure that whole groups of pixels will be re-mapped to one inserted 
color because the color will be based on and close to colors of  those 
very pixels. 
Colors that belong to protected LUT output colors will not be re-
mapped. 
An inserted LUT output color will be added to the list of active LUT 
output colors and thus appear in the Color Wheel and Histogram 
views. 
 
Identifying the Effects After Color Insersion  
Pixels that belong to the new LUT output color will be highlighted in the 
Main and Viewboards views with the RGB/LUT Button on RGB viewing 
mode. No change occurs in the Histogram and Color Wheel views until 
the Apply button is clicked. 
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6.4.11   Apply Edit Function Operations 

 
Selecting the Apply button will conclude and commit any specified Edit 
function changes to the LUT file. The selected Edit tool button is 
turned 'OFF' when the operation is completed. 
 

6.4.12   Undo Edit Function Operations 

  
The Undo button reverses the latest edit function including changes to 
the colors’ protection status. Up to 10 previous edit functions are 
“remembered” and can be cancelled with the Undo button.  
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6.5 LUT Edit Settings in the Feature Menu 
The Feature Menu in the Menu Bar contains options from which you 
choose general LUT creation and LUT editing settings. Clicking on 
Feature displays the menu shown below.  

6.5.1 Create LUT… 
This is where you normally start the LUT process by generating a 
preliminary LUT that can then be refined through the Edit tools.  
As described in section 6.1.1, you start by opening the RGB image file 
in the viewer and then select the Feature Tab to move the Feature 
Screen. In the Feature Screen, select Create from the Feature Menu. 
to display the dialog (Fig. 6-6 shown overleaf) from which you select 
your LUT generation method and parameters. You also determine the 
number of initial colors, so it is here that you must choose starting with 
Excessive Initial Colors or One/Few Initial Colors (see section 
6.1.3).  The two setup buttons  lead to options that allow you to 
adjust each of the two adaptive generation methods.  
 
LUT Generation Methods 
The initial LUT generation method choices are: 
Load Predefined Colors: Predefined colors from a palette are used. 
The palette is specified in the file window. You can select a palette by 
typing the file name in the edit field or by file selection through the 
Browse button. The  available file types are: 
• .LUT: The color palette part of a previously generated LUT is 

used. 

 
Fig. 6-5: The Feature Menu 
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• .TIF: The palette part of an indexed color TIFF file is used. 
• .PCX:The palette part of a palettized PCX file is used. 
• .PAL: Usage of a palette PAL file, generated by other software 

applications.  
 
Image Independent (Linear): Linear distribution of colors in RGB 
space. The number of LUT output colors can be set in the pull-down 
box. 
Photo, Artwork, etc.:  Adaptive method. The median cut algorithm is 
used with the parameters specified through the  setup button.  
Maps, CAD Plots, etc.: Adaptive method. The modified median cut 
algorithm is used with the parameters specified through the setup 
button. 

 
As noted above, additional options are connected to the two adaptive 
algorithm methods – Photo, Artwork or Map, CAD plots.  
 
Select the attached setup button  to reach the setup dialog for each 
of the adaptive methods. The dialog is shown overleaf: 

 
Fig. 6-6: Create LUT Dialog 
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• Choose RGB or HSV color space for color distance calculations.   
• Select the initial number of colors for your LUT output. The 

number of output colors can also be controlled by defining the 
smallest (minimum) distance between colors in color space. 

• Commit your settings by clicking OK and thereby initiate the 
analysis of the RGB input image for generation of a representative 
LUT.   

 
Tip: The initial LUT will normally be based on the whole image. With 
the adaptive methods, you can also create a LUT based on a selected 
portion of the image - a specific image area in which the colors best 
represent your purposes. Instructions follow below:  
 
Creating an initial LUT on the basis of a specific image area  
You may want to use a specific image area, with representative colors,  
as the only input for creating the initial LUT. Here’s how : 
• Move to the Feature Screen - Main View with an open image. 

• Click on the Rectangle Selector Tool on the View Toolbar. . 

• The cursor changes to :  
• Mark out the area by dragging the cursor. You can move and 

change the rectangle as described in section 6.2.3 on the 
Rectangle Selector Tool. You should now have an active 
rectangle. 

• Select Create LUT from the Feature Menu.  
• Select the Selected rectangle option in the Create dialog.  
• Make the additional settings in the LUT Create dialog as described 

above and click OK. 

 
Fig. 6-7: Create LUT - Adaptive Method Settings 
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• WIDEimage will proceed using only pixels within the square while 
calculating the initial LUT filter. 

 

6.5.2 Load LUT…  
Choose Load LUT if you want to work with a previously generated 
.LUT file. A file selector dialog allows you to choose your file. 
  

6.5.3 Close LUT 
This option closes the opened LUT file.  
 

6.5.4 Save LUT… 
A Save As… dialog is displayed for saving the generated/edited .LUT 
file wherever you specify. 
 

6.5.5 Import Color(s) 
Import Color(s) is used in connection with an active (open) .LUT file.  
 
Selecting Import Color(s) displays the dialog below for specifying either 
: 
• A number of self defined new colors to be added to the currently 

active LUT output colors, or 
• A palette screen for selecting a number of new colors to be added 

to the active LUT output colors.  
 
Importing Self-Defined Colors 

Fig. 6-8: Import Color(s) to LUT Dialog 
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• You specify self-defined new colors by mixing Red, Green and 
Blue using the three sliders or by setting values directly in the edit 
fields. 

• Your result is viewed in the color window on the left. RGB color 
space or HSV color space can be selected. 

• Click on Add to list for each self-defined new color. Your list of self 
defined new colors is displayed at the bottom of the dialog and will 
be updated with each new color. 

• Use the Remove From List and Replace buttons to edit your list of 
self-defined colors. 

• All the colors on the list will be imported to the LUT output colors 
when you click OK. 

 
Importing Palette Colors 
 

• Click on the From Palette button to display a file selector dialog for 
specifying and loading a file containing a palette. 

• Loading the file displays the palette colors as small squares (see 
fig. above). Palette colors will be sorted either by their Palette 
Index Value or by their HSV value, depending on the dialog’s Sort 
By box setting. 

• One or more colors can be selected for importing. Click on a color 
square to select and deselect it. You can affect whole clusters by 

 
Fig. 6-9: Import from Palette Dialog 
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dragging the mouse pointer over colors and thereby toggling their 
selection. The values of the last selected (single color) are 
displayed on the right side of the dialog. 

• Click the OK button to import the marked colors from the palette 
and add them to the list of active LUT output colors. There will not 
be any RGB input colors relating to these imported colors. This 
can later be done using the Merge, Explode or Remove edit tools. 

• The original number of colors in the LUT plus those added cannot 
exceed 255. 

 

6.5.6 Histogram Sorting 
Histogram Sorting interacts together with the Histogram View, allowing 
you to select the immediately active Histogram sorting method. The 
following methods are available: 
• Sort by Pixel count 
• Sort by Palette order 
• Sort by HSV 
• Sort by RGB 
 

6.5.7 Color Space 
The Color Space dialog allows you to determine if RGB or HSV color 
space is to be used in connection with the Merge, Explode and 
Remove LUT Edit functions (see section 6.2.3).  Color Space changes 
will only effect LUT edit operations performed after the change. 
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7. Supported File Formats 
WIDEimage supports more than 50 different industry standard file 
formats. This ensures compatibility with the maximum number of 
general and special applications within CAD, DTP, and Graphics. 
 
The raster file formats supported are split into the following groups: 
 
• General image file formats 
• Graytone file formats 
• Color file formats 
• print file formats 
 
For raster file formats, WIDEimage supports: 
 
• Scanning to any of the following fifty-plus industry standard file 

formats. 
 
• Converting from any file format (except the Print file formats) to 

any other file format (including the Print file formats). 
 
• Viewing and zooming-in to any of the file formats (except the Print 

file formats).  
 
• Printing from any file format (except color formats) to any of the 

supported printers, and print file formats. 
 

7.1 General Image File Formats 
Bmp. Microsoft Windows bitmap file format. Most Windows graphics 
and image applications support this format. Note that this format is 
defined “upside-down”, so that treatment after conversion or scanning 
may take a long time on the application. 
 
Tif. TIFF (Tagged Image File Format, Aldus Spec.) is a standard file 
format used by most Raster and Desk Top Publishing programs; it is 
also the standard image file format for many image processing / 
enhancement programs.  
Through the Options button in the Save As… dialogs you can select 
the best TIFF compression type (e.g., uncompressed, packbits, LZW, 
group3 or group4) and specify rows per strip or tile size. For the 
uncompressed, packbit and LZW types you can also select B/W or 
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graytones (see later section: "Graytone Formats"). Both Intel and 
Motorola orientations are supported. 
When a TIFF file is used as source in Convert, View or Print, 
WIDEimage automatically detects which of the following B/W or 
Graytone compression methods was selected when the TIFF file was 
generated. 
Tif. Uncompressed B/W, Graytone or Color version of TIFF, supported 
by most vendors. 
Tif. Packbits byte oriented runlength compressed B/W, Graytone or 
Color version of TIFF, similar to Macintosh packbit format. 
Tif. Group3 runlength compressed B/W version of TIFF, supported by 
many vendors. 
Tif. Group4 compressed B/W version of TIFF, supported by some 
vendors. 
Tif. LZW(Lempel-Ziw-Welch) compressed B/W, Graytone or Color 
version of TIFF, supported by many vendors. 
A special case is the Wicks & Wilson aperture card file format, which 
is a separately selectable variant of TIFF: 
Tif. Wicks & Wilson, Uncompressed B/W TIFF variant compatible with 
the Wicks & Wilson aperture card scanner. Since it is used with 
microfilm negatives, the image is reversed. 
 
CALS – General for CALS - The CALS raster format is a standard 
developed by the Computer Aided Acquisition and Logistics Support. 
The CALS file is composed of the CALS 
header followed by some data. The CALS-headers subtype-parameter 
describes 
and determines the format of the data that follows the header. 
WIDEimage supports the following CALS subtypes: 
 
Cal – CALS1 CALS Type1 untiled format, compatible with CCITT 
Group4 format (CALS Computer Acquisition and Logistics System, 
MIL-R-28002A). 
 
Cal – CALS2 CALS Type2 tiled format, compatible with CCITT 
Group4 format (CALS Computer Acquisition and Logistics System, 
MIL-R-28002A). 
 
Cal – CALS4 CALS Type 4 titled format, compatible with CCITT 
Group4 format (CALS Computer Acquisition and Logistics System, 
MIL-R-28002A). 
It is a CALS-encapsulation of the JEDMICS (Joint Engineering Data 
Management Information and Control System) format (see below).  
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JEDMICS a black/white tiled raster data format as defined by the Joint 
Engineering Data Management Information and Control System. The 
image is divided into tiles of 512 * 512 pixels. Each tile is compressed 
with the 2-dimensional CCITT group 4 encoding algorithm.  
 
Pcx. Black & white file format originally defined by PC Paintbrush from 
Z-Soft Corporation.  
 
Rlc. Used by Softdesk CADoverlay and ViewBase. CADoverlay can be 
used to import raster images as an overlay into AutoCAD.  
 
Rlc2. Softdesk CADOverlay-enhanced Rlc file format, containing 
additional information at the end of the file. Since Rlc and Rlc2 are 
compatible, except for this additional information, both formats are 
supported by the WIDEimage Rlc choice. 
 
Ig4. Softdesk Group4 compressed format (similar to the Rlc2 
fileformat, but with raster data segments containing strips of group4 
data). 
 
Rnl. Used by GTX corporation overlay CAD systems and Raster To 
Vector conversion systems (Simple runlength encoding). 
 
Gtx-G3. Used by GTX corporation overlay CAD systems and Raster 
To Vector conversion systems (CCITT G3 encoding).  
 
Gtx-G4. Used by GTX corporation overlay CAD systems and Raster 
To Vector conversion systems (CCITT G4 encoding).  
 
Ras. Sun raster format (is the native bitmap format for the SUN UNIX 
platform). 
 
Eps. Encapsulated Postscript format. Works with many Desk Top 
Publishing software packages. 
 
Hrf. Hitachi Inc. CADCore format. 
 
Rst. Indigo Graphics Systems Inc. raster format. 
 
Gr4AB. ABB Engineering Automation Inc. format compatible with 
CCITT Group4 format. 
 
VifAB. ABB Engineering Automation Inc. format compatible with 
runlength compressed format. 
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CitIN. INTERGRAPH Inc. format compatible with CCITT Group4 
format (Intergraph Type 24). 
 
RleIN. INTERGRAPH Inc. format compatible with runlength 
compressed format (Intergraph Type 9). 
 
Pict. Macintosh PICT format is one of the best supported file formats 
on the MAC platform (packbit encoding). 
 
Pro-Rlc. Xerox Pro Scan RLC file format. 
 
Wpf. Wicks & Wilson internal file format. 
 
ImgCM. File format used for the CADmate Raster To Vector 
conversion package, as well as for the general raster format 
(EYESTAR format) supported by Microtek desktop scanners. 
 
ImgCC. File format used for AutoDesk's CADcamera Raster To 
Vector conversion package (similar to Datacopy Inc. Img format). 
 
ImgGEM. Used by Digital Research Inc. GEM applications, such as 
GEMpaint and GEMscan. Note that many GEM applications are rather 
limited in the size of image they are able to load. 
 
Scn. Used by Eldak's Raster To Vector conversion package and by 
Eldak's raster editor (similar to Scan-Graphics Inc. Scn format). 
 
Cut. For the Media Cybernetics Dr. HALO raster editor. 
 

7.2 Graytone Formats 
Tif. Uncompressed 8-bit gray-level version of TIFF. Graytone options 
can be selected through the Options button in the Save As… and 
Batch Convert dialogs. (See Tif file format in previous General Image 
file section for setup.) 
 
Tif. Packbit compressed 8-bit gray-level version of TIFF. Graytone 
options can be selected through the Options button in the Save As… 
and Batch Convert dialogs. (See Tif file format in previous General 
Image file section for Setup.) 
Tif. LZW (Lempel-Ziw-Welch) compressed gray-level version of TIFF, 
supported by many vendors. 
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Bmp. Microsoft Windows bitmap file format. Most Windows graphics 
and image applications support this format. Note that this format is 
defined “upside-down”, so that treatment after conversion or scanning 
may take a long time on the application. 
Igs. 'Softdesk' uncompressed Graytone format. 
 
Pcx. Graytone 8-bit format as defined by Z-Soft for PC-Paintbrush, 
widely used with many applications. Graytone options can be selected 
through the Options button in the Save As… and Batch Convert 
dialogs.  
 
Ras. Sun gray-level format (is the native bitmap format for the SUN 
UNIX platform). 
 
Jpeg. Joint Photographic Experts Group compression as specified in 
ISO 10918-1. Achieves outstanding compression ratios by "lossy" 
algorithm. The lossyness can be controlled by setting the quality factor 
in the Save As… -  Options dialog. 
 
NOTE: For scanning, the graytone file formats are selectable when 
Mode is set to "Graytone" 
 
Conversion between the above graytone formats is supported with 
graytones maintained. 
Conversion of the above graytone formats to a line mode format and 
Printing or Viewing of graytone files is supported by the user specifying 
a threshold value between 0 and 255. 
Conversion of a line mode format to one of above graytone file formats 
is supported by mapping 0 and 1, to 0 and 255.  
 
NOTE: Graytone formats produce very large files; e.g., an E-Size 
drawing scanned at 300 DPI results in a file size of 150 Mb. 
 

7.3 Color Formats 
Tif. Uncompressed 24-bit color version of TIFF. Adjustable settings 
can be made through the Options button in the Save As… and Batch 
Convert dialogs. (See Tif file format in previous General Image file 
section for options.) 
 
Tif. Packbit compressed 24-bit color version of TIFF. Adjustable 
settings can be made through the Options button in the Save As… and 
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Batch Convert dialogs. (See Tif file format in previous General Image 
file section for options.) 
 
Tif. LZW (Lempel-Ziw-Welch) compressed 24-bit color version of 
TIFF, supported by many vendors. 
 
Tif. Feature extracted and indexed 8-bit and 4-bit color formats. 
 
Bmp. Microsoft Windows bitmap file format. 24-bit true color and 8-bit 
and 4-bit feature extracted and indexed color formats. Most Windows 
graphics and image applications support this format. 
 
Pcx. 24-bit true color and 8-bit and 4-bit feature extracted and indexed 
color formats as defined by Z-Soft for PC-Paintbrush. Widely used with 
many applications. The graytone option can be set through the 
Options button in the Save As… and Batch Convert dialogs. 
  
Ras. Sun 24-bit truecolor and 8-bit feature extracted and indexed color 
formats (is the native bitmap format for the SUN UNIX platform). 
 
Jpeg. Joint Photographic Experts Group compression as specified in 
ISO 10918-1. Achieves outstanding compression ratios by "lossy" 
algorithm. The lossyness can be controlled by setting the quality factor 
through Options in the Save As… and Batch Convert dialogs. 
 
NOTE: For scanning, the color file formats are selectable when 
"Mode" is set to "Color" 
 
Conversion between the above color formats is supported with colors 
maintained. 
 
Conversion of above color formats to graytone formats is supported by 
using: 
                   Gray-level = 0.29xR+0.59xG+0.11xB 
Conversion of above color formats to a line mode format is supported 
by internal conversion to Graytone levels and the user specifying a 
threshold value between 0 and 255. 
NOTE: 24-bit true color formats produce very large files; e.g., an E-
Size drawing scanned at 300 DPI results in a file size of 450 Mb. 
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7.4 Print File Formats 
Rtl. Hewlett Packard Raster Transfer Language output file format 
supported on the HP7600, HPDesignJet, Océ Graphics thermal printer 
and the NovaJet printers. 
Pcl. File format for HP LaserJet-compatible laser-printers.  
 
Tif. Group4 compressed B/W version of TIFF, supported by some 
vendors. 
Generic Cals. Many printers today support output in the CALS type 1 
format. 
 
Ver. VersaTec Inc. CADMate electrostatic large-format printer raster 
output file format. The Versatec Data format is also available. 
 
Crf. CalComp Inc. DrawingMaster thermal large-format printer raster 
output file format. 
 
Jdl. Japan Digital Laboratory Inc. Express Printer output file format. 
 
Atl.  24" thermal printer raster output file format. 
 
Con. Hybrid thermal printer raster output file format. 
 
Scm. Partner Gmbh. SCANmate electrostatic large-format printer 
raster output file format. 
 
Gra. Graphtek thermal printer raster output file format 
 
Ltx. Roland Inc. LTX420L, LTX420, LTX320L, and LTX320/321 
thermal large format printer raster output file format. 
 

7.5 Setting the CALS Gp4 Orientation 
If you choose to scan or convert to CALS Gp4 format, the Setup 
button in the file selection dialog allows you to input the pel/path 
orientation and store it in the Gp4 CALS file header of the document to 
be scanned or converted. 
The CALS Gp4 pel/path orientations selectable are: 

00/270 (default) 
90/270 
180/270 
270/270 
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For CALS Gp4 documents, the manner in which the ODA raster 
architecture deals with orientation requires the use of two operations. 
The pel-path and line-progression directions specified for the 
document at interchange time will guide the user during the imaging 
process. To get proper viewing, a reader will take pels from a 
compressed or uncompressed data stream (file) and place them on 
the screen or paper in the directions indicated. The decoding program 
will lay down the first line of pels along the pel-path direction and the 
second line along a path parallel to the first, but displaced from it along 
the line-progression direction. 
 
The decoding system knows its own requirements.  If the target device 
is a display,  the pels may be placed in memory in one organization. If 
the target device is a narrow printer, the pels may be placed in 
memory by the decoding program in a different way. This means that 
the orientation parameters found in the file are purely descriptive, not 
rescriptive. 
The pel-path direction may have any of four values and the line- 
progression direction can be at either of the two possible right angles 
to it. Therefore, this model can describe images that are not only 
retreated, but also mirrored either vertically and/or horizontally. This 
allows the orientation parameters to describe how to image a file that 
might have resulted from scanning the reverse side of an aperture 
card or paper sepia. This procedure may have been done in order to 
improve image quality. 
Refer to the figures overleaf for an illustration of the possible 
orientations. 
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Fig. 7-1: CALS Positioning of Portrait Document 
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Fig. 7-2: CALS Positioning of Landscape Document 
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If a mix of scans is done as a batch, and the file-writer assumes that 
all of the scans have a certain orientation, when in fact they do not, 
then a QA post-process will be necessary. The QA operator would 
view each scan, check its quality, perhaps perform a clipping 
operation, and then identify which direction would be "up" for proper 
viewing orientation. The orientation parameters would end up in the 
file, which until that point would have had incorrect orientation 
parameters. No other changes or actual rotation would be required. 
 
It is worth noting that some organizations require that all files have the 
same orientation. 
 
Rotation to Proper Viewing Orientation 
 
MIL-R-28002A allows the contractor to optionally specify that all 
documents be rotated, where necessary, to achieve proper viewing 
orientation, with pel-path direction set to 0 and line-progression 
direction set to 270. If this option has been specified, the QA process 
described above would require an additional step of rotating any 
document that was improperly scanned. This contracting option would 
be specified in systems where the viewing subsystem is not powerful 
enough to perform at display time any rotation that may be required 
because of earlier random-orientation scanning. 
 

7.6 JPEG Format: 
JPEG is a compression method for full-color and gray-scale images.   
 
JPEG is designed to handle "real-world" scenes, for example, scanned 
photographs. Line drawings images are not JPEG's strong suit. For 
that sort of material you may get poor image quality and/or little 
compression. Converting a B/W image to JPEG will result in a larger 
gray-scale image file of poor quality, and is therefore not 
recommended. 
 
JPEG is 'lossy', meaning that the output image is not necessarily 
identical to the input image. Hence you should not use JPEG if you 
must have identical output bits. However, on typical real-world images, 
very good compression levels can be obtained with no visible change. 
Amazingly high compression is possible if you can tolerate a low-
quality image.  You can trade off image quality against file size by 
adjusting the "quality" settings through the Options button in the Save 
As… and Batch Convert dialogs: 
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Quality: The quality option lets you trade off compressed file size 
against quality of the reconstructed image: the higher the quality 
setting, the larger the JPEG file, and the closer the output image will 
be to the original input.  Normally you want to use the lowest quality 
setting (smallest file) that decompresses into something visually 
indistinguishable from the original image.  For this purpose the quality 
setting should be between 50 and 95; the default of 75 is often about 
right.  If you see defects at quality 75, then go up 5 or 10 counts at-a- 
time until you are satisfied with the output image.  Quality values 
above around 95 are not recommended for normal use. The 
compressed file size increases dramatically without significant gain in 
output image quality. 
  
Smoothing: The smoothing option filters the input to eliminate fine-
scale noise. A moderate smoothing factor of 10 to 50 may get rid of 
dithering patterns in the input file, resulting in a smaller JPEG file and 
a better-looking image. Too large a smoothing factor will visibly blur 
the image. The default value is 0. 
 

7.7 File Format Limitations 
Some scanner models support scanning at very high resolutions. 
Scanning at maximum width (8.5 on the front measurement ruler) at 
1000 DPI produces approximately 36000 pixels/line. 
This results in a problem with file formats that were designed to accept 
a maximum length of approximately 32000 pixels (signed 2 bytes), or 
64000 pixels. 
The file formats with the 32000 limitation are: Pcx, Cut, Rlc, Vif, 
ImgCC, ImgCM and ImgGEM. JPEG formats have the 64000 
limitation. WIDEimage solves limitation problems by writing the correct 
value in the width field in the file header. This means that WIDEimage 
will work correctly with these formats. 
Whether third party software will work with these files depends on the 
implementation. An example of a program that works correctly with the 
files is CADOverlay ESP version 3.5, although Rlc originally was 
designed to handle a maximum of 32000 pixels. If your software 
cannot handle the wide files correctly, you have the following 
possibilities: 
 
1. Scan at max 800 DPI.  
2. Limit the scan width so the scanner does not produce too many 

pixels.  
3. Have the third party software vendor change 
  the way they read the files.  
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8. Appendix A: About Color Scanning  
Introduction 
A wide format color scanner is designed to accommodate a large 
number of different scanning needs such as black and white scanning 
for CAD applications, classified scanning for GIS applications and 
true-color scanning for large format copying.  
This document describes how to use your color scanner for color 
copying. At first, color copying may sound like a simple task. You just 
scan an original and get a file that - of course - is compatible with you 
printer. Since it is that simple with black and white, one would expect 
the same ease with color copying. Unfortunately the world of colors 
and color reproduction is not so simple, mainly because the scanner 
produces device dependent RGB colors, while printers need device 
dependent CMYK colors. 
In an ideal world this would not be a problem. If printers where able to 
combine Cyan, Magenta and Yellow correctly it would be a simple 
mathematical problem to convert colors from RGB to CMYK. However, 
printers are far from being ideal. printers such as inkjets are highly 
nonlinear and can only reproduce a fraction of the colors that can be 
produced by a scanner and viewed on a monitor. 
During color copying we therefore need to undertake a number of 
additional steps besides scanning and printing in order to ensure high 
quality copy results. These are: 

• Scanner Color Calibration. 
• Raster Image Processing. 
• Color Management. 

 
Scanner Color Calibration 
Included with your Color Scanner is an IT8.7 characterization target. 
The color values for each patch on this target is described in the 
IT8DATA.IT8 file placed in the application’s installation directory. 
Running the wizard for scanner calibration adjusts the electronics in 
the scanner so RGB output from the scanner will match the color 
values from the IT8DATA.IT8 file as closely as possible.  
The colors produced by the scanner after performing color calibration 
are not especially vivid and actually tend to be a bit dark. So why 
should we want to color calibrate the scanner?  Scanner calibration is 
necessary to ensure stability, reproducibility and predictability of color 
output. RIP’ing and color matching mentioned later in this text can take 
care of producing the ‘right’ colors for us. 
And why isn’t scanner output stabile? Over time, parts in the scanner, 
such as the light sources, will change thus this will affect the color 
balance and linearity. So if we do not color calibrate the scanner, the 
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output produced by the scanner half a year from now will differ from 
that produced today. By color calibrating the scanner at regular 
intervals, say once a month, you ensure that all files created are based 
on the same color scheme. Thus, the results you get from the RIP and 
your color management system are predictable, so you don’t have to 
waste time and money experimenting in order to get the right result. 
 
Raster Image Processors 
When talking about RIP’s,  many tend to think of PostScript RIP’s that 
are used to rasterize the fonts and vector graphics in a PostScript file. 
But in order to output, for example, a TIFF file containing RGB data on 
an inkjet printer you will also need a RIP. In this case, the job of the 
RIP is to convert from RGB to Cyan, Magenta, Yellow and blacK dots 
on the output media. 
The RIP does this either by using halftone screening or stochastic 
screening. When using halftone screening, the shade of each color 
Cyan, Magenta, Yellow and blacK is represented by cells, e.g. 8 by 8 
dot’s where a certain percentage of the dots are on, corresponding to 
the intensity of the color. When using stochastic screening, the RIP 
uses randomly placed dots instead of the nicely aligned dots that are 
used in halftone screening . Often stochastic screening produces a 
better looking result on low resolution devices such as inkjet printers.  
Apart from the screening, RIP’s can act as color and ink control 
managers, handle enlargement, rotation, tiling and paneling, 
previewing and a number of other important tasks. 
There are a lot of different color RIP’s on the market today. The 
cheapest solution is just to use the Windows driver that comes with 
your printer. It will do the job, although the result will not be as good as 
that which can be obtained when using a dedicated RIP. To get better 
results, you may choose to use a low price RIP for a few hundred 
dollars (e.g.RenderPrint from Insight). For real professional results you 
will have to spend several thousands dollars on a high-end RIP such 
as PosterJET from DigiColori. 
 
Color Management 
Devices such as scanners, monitors and printers use different 
characteristics in the way they represent colors. Therefore, in order to 
ensure a close match between scanned input and monitor/printer 
output, some standard system is required to convert between the 
colors represented by each device.  
Please note, that we are referring to predictable colors and not 
WYSIWYG colors, the latter being an unobtainable ideal result. This is 
one of the most important concepts in color management: a scanner 
might produce colors that can be seen on an RGB monitor, but cannot 
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be obtained with CMYK printing. So the objective is not to match the 
colors in the original - which is usually impossible - but to provide the 
best possible approximation of these colors, within the limitations of 
the monitor and the ink on paper, and to do so predictably. 
A few years ago the International Color Consortium (ICC), published a 
detailed standard for device color profiles. Standard ICC device 
profiles use the CIE color model to represent the behavior of scanners, 
digital cameras, monitors and printers. The CIE model acts as a 
"universal translator" between, say the RGB color space of a scanner 
and the CMYK space of a printer. It works in conjunction with color 
transformation engines that actually perform such conversions. 
The first implementation of the ICC profiles was ColorSync on the 
Macintosh. The next was the Image Color Matching (ICM) system 
included with Windows 95. Microsoft will support ICM in a future 
release of Windows NT and workstation vendors such as Sun will also 
include support for ICC in their operating systems. 
A lot of add-on color management systems are been available for the 
Macintosh and these systems are now also becoming available for 
PC’s running Windows 95 and NT. The first system for Windows 95 
was FotoTune from AGFA and Kodak Precision CMS from Eastman 
Kodak and but soon the well known ColorBlind color management 
system will also be available both for Windows 95 and NT. 
 
Image Color Matching under Windows 95 
Under Windows 95, Color Management is supported by the ICM API in 
Win32. The operating system gathers information about the devices 
ICC profiles from the .ICM files placed in the 
<Windows95>\system\color directory. Applications written to support 
ICM can use the API calls to make the operating system map colors 
between devices such as monitors and printers. Unfortunately at the 
moment, very few applications support ICM under Windows 95 . A 
growing number of applications are expected to do this within the next 
few years. 
AGFA FotoTune 
Currently, a more practical approach to color management under 
Windows 95 is to use the FotoTune software package from AGFA. 
This color management system, available as a plug-in for Adobe 
PhotoShop for Windows 95 (FotoTune currently does not run under 
Windows NT), contains a dedicated color matching engine that acts as 
a translator between the RGB color space of the scanner, the RGB 
color space of the monitor and the CMYK color space of the printer.  
In order to work properly, FotoTune must have an accurate color 
profile of the scanner, monitor and printer. FotoTune contains profiles 
for most common monitors and printers and a profile for the Color 
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Scanner is placed in the application’s installation directory. To make 
the Color Scanner profile available to FotoTune, copy the file CTX_W4 
from the application’s installation directory to the \fotoflow\ctags 
directory. 
When you have installed FotoTune, two filters are made available in 
PhotoShop: FotoTune/ColorMatcher and FotoTune/SoftProof.  
You can use the SoftProof filter to preview what you get on paper 
through your monitor. You must select the scanner as the Source and 
then select appropriate profiles for your monitor and printer. You can 
then use this filter to get an impression of what your output will look 
like once it is printed. 
Use the ColorMatch filter to process your image in order to get the 
best possible output on your printer. Don’t be put off by the fact that 
the image might look completely wrong on your monitor, it will be all 
right on the paper. 
 
Making Your Own AGFA FotoTune Profile 
To obtain an even better match with your Color Scanner you can use 
FotoTune to make an individual profile for the scanner. To do this, you 
need to run the color calibration from the scanning application’s 
File/Calibrate Scanner… menu. Having done this you should scan the 
IT8 test pattern (delivered with your Color Scanner) on camera 1 as an 
A4 page. Use the View Screen’s crop function in the program to crop 
the image so only the color patches are left without removing any of 
the colors. You have to be very precise. Save the result as a TIFF file, 
for example IT8.TIF. 
Copy the file IT8DATA.IT8 from the application’s installation directory 
to the \fotoflow\crefs directory enable  FotoTune to determine how the 
calibration original looked. 
Start up FotoTune and click “new” below the scanner icon. Specify the 
name of the TIFF file you created (IT8.TIF) and push the Analyze… 
button. If you have been sufficiently accurate in your cropping, 
FotoTune will accept your file meaning you have a color profile for 
exactly your scanner. If the file is not accepted, you will have to go 
back to the program and improve the cropping step. 
 
Color Profiles Installed Together with this Application 
When installed under Windows 95 and Windows NT, the following two 
files are placed in the installation directory: 

CTX_W4.ICM Windows 95 standard ICC color profile 
CTX_W4  AGFA FotoTune color profile 

Under Windows 95 the CTX_W4.ICM file is also installed in the 
<Windows 95>\system\color directory as a standard Windows 95 
device profile. 
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Scanning 
Once you have set up your Color Management and the RIP, there are 
a few things you should keep in mind when scanning.  
First of all you should always scan to RGB color. The color 
management system will not work correctly with index colors. 
Second, you must select a proper file format. The application supports 
scanning to a number of different color file formats: e.g. BMP, JPEG, 
PCX, Sun Raster and TIFF. The two most commonly used formats are 
JPEG and TIFF. JPEG provides excellent compression of about 50 
times when running with the default setting. However JPEG uses a 
lossy compression scheme, i.e. it throws away information in order to 
achieve it’s high compression and low file size. This is often 
unacceptable in connection with high quality copying. TIFF is the most 
widely used format for color scanning. When scanning in color, you 
can either scan uncompressed or use LZW compression. Do not use 
Group 3, Group 4 or Packed Bits, these compression methods only 
work for black and white and will corrupt your data! LZW is a lossless 
compression scheme, so no information is lost when using it. It will 
compress the files around 1.5 to 3 times. It doesn’t sound like much, 
but when you are working with color files of 100Mbytes or so, it could 
make a big difference. The only disadvantage with using LZW is that 
some applications do not support it. 
It is very important that you scan with gamma curve, contrast and 
brightness parameters set to exactly the same values that you used 
when you created your color profile. The default ICC and AGFA 
FotoTune profiles that came with the application were generated using 
default gamma, contrast and brightness values set to 0. When you 
create your own profile it would be best to do the same.  
 

1.IT8.7/3, “Graphic technology—Input data for characterization of 4-color process 
printing”, draft standard of Subcommittee 4 (Color) of ANSI Committee IT8 (Digital 
Data Exchange Standards), 14 December 1992, Paragraph 4.2. 
 
Insight Development Corporation 
2420 Camino Ramon, Suite 205 
San Ramon, CA 94583 
Phone: +510 244 2000 
Fax: +510 244 2020 
Internet: http://www.insightdev.com 
 
DigiColor International Ltd. 
Crown House, The Metro Centre 
Toutley Road, Wokingham, Berkshire, RG41 1QN United Kingdom 
Phone: +44 1189 78178 
Fax: +44 1189 78179 
Internet: http://www.digicolorint.com 
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Agfa Gevaert NV 
GS/EPS FotoTune geb.58/04 
Septestraat 27 
2640 Mortsel 
Belgium 
Fax : +32 3 444 76 77 
Internet: http://www.agfahome.com 
 
EASTMAN KODAK COMPANY 
Color Management Group 
900 Chelmsford Street 
Lowell, MA 01851 
Phone: +1 716 726 7260 
CompuServe: GO KODAK 
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9. Appendix B: Scanning With Thick Media 
Scanning needs are not always limited to convenient paper thin media. 
Many industries, such as reprographics and GIS, will find the need to 
digitize or copy images printed or pasted on thicker media such as 
cardboard, foamboards, gatorboards etc.  
 
Thick media scanning is not as straight forward as normal scanning. 
Certain procedures should be followed in order to compensate for the 
original’s bulkiness and stiffness.  Thick media scanning also sets 
some limitations on certain scanning modes and automatic 
adjustments. This chapter is about the procedures and limitations 
involved when scanning thick originals.    
 
The following guidelines and comments apply to media from 2 mm 
(0.08”) thick, hereafter termed “thick media” throughout this chapter. 
Original’s from 0 mm to 2mm are considered “normal” scanning 
media. The guidelines and instructions apply for scanner model’s 
originally constructed for thick media scanning. 

9.1 Adjust the Insertion Slot 
Normally, the insertion slot on your scanner will be set to take in 
normal scanning media. To carry out thick media scanning, you must 
enlarge the insertion slot space on your scanner and fit it to your thick 
original. See the Operator’s Guide that came with your scanner for 
instructions on making insertion slot adjustments. 

9.2 Scanner Adjustments 
Your scanner needs to keep certain internal factors in line in order to 
function properly. The scanner frequently performs a completely 
automatic adjustment of its light profile and stitching factor but only 
when in the “Normal” thickness position. When you raise the insertion 
area to accommodate thick media, these automatic adjustments are 
turned off and you have to take certain measures to maintain them.  
 
Light profiles – Adjustment of the light profiles must take place 
frequently because even  slight movements of the cameras can affect 
optimal scanning conditions. As stated above, the light profiles are 
only adjusted at the “Normal” (0-2mm) position.  
 
It is therefore important to let the scanner start up at the “Normal” 
position so that the light profiles will adjust themselves before your 
new scanning session.  
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If you are scanning thick media over many hours, then it is strongly 
recommended that you, from time to time,  take down the insertion slot 
adjustment to the “Normal” position in order to trigger a new light 
profile adjustment. The scanning application will give a warning if a 
light profile adjustment hasn’t taken place within the last two hours. 
 
Stitching –  Stitching is the term used to describe the scanner’s ability 
to connect image points between cameras, despite overlapping or 
missing pixels. 
 
Stitching settings are also automatically adjusted in the “Normal” 
position but, unlike light profiles, the stitching settings found at the 
"Normal" position may not be correct for your thick media. Therefore, 
whenever you scan thick media at other positions than “Normal”, you 
have to check the stitching factor and perhaps adjustment it. 
 
Normally, only stiff media will affect stitching while flexible media will 
likely be stitched properly regardless of its thickness. Stiff media will 
“perch” itself on top of the scanner rollers and thus rise a small 
distance over the glass plate which serves as the basis for “Normal” 
stitching settings.  
Stitching adjustments are made in this program’s Scan Menu - 
Scanner Setup dialog. See the relevant section in this manual for more 
details. To modify the stitching factors, you insert your thick original in 
the scanner, and then scan while checking the results in the viewer. 
Look for overlapping or missing pixels in the camera transition areas 
and then adjust the values (for each camera) in the Scanner Setup 
dialog. The stitching parameters are modified by adding offsets to the 
automatic normal settings. Repeat the process until the effect is 
minimized. 
 
The modified stitching parameters will automatically be selected when 
in one of the extended media positions and not in the “Normal 
position”, where the standard automatic stitching setting is always 
used. 
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9.3 Positioning the Scanner 
Don’t place the scanner pressed up close to a wall because a thick 
and stiff original will not bend and fall towards the floor as it passes out 
the other side of the scanner. Make sure you position your scanner so 
that the empty space behind it is at least as long as the original being 
scanned.  
 

9.4 Thick Original - Insertion and Support  
It is recommended to insert thick media using Center Alignment 
which gives a balanced grip from the rollers in the scanner. 
Remember to set the scanner to Center Alignment reading in the 
application’s File Menu – Scan Preferences. 
 
It is also recommended you help support the original with both hands 
during scanning so that it does not tilt and thus distort the image in the 
end result. This should be done both at front as the original enters the 
scanner and from behind as it exits. 
 

9.5 Limitations 
No Prescanning - Prescanning is like scanning, but the scan is 
carried out only in memory.  Prescanning is used when a user wishes 
to evaluate a scan while making such adjustments as color tones, 
threshold etc. In some modes, the scanner performs its own prescans 
in order to make automatic assessments and calculations. 
 
Prescanning is carried out by repeated scans of the original as it 
automatically slides back and forth in a direct path over the cameras. 
Unfortunately, the sheer bulkiness and stiffness of thick media makes 
it likely to swerve slightly in its path over the cameras. This means that 
the mechanical “sliding” cannot be performed with enough accuracy to 
enable reliable prescanning. 
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Below is a list of the scanning tools and modes that require 
prescanning and therefore cannot be performed with thick media : 
 
• Index Color scanning mode 
• Histogram Auto in B/W threshold mode 
• Histogram Manual in B/W threshold mode 
• Apply buttons in the mode adjustment dialogs 
• Black and White point Setup 
• Automatic Alignment 
• Scanwindow – Scan an isolated image portion 
 
Speed -  In the thick media positions, scanning speed is automatically 
reduced in order to ensure smooth movement despite the media’s low 
grade of flexibility. The “Normal” position gives the highest scanning 
speeds.  
 
Edge Distortion - Scanning of thick originals can create distortions in 
the end result when the original’s front edge meets the exit rollers or 
when the trailing edge leaves the entry rollers. To omit this problem, 
the leading and trailing edges are by default skipped when in one of 
the extended media thickness positions, i.e., insertion slot positions 
other than “Normal”. Skipping of the leading/trailing edges can be 
turned OFF/ON through the scanning application’s Scanner Setup 
dialog – Extended Thickness – Use extending thickness paper 
handling. 
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10. Appendix C: Program License Agreement 
You should carefully read the following terms and conditions before opening the CD-
ROM package. Opening the CD-ROM package indicates your acceptance of the terms 
and conditions. If you do not agree with them, you should promptly return the package 
unopened and your money will be refunded. 
Contex provides this program and licenses its use. You assume responsibility for the 
selection of the program to achieve your intended results, and for the installation, use, 
and results obtained from the program. 
 
LICENSE 
1. You may use the program on a single machine. 
2. You may modify the program and/or merge it into another program for your use on 
the single machine. 
3. You may copy the program into any machine-readable or printed form for backup or 
modification purposes in support of your use of the program on the single machine. 
4. You may not use, copy, modify, or transfer the program, or any copy, modification, or 
merged portion, in whole or in part, to another party, except as expressly provided for in 
this license. If you do so, you terminate your license. 
 
TERM 
The license is effective until terminated. You may terminate it at any time by destroying 
the program together with all copies. The license will also terminate upon conditions set 
forth elsewhere in this Agreement or if you fail to comply with any term or condition of 
the Agreement. You agree upon such termination to destroy the program together with 
all copies, modifications, and merged portions in any form. 
 
LIMITED WARRANTY 
This program is provided as is without warranty of any kind, either stated or implied, 
including but not limited to the implied warranties of merchantability and fitness for a 
particular purpose. The entire risk as to the quality and performance of the program is 
with you. Should the program or hardware provided with the program prove defective, 
you (and not Contex or an authorized dealer) assume the entire cost of all necessary 
servicing, repair, or correction. 
Some states do not allow the exclusion of implied warranties, so the above exclusion 
may not apply to you. This warranty gives you specific legal rights; you may also have 
other rights which vary from state to state. Contex does not warrant that the functions 
or the operation of the program will be uninterrupted or error-free. 
However, Contex warrants the CD-ROM on which the program is furnished to be free 
from defects in materials and workmanship under normal use for a period of one (1) 
year from the date of delivery to you, as evidenced by a copy of your receipt. 
 
LIMITATIONS OF REMEDIES 
Contex's entire liability and your exclusive remedy shall be: 
1. The replacement of any CD-ROM not meeting the Contex "Limited Warranty" and 
which is returned to Contex or an authorized Contex dealer with a copy of your receipt, 
or 
2. If Contex or the dealer is unable to deliver a replacement CD-ROM which is free of 
defects in materials or workmanship, you may terminate this Agreement by returning 
the program and your money will be refunded. 
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In no event will Contex be liable to you for any damages including any lost profits, lost 
savings, or other incidental or consequential damages arising out of the use or inability 
to use such program, even if Contex or an authorized Contex dealer has been advised 
of the possiblity of such damages, or for any claim by any other party. Some states do 
not allow the limitation or exclusion of liability for incidental or consequential damages, 
so the above limitation or exclusion may not apply to you. 
 
GENERAL 
You may not sublicense, assign or transfer the license of the program except as 
expressly provided in this Agreement. Any attempt otherwise to sublicense, assign, or 
transfer any of the rights, duties, or obligations hereunder is void. 
This Agreement will be governed by the laws of Denmark. Should you have any 
questions concerning this Agreement, you may contact Contex. 
You acknowledge that you have read this Agreement, understand it, and agree to be 
bound by its terms and conditions. You further agree that it is the complete and 
exclusive statement of the Agreement, oral or written, and any other communications 
between us relating to the subject matter of this Agreement. 
 
 
 
CONTEX A/S 
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11. Appendix D: Glossary 
 
Acquire:  A command in some programs that starts the HP

PhotoSmart PhotoCapture software, to scan a picture
directly into a program.  

Activate:  To activate an open window, click anywhere on it or
choose its name from the Window menu. To activate 
a window that is not open, open the window.  

Active Window:  The window currently in use or currently selected. If a
window is active, its title bar changes color to
differentiate it from other windows. Only one window
can be active at a time; the other windows are
inactive.  

AdaptiveThresholding 

 

Advanced 2-D Adaptive Thresholding estimates the
background gray level in a window area around each
pixel. The difference between the actual pixel value
and the background is then compared to the adaptive 
settings to determine if a pixel is thresholded as a
black or a white pixel 

Additive Colors: The additive primary colors are red, green and blue. 
These additive primaries represent the three main 
components of white light. Used individually or 
together, these three colors of light can be mixed to 
create nearly all colors. When these three primary 
colors are mixed in equal parts they produce white. 
Additive color is used in scanners and computer 
displays. 

ADL+ Error Diffusion 
Halftoning 

Image Processing that supports visibility of graytones 
in printed output by adding toned shades of gray in 
regions between black and white. Carried out as a 
segment of Dual 2D-Adaptive enhancement  
processing in copy modes. 

Automatic Exposure:  A feature of the HP PhotoSmart PhotoCapture
software that automatically sets brightness and
contrast levels to optimize the quality of the final
scanned picture.  

Bit:  The basic unit of digital information stored in a
computer.  

Bitmap:  A type of computer image made from a matrix of 
individual pixels. .bmp.  

Bitmapped Image:  A bitmapped image is a computer file representing a 
line-art image that was scanned with a scanner. 
Refers to the pattern (map) of bits that are either black 
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or white.  

 

Black Level: The Black Level is a setting in scan programs used to
change dark graytone colors to true black. For
example, if one is copying a brochure with a mixture of
text and pictures, the text will often be digitized to a
color that we may see as black but really is a dark 
graytone. When the printer digests this graytone data,
it will print the original’s text with a halftone pattern,
meaning scattered dots instead of solid black. By
increasing the Black Level value, one can get the text 
to be copied in real black and it will therefore appear 
clearer. 

Black Point Adjustment: An adjustment made that will determine the amount of 
shadow detail in an image. It is considered proper to 
set the black point so that the darkest part of an image 
will only just have zero detail.  

Blueprint: A process of photographic printing used mainly for 
copying architectural and mechanical drawings;  
produces blue lines on a white/bluish background. 

Blur: The averaging of pixel elements. 

Brightness Adjustment: An adjustment on a scanner that allows the user to 
compensate for a light or dark original. 

Byte:  A unit of digital information made up of a string of 8
bits.  

Calibration:  Adjusting a device so that it performs in accordance
with an established standard.  

Scanner calibration is minimizing color deviation 
between scanned ANSI IT8 reference color patches
and the known color reference values. Generally,
Calibration is the process of setting a device to known
color conditions – stabilizing the device to a known
and quantifiable state.  

Calibration is commonly done with devices that
change color frequently, such as monitors (phosphors
lose brightness over time), scanners (light changes)
and printers (proofers and other digital printing devices
can change output when colorant or paper stock is 
changed).  

CALS: Computer-aided Acquisition and Logistics Support 
(CALS) standard, a U.S. Defense Department and 
industry initiative that addresses the design, 
manufacture, and support issues of generation, 
access, management, and use of technical data in 
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digital form. 

 

CCD: Charge Coupled Device, CCD is the image sensor in 
the scanner that converts light to voltages. These 
voltages are converted by the scanner into the image.

CCITT Group3: Standard runlength compression format used with 
FAX transmission. It utilizes modified Huffman coding 
to further compress the runlength numbers. Most 
scanner file formats are dialects of this format. 

CCITT Group4: Two-dimensional compression format, giving very 
compact image files. Standardized by CALS (MIL 
28002) and ISO-ODA for Drawing Archival and 
Interchange. 

Check Box:  Check boxes turn a feature on or off. The feature is on
when the box contains an "X." or "(." Click the box to
check or uncheck it as required.  

Choose:  Select an item from a menu. Click the main menu item
and then click the item in the drop-down menu; or, 
click the menu item, drag to the drop-down menu 
item, and release the mouse button.  

CIE LAB: A device-independent color space specified by CIE, 
used in modern color management software to 
facilitate conversion of data from a scanner to a 
display, or from a display to an output device.  

CIE: Centre Internationale d’Eclairage (CIE) is an 
international organization that establishes methods for 
measuring color. These color standards for 
colormetric measurements are internationally 
accepted specifications that define color values 
mathematically. The first color space model, the CIE 
xyz, was developed in 1931. CIE defines color as a 
combination of three axes: x, y,and z. The two color 
spaces released in 1978 are CIE Lab and CIE Luv. 
The goal was to provide an accurate and uniform 
reference of visual perception.  

Click:  Position the mouse cursor on top of an object and
press and release the left mouse button once.  

Clipboard:  A temporary storage place used for copying and
pasting pictures between programs.  

CMYK: The subtractive printing colors. Cyan, Magenta, 
Yellow, Black. 
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Color Balance:  The visual effect of an image when the amount of
each color and the overall amount of color are 
balanced.  

Color bit depth: The simplest pixel has two options: black or white. (A 
pixel with two choices is known as a 1-bit image, or 
two raised to the power of one). Adding more bit 
information increases the number of color options. 
The number of potential color options for a pixel is 
called color bit depth. For example a 4-bit pixel would 
have 16 color options, and an 8-bit pixel would have 
256 color options, while a 24-bit pixel would have 
16,777,216 color options. 

Color Cast: An image is said to have a color cast if its colors are 
not true. A color cast will usually be described by 
stating the particular color predominant in the image, 
e.g., the grass appears to have a red color cast. 

Color Correction:  To improve the color rendition. Correcting for, and 
eliminating an unwanted color cast. 

Color Management System:  Color Management System (CMS) software increases 
the accuracy of color interchange between scanners, 
displays and printers based on profiles for each 
device. The CMS is a layer of software resident on the 
computer that negotiates color reproduction between 
the application and color devices. The CMS performs 
the color transformations necessary to exchange 
accurate color  between diverse devices. The Color 
manager needs access to characterization data for the 
device. The format and content of such device profiles 
is standardized by the International Color Consortium 
(ICC.) 

Color Separation:  Process of separating colors, in an image, into primary
color components for printing. Converting an RGB 
color image into CMYK color image. Color separation
is a technical function during which critical settings
such as GCR, black ink limit and total ink limit are
applied to the image. 

Color Space: A color space is a particular language used to 
describe color. Examples of color spaces are: RGB, 
CMYK, HSV, CIE LAB.  

Color: Electromagnetic energy that exists in the form of 
wavelengths creates the perception of color. There is 
a huge difference between the visible spectrum we 
can see with our eyes and the colors which can be 
reproduced on a computer screen and then printed on 
a color printer. The total number of colors that a 
device can produce is called its color gamut. The 
visible spectrum is larger than the color gamut of a 
color monitor, which in turn is larger than that which 
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can be reproduced by a color printer. No system can 
produce all the colors visible to the human eye. 

Contrast:  The difference between the lightest and darkest
significant areas in a picture. A picture with high 
contrast has nearly white areas and nearly black areas
with sharp changes in brightness between them. The
picture seems dominated by stark light and dark
tones.  

Copy:  To duplicate an image and place it on the clipboard.  

Crop Box:  A box drawn in the picture when the Size tools are
visible. It shows the area that will be scanned when
saving or printing the picture.  

Crop:  To select the part of the picture desired. Only the part
of the picture inside the crop box is saved or printed.  

Density units: Photographers and printers measure transmission in 
base-10 logarithmic density units, where transmission 
of unity corresponds to a density of 0, transmission of 
0.1 corresponds to a density of 1, transmission of 0.01 
corresponds to a density of 2, and so on 

Density: The light stopping ability of a film. Density is inversely 
proportional to the amount of light reflected or 
transmitted by an image. 

Destination:  The program or device where the scanned picture will
be printed or used. This information lets the software 
produce the highest-quality picture based on the 
characteristics of the selected device.  

Device Dependent Color 
Space: 

For example RGB. A device dependent color space, 
e.g., the same scan file will appear different when 
viewed on different computer displays.  

Device Independent Color 
Space: 

For example CIE LAB. A device independent color 
space is one in which color values are absolute, e.g., 
defined by CIE standard. CIE LAB is the central color 
space in color management systems (CMS) and is 
used to translate between different device dependent 
color spaces such as scanner RGB and display RGB.

  

Device Profile: A file used as part of a Color Management System 
(CMS). A device profile contains information about the 
characteristics of a scanner, computer display or 
printer. The format for device profiles (Win95, 
Colorsync. etc.) is standardized by ICC (International 
Color Consortium). 
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Dialog Box:  A window that appears to request or supply
information. Many dialog boxes have options which
must be selected before the program can carry out a
command.  

DIP Digital Image Processor. Hardware embedded
function that does image enhancement in real-time 
while scanning. 

Dither:  To use patterns of different colored pixels to create
blended colors; or, to use dots of different sizes to 
simulate grayscale images. (see below) 

Dithering: A printing or display device may have only a small 
number of  grayscale or color values for each device 
pixel. However, if the viewer is sufficiently distant from 
the printed page or display, the value of neighboring 
pixels can be set so that the viewer's eye integrates 
several pixels to achieve an apparent improvement in 
the number of levels or colors that can be reproduced.

Dots Per Inch (dpi):  A measure of dots in a square inch where the 
individual element is a round dot on the printed page. 

Double-click:  Position the mouse cursor on top of an item and press
and release the left mouse button twice, in quick
succession. If the clicks occur within the time set in
the MS Windows Control Panel, it interprets the two
clicks as a single gesture.  

DPI: Dots Per Inch, equivalent to Pixels Per Inch. An 
expression of resolution of a scanned image. 

Drag:  Press the left mouse button and move the mouse
while keeping the button pressed. When the desired 
action is completed, release the mouse button. Drag
refers to an action sequence (mouse down, mouse
move, mouse up), such as "Drag the button in the
scroll bar. . ."  

DSP: Digital Signal Processor, does image enhancement in 
real-time while scanning. 

Dual 2D-Adaptive 
Enhancement 

Enhancement processing on the foreground and 
background separately. Processing is performed on-
the-fly. The separate enhancement processes are 
simultaneously performed on different drawing 
aspects.  

Dynamic Range:  A measurement of scanner quality; the density 
difference between highlights and shadows. 
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Edit:  Modify an entry using standard Windows text-editing 
techniques.  

Emulsion:  The light sensitive silver, coated on the clear acetate
film base, that forms the photograph when a picture is
taken and the film is developed.  

Equalizing: Distributing all color or tone equally along a density 
range. 

Export:  To send a copy of the picture to a file.  

Exposure:  The overall lightness or darkness of a picture. 
Exposure is determined automatically when the film or
photograph is pulled into the HP PhotoSmart photo
scanner, but can be manually adjusted before saving
the picture.  

File Format:  The format in which a scanned picture is saved. Many
programs can insert or import a picture from a file, if it
is saved in a file format that the program supports.
Common file formats include TIFF (Tagged Image File
Format), BMP (Windows bitmap), JPEG (Joint
Photograph Expert Group), and FPX (FlashPix
format).  

Flip Horizontal:  To flip the picture left/right.  

Foreground: Foreground when scanning raster data (black and 
white, or monochrome data) refers to the pixels that 
represent data of interest (background refers to 
everything else). Typically, lines and shapes are 
represented by black pixels (foreground) and empty 
space is represented by white pixels (background). 
When scanning grayscale data, background means 
the gray level of a region of pixels that surrounds 
some desired foreground data. 

Gamma Adjustment: An adjustment that makes the tone distribution lighter 
or darker in an image. 

Gamut Transformation: Color Management System function, where out-of-
gamut colors are converted to colors within the gamut 
of the targeted device, e.g., a printer. 

Gamut: The color range scanable, printable or displayable by 
a device; e.g., if some of the displayable colors are 
outside of the gamut of the printer they cannot be 
printed. 

GCR: Gray component replacement. A color separation 
setting used on color photographs where cyan, 
magenta and yellow inks are replaced by black ink (in 
a balance that would yield a gray value). The 
advantages are a reduction in overall ink usage and 
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some increase in image detail.  

Grayscale: A term for a black and white photographic image or a 
scanner setting. Refers to the range of 256 gray tones 
that make up the image.  

Halftoning: The processes of offset printing and laser printing are 
intrinsically bilevel. However, these devices can 
reproduce a range of tone levels by halftoning; e.g., an 
array of widely spaced dots produces the perception 
of light gray, and an array of tightly spaced dots 
produces dark gray. Halftone dots are usually placed 
in a regular grid. In color printing it is conventional to 
use cyan, magenta, yellow and black grids that have 
exactly the same dot pitch but different carefully-
chosen screen angles.  

Highlights:  The lightest part of a picture--reproduced as white on 
the screen or when printed.  

Histogram: A bar graph representing the statistical distribution of 
Graytones or colors in an image. Each column 
represents the number of pixels at that gray level or 
color. 

HLS: A color space with the three variables of Hue, 
Lightness, Saturation. See HSV.  

HSV: A color space with the three variables of Hue, 
Saturation, Value. Hue means color (as in the color 
wheel.) Saturation is an indication relating to the 
richness or vibrancy of the color. Value is a term best 
related to the intensity of light illuminating the object. 

Hue:  A named color. In discussions of color that relate to
photography, scanning, and printing, six hues are
especially important: red, yellow, green, cyan, blue,
and magenta. These hues make up every color we
can see, and are the designated hues on color
wheels.  

Hue: A measurement of color that can be related by 
pointing towards a certain color on the color wheel. 
Hue indicates the relative redness, blueness, 
greenness, yellowness, etc., of a color.  

ICC: The International Color Consortium (ICC) was formed 
to address the need for a common color framework. 
The ICC has developed a standard device profile that 
contains information about how various devices render 
color. This concept is supported by Apple (Colorsync), 
Microsoft for Windows 95, Sun for Solaris, and by 
Silicon Graphics for Irix. 
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Image Editor:  A program used to edit pictures to change colors,
increase detail, scale or otherwise alter the picture.  

Import:  A command in many computer programs, that brings
a scanned picture which has been saved to a file, into
a document.  

Indexed color: Indexed color (or pseudo-color) is the provision of a 
relatively small number, say 256, of discrete colors in 
a colormap or palette. For each pixel in the image, the 
index number of a color is then stored. When 
retrieving  the image, a lookup table uses the index to 
retrieve red, green and blue components that are then 
sent to the display. In graphic file formats such as 
PCX of TIFF, an indexed color image is accompanied 
by its colormap. 

Interpolation: Using the interpolation method of resampling 
generates values for points in between the actual 
pixels by looking at the surrounding colors or 
intensities. In a scanner resolution is increased 
beyond the actual number of CCD cells. As each line 
of pixel data arrives from the cameras, new 
interpolated pixels are added between original pixels. 
The added pixels enhance line edge definition. 

JPEG Compression:  Joint Photographic Experts Group Compression. A 
method to save storage space by compressing files. 
JPEG achieves a high degree of compression by 
discarding non-important picture detail. 

JPEG:  A compressed file format for images. Named after the
Joint Photographic Expert Group, JPEG images
feature small file size and speed, but lower quality
than other formats.  

Landscape Photograph:  A photograph in which width is greater than height 
when properly oriented. A photo in which the height is
greatest is called a portrait photograph.  

Lossless Compression: File compression and subsequent de-compression 
without any loss of data.  

Lossy Compression: File compression that will compress data to a high 
degree. When subsequently un-compressed, data will 
have been lost.  

LZW: Method of lossless compression used with many file 
formats; developed by Lempel, Zev and Welch. 
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Midtones:  The most important part of a picture between black 
(shadows) and white (highlights).  

Negative:  A reversed photographic image used to produce a
positive print or a scanned image.  

Noise: A term used to describe the occurrence of pixels that 
contain random colors within an image. 

Original:  The paper, negative, slide, or film to be scanned.  

Palette: The set of colors available for an image. 

Paste:  To insert a copy, to the clipboard, of whatever was last
cut or copied.  

PICT:  A file format for pictures used primarily on the
Macintosh.  

Pixels Per Inch (ppi):  A measurement of resolution for scanners, where the
individual element is a square picture element (pixel). 

Pixels: The word pixel is a combination of the two words 
picture and element. It is the smallest building block 
within a scanned line-art or photographic image. A 
pixel is the small square picture element that is filled 
with a color, black or white. The value of a pixel 
depends on the luminance of the area, and is either a 
single bit for a black and white image, or multi-bit for a 
color or gray-tone image. Pixels come in various sizes 
and their size is expressed in terms of resolution. 
Resolution is measured in pixels per inch (ppi) or the 
equivalent dots per inch (DPI.) 

Portrait Photograph:  A photograph in which height is greater than width 
when it is properly oriented. A photo in which the width
is greatest is called a landscape photograph.  

PostScript:  A computer language developed by Adobe (R)
Systems, Inc. for printing text, graphics, and scanned
images. PostScript (R) is a vector format that can 
include scanned bitmapped images.  

 

Raster File: Also called Raster Image or Bitmapped Image. A 
picture composed of individual dots (picture elements, 
pixels) the way a scanner perceives it. The rows in a 
high-resolution raster file typically contain 200 or 300 
dots per horizontal inch of the original drawing, and 
there are typically 200 or 300 rows per vertical inch. 
As each of these dots is defined by location, and by 
whether it is on or off, raster images generally result in 
large data files. 
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Resolution of a Scanner: Expressed as DPI (dots per inch) or the equivalent ppi 
(pixels per inch). The higher the resolution of a 
scanner, the smoother the scanned images. 

Resolution:  A measure of how many pixels per inch are scanned.
Generally, more pixels per inch means more detail in
the picture and a larger file when saved. Defines the
level of detail that can be captured or shown by a
scanner, display, or output device. For scanners, the
resolution is defined by the number of dots (pixels) per 
inch (DPI) that can be captured horizontally and
vertically, e.g. 300 DPI equals 90,000 pixels per
square inch. Screen Resolutions are normally 72
pixels per inch of screen. Additional detail is thrown
away by the screen display driver, anyway. For Printer 
Resolution scans, you need 150 dots per inch and
above for good results on the printed output. One
must find the level of detail that is still visible in printed
output on the printer in question, and not dramatically
increase the size of a saved file without bettering the 
result.  

RGB: Red, Green, Blue. These additive primary colors are 
the basic elements of white light. By mixing them on a 
computer monitor or in a scanned image file, other 
colors can be created. For instance, Red and Green 
produces Yellow, and equal amounts of all three 
produce gray. 

RIP: Raster Image Processor. A RIP is a special software 
that converts scanned images into a color dithered 
(halftone) image that can be output directly. An image 
must be 'ripped’ before it can be output on a CMYK 
device, e.g., an inkjet printer. 

Rotate:  To turn the picture left (clockwise) or right
(counterclockwise) from the orientation in which it was
scanned.  

 

Runlength Encoding: A method of compressing raster or bitmap data by 
representing "runs" of white or black dots along a 
scanned line as the number of dots in each run. Many 
variations of this scheme exist, with varying 
compression efficiency. Typically, runlength 
compression formats yield a file 20-25% the size of an 
uncompressed file. 

Saturation:  The level of colorfulness of the picture. A picture with
high saturation has vivid color. A black and white
picture has zero saturation. The purity of a color or the
degree to which it is diluted with white light. Red is a
highly saturated color. Pink is a diluted red (has lower 
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saturation).  

Saturation: Saturation is one attribute of color in the color space 
called HSV (Hue Saturation, Value). Saturation is a 
characteristic indicating the vibrancy or intensity of a 
hue. A color with high saturation will appear more 
intense than the same color with less.  

Scale:  To reduce or enlarge the size of a picture
proportionally.  

Scanner Calibration:  A program that helps adjust the scanner to achieve
stable colors or Black and white and work with a
printer. Calibration gives better scanning results. The
program should be run whenever changing printing
equipment, toner, and inks, and whenever getting poor
results when printing pictures.  

Screen Calibration:  

 

A program that helps adjust the computer screen to 
get the best display of scanned pictures and
documents. This program is run during installation and
should be used again any time that the computer
screen or the lighting around the computer is
changed.  

Scroll:  Move through a list or window by dragging the scroll 
bar button to the desired position, clicking the scroll
arrows, or using the up-arrow and down-arrow on the 
keyboard. Clicking the scroll bar itself moves the
window or list faster than clicking the scroll arrows.  

SCSI (Small Computer 
System Interface):  

An interface that allows hard disks and other high-
performance peripherals to be attached to Macintosh
and PC computer systems.  

SCSI Card:  The printed circuit card that came with the scanner.
With its driver software, the card allows the computer 
to talk to the scanner. The card is ASPI compatible
with a SCSI-II output connector.  

SCSI: Small Computer System Interface. Specification of 
interface to computer equipment like disks, printers, 
scanners etc. 

Select Source:  The command in some programs that allows choice of
where the Acquire command will get its picture.  

Shadow Detail: The amount of detail contained in the dark parts of an 
image. It is desirable to maintain shadow detail, but 
there is a risk of decreasing overall contrast if one 
lightens the shadow too much in an attempt to expose 
additional detail. If an image is scanned without 
shadow detail, it will be impossible to regain detail 
using an image editing program.  
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Shadow:  The darkest part of a picture; reproduced as black 
onscreen or when printed.  

Sharpness: An attribute of a scanned image and also an attribute 
of scanner quality. 

Source:  When using either the Insert Object (OLE) or Acquire
(TWAIN) commands to scan a picture into a program,
such as a word processor, the source is the program 
where the picture is acquired or retrieved. The
scanner software is the source that controls the HP
PhotoSmart photo scanner.  

SRGB: Hewlett-Packard and Microsoft proposed the addition
of support for a standard color space, sRGB, within 
the Microsoft operating systems, HP products, the
Internet, and all other interested vendors. The aim of
this color space is to complement the current color
management strategies by enabling a third method of
handling color in the operating systems, device drivers 
and the Internet that utilizes a simple and robust
device independent color definition. This is to provide
good quality and backward compatibility with minimum
transmission and system overhead. Based on a
calibrated colorimetric RGB color space well suited to 
Cathode Ray Tube (CRT) monitors, television,
scanners, digital cameras, and printing systems, such
a space can be supported with minimum cost to
software and hardware vendors.  

Stitching: In large format multiple CCD camera scanners,
electronic stitching adjusts for overlap in the field of
view of adjacent cameras. Automatic stitching at start
of scan ensures that each camera captures the
correct number of pixels independently of mechanical
and thermal changes. 

Subtractive Colors: The subtractive primary colors: cyan, magenta, yellow. 
As ink applied to a piece of paper by a printer, these 
colors absorb light and alter the colors seen by looking 
at the printed paper. Cyan ink absorbs the red third of 
the spectrum, magenta ink absorbs the green third, 
and yellow ink absorbs the blue third. This should 
theoretically cause the viewer to see a black color, but 
due to unavoidable impurities in the inks, there is still 
light reflected and the viewer sees a muddy brown. 
The absence of CMY pigments results in white. 

 

Thumbnail:  A very small, low resolution version of a picture that
shows just enough detail to tell which picture it
represents. In the HP PhotoSmart PhotoCapture
software, the thumbnails allow resetting of any
changes made to the picture and, for negatives, allow 
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picking which negative will appear in the preview area. 

TIFF:  Tagged Image File Format. One of the most common 
graphic file formats for line-art and photographic 
images.  

 

Tonal Distribution: Tonal Distribution describes the distribution of various 
bright or dark tones within an image. During the 
scanning or image editing stage, tones can be 
redistributed, lightening a dark image or darkening a 
light one. 

Tone Compression: A term used in scanning and image editing that refers 
to compressing the broad range of tones and colors in 
an image down to the narrower range available on a 
printer.  

Tone Curves: The shape of the tone transfer curves can be adjusted 
by the user to alter color or tone correction. The lower 
left end of the curve typically represents the dark 
portions of a picture and an upward bend will typically 
lighten the shadows. Similar capabilities exist by 
working with the middle or highlight parts of the curve. 
In this way it is possible to alter only certain tonal 
ranges of an image without making un-wanted 
changes to other parts of the image.  

Tone: Any color or neutral that is denser than white. 

True color: True color systems provide eight bits for each of the 
three components (red, green and blue). Therefore 
true color is often referred to as 24-bit color. 

 

TWAIN:  A standard method of communications that programs
can use to send instructions to hardware (such as
scanners) and receive data back from them (such as
pictures).  

UCR: Under Color Removal. A color separation setting used 
on color photographs where cyan, magenta and yellow 
inks are removed from dark, neutral areas and 
substituted by black ink. The advantages are a 
reduction in overall ink usage. See also GCR.  

Vector Drawing: Also called Vector File. Consists of mathematically 
defined elements, such as "Line from A to B", "Circle 
with center and radius", etc. CAD systems use vector 
drawings because of their accuracy, relatively low 
memory requirement and data-file sizes compared to 
raster images. 
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Vector File: Also called Vector Drawing. Consists of 
mathematically defined elements such as: Line from A 
to B, Circle  with center and radius etc. CAD systems 
use vector drawings because of their accuracy and 
relatively low memory and data file sizes compared to 
raster images. 

Vectorization: Also called raster-to-vector conversion (RTV). The 
process of automatically converting a raster (bit-
mapped) image into a vector (CAD) drawing. 

Video Card: Expansion card installed inside the computer. 
Different types of video cards support varying monitor 
sizes and number of displayable colors. 

White Level:  White Level is a setting in scan programs used if one 
has an original with a background that is not 
completely white. To get the background to appear as 
pure white one can set the White Level to a lower 
value.  

White Point Adjustment: An adjustment made that will determine the amount of 
highlight detail in an image. The white point should be 
set so that the lightest part of an image will only just 
have zero detail 

WYSIWYG -  What You See Is What You Get. Pronounced
"wizzywig." Screen output that exactly (or very closely)
matches the appearance of printed output. 

XYZ: The CIE system is based on the description of color 
as a brightness (luminance) component Y (as 
described above), and two additional components X 
and Z. The spectral weighting curves of X and Z have 
been standardized by the CIE, based on statistics 
from experiments involving human observers. XYZ tri-
stimulus values can describe any color. 

Zoom:  The ability to enlarge or shrink the view of the picture
in a window. Zoom does not alter the size of the final
scanned picture; it only provides a better view while
creating a selection border on the screen.  
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12. Index 

A 

Active image…………………. 3-2 
Adaptive Map ...................... 4-12 
Adaptive Photo .................... 4-12 
Adjustments tab............ 4-9, 4-27 
Align (in the viewer)............... 5-8 
Alignment detection............. 3-23 
Aperture Card insertion ....... 4-48 
Aperture Card setup ............ 4-48 
Apply edit (LUT) .................. 6-29 
Atl file format ......................... 7-7 
Auto file naming................... 4-50 
Auto Paper size detection ... 4-16 

B 

back-ups during scanning ... 3-21 
Backward............................. 4-20 
Batch convert files ............... 3-17 
Batch print ........................... 3-16 
Batch scan 

Setting options................. 4-49 
Batch scanning 

Preferences ..................... 3-22 
Black and White Point ......... 4-24 
Blur filter setting..................... 4-5 
Bmp....................................... 7-1 
Bmp file format ............... 7-5, 7-6 
Brightness ........................... 4-33 
Brightness setting.................. 4-5 
BW Photo F+S .................... 4-11 

C 

CalComp format ............. See Crf 
Calibrate scanner ................ 4-51 
calibrate the scanner........... 4-52 
CALS................................... 11-3 

Orientation setup ............... 7-7 
Cals file format ...................... 7-7 
Camera Stitching................. 4-46 
card copy generation........... 4-48 
CitIN file format...................... 7-4 
Classified............................. 4-12 
Close 

from File menu .................. 3-9 

 
 
 
 
 
Close LUT ........................... 6-33 
Color feature extraction ......... 6-1 
Color file formats ................... 7-5 

Conversion ........................ 7-6 
Selecting before scanning . 7-6 

Color info field (setting of) ... 3-20 
Color wheel view ................. 6-10 
Color Wheel view .................. 6-2 
Con file format ....................... 7-7 
Contrast............................... 4-33 
Contrast setting ..................... 4-5 
Counting image colors......... 5-17 
Create LUT.......................... 6-30 
Create LUT options ............. 6-30 

Image independent.......... 6-31 
Load predefined colors.... 6-30 
Maps,CADplots................ 6-31 
Photo,artwork .................. 6-31 

Crf file format......................... 7-7 
Crop....................................... 5-6 
Cursor.................................... 5-5 
Cut file format ............... 7-4, 7-12 

D 

Default scan file (set)........... 3-21 
Demo mode........................... 2-1 
Despeckle (in the viewer) ...... 5-8 
Despeckle setting.................. 4-5 
Despeckling................ 4-29, 4-31 
Display during scanning ...... 3-21 
dpi........................................ 4-12 

E 

Eject Original ....................... 4-42 
Encapsulated Postscript format

..................................See Eps 
Eps file format ....................... 7-3 
Exit (leaving CADImageScan)3-24 
Extended Thickness Settings4-46 
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F 

Feature menu...................... 6-30 
Feature screen 

Status bar ........................ 6-15 
File formats............................ 7-1 

Color.................................. 7-5 
General image................... 7-1 
Graytone............................ 7-4 
Limitations ....................... 7-12 
Plot,Print............................ 7-7 

File menu............................... 3-8 
Forward ............................... 4-20 

G 

Gamma Curve Edit .............. 4-35 
Gamma curve, apply ........... 4-34 
Gr4AB file format................... 7-3 
Gra file format........................ 7-7 
Graytone file formats ............. 7-4 

Conversion ........................ 7-5 
Selecting before scanning . 7-5 

Gtx file formats ...................... 7-3 

H 

Halt ...................................... 4-20 
Halt mode............................ 4-20 
Histogram 

Analysis ........................... 4-36 
Auto ................................. 4-28 
LUT - Sorting ................... 6-35 
LUT (in feature screen) ..6-2, 6-

13 
Manual............................. 4-28 

Hitachi file format............ See Hrf 
Holefilling.............4-5, 4-29, 4-31 
Hollerith card batch scan..... 4-48 
Hollerith paper size detection4-17 
Hrf file format......................... 7-3 
HSV 

in feature extraction......... 6-15 

I 

Ig4 file format......................... 7-3 
Igs file format......................... 7-5 
Image manipulation... See Viewer 

tools 
Image menu ........................ 5-10 

Image functions ................. 5-1 
ImgCC file format ......... 7-4, 7-12 
ImgCM file format ......... 7-4, 7-12 
ImgGEM file format ...... 7-4, 7-12 
Import colors (LUT) ............. 6-33 
Insert new color (LUT)......... 6-27 
Installation 

on WINDOWS................... 2-3 
Scanner ............................. 2-2 

Intergraph file format ............. 7-4 
Invert (in the viewer) .............. 5-8 

J 

Jdl file format ......................... 7-7 
Jpeg file format......7-5, 7-6, 7-12 

Compression ................... 7-11 
Quality option .................. 7-12 
Smoothing ....................... 7-12 

L 

Limitations (file formats) ...... 7-12 
Linear .................................. 4-12 
Load LUT............................. 6-33 
Log Format .......................... 3-22 
Logarithmic scale ................ 4-24 
Lossy algorithm .....7-5, 7-6, 7-11 
Ltx file format......................... 7-7 
Luminance........................... 4-25 
LUT edit 

Create initial LUT............. 6-30 
Mark,unmark colors......... 6-17 
Selection of views.............. 6-6 
Setting options........ 6-30, 6-35 
Status bar ........................ 6-15 

LUT edit tools 
Apply edit......................... 6-29 
Assistance tools .............. 6-16 
Color Wheel .................... 6-10 
Commit,regret functions .. 6-17 
Editing functions .............. 6-16 
Explode color................... 6-22 
LUT histogram view......... 6-13 
Main view........................... 6-7 
Merge similar................... 6-21 
Pick color......................... 6-16 
Protect color ........... 6-16, 6-18 
Remove minor color ........ 6-26 
RGB,LUT viewing .............. 6-9 
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Undo edit ......................... 6-29 
Viewboards........................ 6-7 

LUT filter................................ 6-1 
LUT filter - creating a............. 6-3 
LUT options 

Close LUT ....................... 6-33 
Create LUT...................... 6-30 
Histogram sorting ............ 6-35 
Import colors.................... 6-33 
Load LUT......................... 6-33 
Save ................................ 6-33 
Setup editing ................... 6-35 

LUT screen 
Selection of views.............. 6-6 

M 

MacIntosh file format ..... See Pict 
Main Tool Bar ........................ 3-1 
Main Tool Bar (tools) 

Open.................................. 3-5 
Print ................................... 3-5 
Save .................................. 3-5 
Zoom ................................. 3-6 
Zoom birds eye.................. 3-7 
Zoom Factor ...................... 3-7 
Zoom grid .......................... 3-7 
Zoom in ............................. 3-6 
Zoom out ........................... 3-6 

Main view (viewer)................. 5-3 
Maps (LUT editing) .............. 6-31 
Measure image...................... 5-6 
Merge marked color (LUT) .. 6-20 
Merge similar (LUT)............. 6-21 
Microsoft Windows bitmap fileSee 

Bmp 
Microsoft Windows bitmap file 

format .......................See Bmp 
Mirror ..................................... 5-8 
Mode 

Halt ............... See Prescanning 
operations 

Scanning.. ... See Scan Modes 

N 

NTSC    3-22
  

 

O 

Open 
from File menu .................. 3-9 
from Main tool bar ............. 3-5 

Oversize .............................. 4-18 
Overview window 

Selecting area with mouse 4-3 

P 

Paper load ........................... 4-44 
Paper position ............ 3-21, 4-15 
Paper Size........................... 4-15 
Paper Size Detection........... 3-23 
Paper size method 

Auto size ISO .................. 4-14 
Auto size US.................... 4-14 
Auto sizes........................ 4-14 
Fixed sizes ...................... 4-14 
Hollerith (code) ................ 4-14 
Manual values ................. 4-15 
Setting the... .................... 4-15 

Paper Size Method.............. 4-13 
Paper Y offset...................... 4-18 
Pcl file format......................... 7-7 
Pcx file format.7-3, 7-5, 7-6, 7-12 
photographs ............... 4-11, 4-39 
Photos and art (LUT editing) 6-31 
Pick color (LUT)................... 6-19 
Pick color (viewer) ................. 5-6 
Pict file format........................ 7-4 
Plot,Print file formats ............. 7-7 
Preferences 

General............................ 3-20 
Prescan Preferences........... 3-23 
Prescanning operations......... 4-4 
Print 

(whole batch)................... 3-16 
Copies ............................. 3-15 
Dialog .............................. 3-12 
Direct printing .................. 3-13 
Drivers ............................. 3-13 
from File menu ................ 3-12 
from Main Tool Bar ............ 3-5 
Offset............................... 3-15 
Printer profiles ................. 3-13 
Properties ........................ 3-14 
queue (printer name)....... 3-12 
Range.............................. 3-15 
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Scaling............................. 3-15 
To file............................... 3-12 
WINDOWS printing ......... 3-13 

Properties 
(of image) ........................ 3-11 
(of print) ........................... 3-14 

Pro-Rlc file formats................ 7-4 
Protect color (LUT) .............. 6-18 
Pull down menu bar............... 3-1 

R 

Ras file format .........7-3, 7-5, 7-6 
Raster file formats ................. 7-1 
Raster to vector ..................... 7-4 
Rectangle select.................... 5-5 
Red/Green/Blue 

in feature extraction......... 6-15 
Reduction factor .................. 4-17 
Remove marked color ......... 6-23 
Remove similar color (LUT). 6-24 
Resolution ........................... 4-12 

normal ............................. 4-13 
Physical ........................... 4-13 
Turbo ............................... 4-13 

RGB file,viewing .................... 3-4 
Rlc file format ............... 7-3, 7-12 
Rlc2 file format ...................... 7-3 
RleIN file format..................... 7-4 
Rnl file format ........................ 7-3 
Rst file format ........................ 7-3 
Rtl file format ......................... 7-7 

S 

Save 
from File menu .................. 3-9 
from Main Tool Bar ............ 3-5 
LUT filter.......................... 6-33 

Save as.. ...................... 3-4, 3-10 
Scaled Resolutions.............. 4-12 
Scanner Maintenance ......... 4-51 
Scan menu .......................... 4-43 
Scan mode adjustment 

blur filter........................... 4-36 
Brightness,contrast.......... 4-33 
Color blur filter4-29, 4-31, 4-32 
Despeckle,holefilling4-29, 4-31 
Threshold ........................ 4-28 

Scan modes 

Availability ......................... 4-9 
B/W adaptive................... 4-10 
B/W Threshold ................ 4-10 
BW Photo ADL+ .............. 4-11 
Graytone.......................... 4-11 
RGB................................. 4-12 
Setup button .................... 4-12 

Scan options 
Adjusting the scan mode. 4-27 
Batch scanning................ 4-49 
Offsets - setting of.. ......... 4-46 
Scan Modes ...................... 4-9 
Vertical Precision............. 4-45 

Scan Panel 
Adjustments tab............... 4-27 

Scan Preset........................... 4-8 
Scan Screen.......................... 4-1 
Scan to a file........................ 4-41 
Scan to a Printer.................. 4-42 
Scan to File ......................... 4-53 
Scan to the Viewer .............. 4-41 
Scan to Viewer .................... 4-52 
Scan Whole Batches........... 4-42 
Scanner 

Calibrate .......................... 4-51 
Option availability .............. 4-1 
Setup dialog .................... 4-44 

Scanner Speed.................... 3-21 
Scanner Units...................... 4-15 
Scanning 

Adaptive thresholding........ 4-5 
Adjustments.............. 4-4, 4-27 
Contrast,brightness,blur .... 4-5 
Despeckle,holefilling setting4-5 
Detail window ........... 4-3, 4-20 
Overview window...... 4-3, 4-21 
Prescanning ...................... 4-4 
Procedures ........................ 4-4 
Scan panel ........................ 4-2 
Scan tool bar ..................... 4-2 
Threshold setting............... 4-5 

Scanning Modes* and Options.. 4-
39 

Scanning preferences 
Histogram prescan resolution 3-

23 
Index prescan resolution . 3-23 
Log options (batch scan) . 3-22 

Scanning resolution............. 4-12 
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Scanning to file.................... 4-41 
Scanning to printer .............. 4-50 
Scanning tools 

Align ................................ 4-23 
Invert ............................... 4-19 
Mirror ............................... 4-19 
Rotation ........................... 4-19 
Scan ................................ 4-41 
Scanwindow .................... 4-22 
Stop ................................. 4-42 

Scm file format ...................... 7-7 
Scn file format ....................... 7-4 
Screen Select Tabs ............... 3-3 
Screen Selection ................... 3-2 
Screen status bar .................. 3-1 
Screen system overview........ 3-1 
Screens (moving between).3-3, 3-

4 
Screens (types of..) ............... 3-2 
SCSI board............................ 2-2 
SCSI cable ............................ 2-2 
S-curve ................................ 4-35 
Select area (viewer) ....... 5-4, 6-8 
Selected Scanner ................ 4-44 
Selecting colors ..................... 5-6 
Setup LUT editing options ... 6-35 
Sharpen/Soften Filter ... 4-5, 4-36 
Speckle removal..4-5, 4-29, 4-31, 

5-8 
sRGB................................... 3-22 
Standard cursor..................... 5-5 
Status bar (viewer) ................ 5-6 

T 

Tag Information File Format .. See 
TIFF 

Task Tool Bar ........................ 3-1 
Threshold setting................... 4-5 

Histogram auto ................ 4-28 
Histogram manual ........... 4-28 

TIFF....................................... 7-1 
Packbit............................... 7-5 

TIFF compressed .................. 7-2 
TIFF file format ...................... 7-7 
TIFF LZW file format ...... 7-4, 7-6 
TIFF packbit ................... 7-2, 7-4 
TIFF uncompressed 7-2, 7-4, 7-5 

U 

Undo edit (LUT)................... 6-29 
Use extended thickness paper 

handling........................... 4-47 

V 

Ver file format ........................ 7-7 
VersaTec format.............See Ver 
View screen.................... 5-1, 5-2 
Viewer ................................... 5-1 

Image functions ................. 5-1 
Screen functions................ 5-1 
Selection of views.............. 5-3 

Viewer status bar............ 5-6, 5-7 
Viewer tools 

Align .................................. 5-8 
Brightness,contrast.......... 5-11 
Classify................... 5-10, 5-15 
Count colors .................... 5-17 
Crop................................... 5-6 
Decrease colors,graytones5-16 
Despeckle.......................... 5-8 
Grayscale selecting ......... 5-15 
Histogram stretch ............ 5-12 
Hue,saturation,value ....... 5-13 
Image conditions ............. 5-10 
Invert ................................. 5-8 
Main View.......................... 5-3 
Measure ............................ 5-6 
Mirror ................................. 5-8 
Pick color........................... 5-6 
Rectangle selector...... 5-4, 6-8 
Red,Green,Blue setting ... 5-14 
Scaling............................. 5-18 
Standard cursor................. 5-5 
Viewboards........................ 5-3 

Vif file format ....................... 7-12 
VifAB file format..................... 7-3 

W 

Wicks & Wilson -TIFF ........... 7-2 
WINDOWS Installation on..... 2-3 
WINDOWS printer 3-13 
Wpf file format ………………...7-4 
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